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AMAZING
:= APPLE HACKS

Great things to do on your
Mac, iPhone and iPad

hiomse Surtsmarter ot oot

Your Mac, iPhone and iPad are such Meet the team

incredibly powerful and versatile
devices, the chances are you're only
just scratching the surface of all the
wonderful things they can do. To help
inspire you, this month's lead feature
- 54 amazing Apple hacks' - on p20

is all about the amazingly creative and
productive projects you can carry out
on your devices. Of course, it's really
just the start. We'd love to hear what
kind of things you use your devices for, so drop us a line at
letters@macformat.com and tell us yours.

Talking of powerful devices, this month we're taking an
in-depth look at two of Apple’s latest: the new Mac Studio and
Studio Display. While Apple is deliberately aiming both at the
kind of creative pros who churn through massive graphics
and video files all day, is there enough about these devices
to appeal to the rest of us? Find out starting on p78.

If your needs are more portable, the Ultimate iPad Buyer's
Guide (p62) should help you decide which Apple tablet best
meets your needs and budget. And on p84, we pit Apple’s
£549 AirPods Max against its rivals to see which one emerges
as the over-ear, noise cancelling headphones king.

As ever, there’s lots of other great content inside the issue SUBSCRIBE
to excite and enthrall you - from all the latest Apple news and
reviews, to some really handy how-tos. Enjoy the issue,

Jo Membery
Operations Editor
> Jo's developed a serious

case of Craig crush

not on James Bond star

Daniel Craig; it's Apple
senior VP Craig Federigh
she has the hots for

Paul Blachford

Art Editor

>Paul's already packed
his bags for the Apple's
rid Wide Developer
Conference in June. J
wait until he finds out its
mainly an online event.

t

ROB MEAD-GREEN

EDITOR WORTH £89
editor@macformat.com
macformatuk.tumblr.com » facebook.com/macformat » twitter. > Instagram. ormatUK
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Mystery 15-inch

The MacBook Air could soon
come in a larger size,

marking the first time since
2015 that this has happened,

Apple laptop m

A new MacBook could be in the works

here are many rumours
surrounding this year's MacBook
Air release. Some say it will get an
all-new design, that it will come in a range of
new colours, and that it might even come with
an old chip (see opposite page). However,
there are also whispers of another, larger
device that is shrouded in mystery. Ostensibly,
it appears to be a MacBook Air in a new size,
but even that is far from nailed down.

While there have been calls for Apple to
offer a MacBook Air with an increased display
size for a number of years, the idea picked up
steam recently thanks to a report from Display
Supply Chain Consultants (DSCC), a group of
experts in the display industry spearheaded
by prominent analyst Ross Young.

The report outlined that Apple is planning
a15-inch MacBook Air due for release in 2023.
That would be quite a change to the current
MacBook Air situation, as the only screen size
option at the moment is a 13-inch model.
Indeed, the last time Apple offered the
MacBook Air in two sizes was in 2015, when
an Tl-inch version was also available.

A MacBook Air makes sense
However, the waters have been muddied
somewhat by a tweet from renowned Apple
tipster Ming-Chi Kuo, who said that the 15-inch
device “might not be called MacBook Air". If
correct, that leaves two possibilities open: that
the laptop will get a new name, or that Apple is
planning a new device entirely (perhaps akin


mailto:letters@macformat.com
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New devices with old hardware?

pple might keep older chips
A around for longer in future
devices, if a number of leaks and
rumours are to be believed. That could
break with the company's
usual strategy of upgrading
its devices' chips with each
product update, and could
potentially mean less
exciting performance
from your new devices.
One of the products
potentially affected is the
MacBook Air. While many
experts expect the next
version to be outfitted with
the upcoming M2 chip,

to the old 12-inch MacBook in a new
size). From other info in Kuo's tweet,

the former seems more likely, as Kuo
included this titbit: “Although a larger
display generally consumes more power,
the design goal is to use the same 30W
power adapter as MacBook Air.”

The current MacBook Air also uses
a30W power adaptor. That seemingly
excludes the 15-inch device being some
sort of MacBook Pro, as that product
requires between 61W and 140W of
power, depending on the model. A 15-inch
device would also maintain a two-inch
display difference over the 13-inch
MacBook Air, which lines up with the
two-inch distinction between the 14-inch
and 16-inch MacBook Pro.

Filling a gap in the line-up

If the MacBook Air came in two size
configurations, it might be a tempting
option if you like the expansiveness of the
16-inch MBP but don't need its workload-
shredding power (or its eye-watering price
tag). It would also give more choice to
anyone enamoured with the MacBook Air's
more consumer-friendly looks. With the
renewed approach to that laptop thanks to
bright colour options, which are expected

Rumours of a new laptop
size indicate a possible
15-inch MacBook Air

Looks like Apple is going to let
its chips go cold...

well-known Apple analyst Ming-Chi Kuo
believes it could instead come with an
Mi chip (or @ modified version of the M1,
perhaps with more cores).

Similarly, the iPhone 14
and rumoured iPhone 14 Max
could have the same A15
Bionic chip as the one used in
the iPhone 13, according to

Kuo. The iPhone 14 Pro and
41 Pro Max, meanwhile, would

get the new A16 Bionic.

It's not clear if thisis a
decision from Apple to slow
down updates or simply a
response to the ongoing
global chip shortage.

A15in MacBook Air will appeal to those who want
to combine more character with a bigger screen.
to debut this year, you'll be able to get the
laptop that looks the way you want, and
avoid having to opt for the MacBook Pro
just because you need a larger display.
Kuo believes that the 15-inch laptop
will enter mass production in the fourth
quarter of 2023 "if all goes to plan”. That
points towards a likely launch date in late
2023, an idea Kuo strengthens by calling
the product “Apple’s potential 15-inch
notebook in 2023". That also lines up with
DSCC's prediction of a 2023 release date.
Whatever the device ends up being
called, the idea of a 15-inch Apple
laptop seems to be gathering steam. If
you've been craving a larger MacBook
Air, you might not have long to wait.

THE POLL

What are you most hoping
to see at WWDC 20227

ios/
iPad0S 16

Rt WacPrs

Log on and see next
issue's big question!

Recent reports have
suggested Apple is working on
a device with a folding OLED
screen. This display would
supposedly measure around
20 inches across when laid flat.
That means it could be used as
amonitor or a very large iPad.
You could then fold it up to about
90° and use it as a small laptop
with a virtual keyboard.

The reports have come
from reliable sources, such
as reporter Mark Gurman and
display industry expert Ross
Young. All have said the device is
several years away from release,
with 2025 being seen as the
earliest date (but 2026 or 2027
more likely). If true, it could be an
intriguing new direction for Apple.

Rather than a separate keyboard, the
foldable iPad might use virtual keys.
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NELWS
ROUNDUP

SET FOR 6-10 JUNE

Apple has announced
the dates of its next
Worldwide Developers
Conference, which will
take place from 6-10
June 2022. The show
will be almost entirely
online, although there
will be a small in-person
viewing event for
developers at Apple
Park. Apple is expected
to unveil the latest
versions of its operating
systems, as well as a
few hardware updates,
which might include a
design overhaul for the
MacBook Air.

FEATURE MAY
NEVER APPEAR

Rumours have been
rife that Apple will put
Touch ID under the
displays of future
iPhones, but Apple
analyst Ming-Chi Kuo
says that might not
be correct. Kuo had
previously predicted
the tech might come out
in 2023 at the earliest,
but has changed tack,
saying “Face ID with
amask on iPhone
is already a great
biometrics solution.”
Will under-screen Touch
ID ever emerge? We'll
have to wait and see.
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Cracks appear in
Apple's walled garden

App developers can now apply
for an ‘entitlement’ to bypass
the App Store IAP system.

Certain apps can now send users to payment websites

hen Apple is set on something,
there is little that will make it
change course. A rare change of tack
has come to pass, however, with important
implications for the App Store - and Apple's
struggles against antitrust investigations.

That change seems simple: apps like Netflix,
Kindle and Spotify can now point customers to
sign-up pages on their own websites, something
that Apple previously forbade. However, it
means there's a breach in Apple’s walled
garden. People will have the option to avoid
in-app purchases (IAPs), as these apps will not
have to pay Apple’s 30% commission.

Before you think Apple has gone soft, it's
clear the change is a grudging one. Apps must
apply for an ‘entitlement’ to bypass the IAP
system, and then have to use a specific user
experience flow that warns customers of the
risks of purchasing from third-party sites. Links
must open in a web browser (not in the app), no
extra data can be passed to websites, and
apps can't even explain how much they
charge until users leave the app itself.

Still, it shows IAPs are not the be-all and
end-all, even if only in a limited way. Whether
that will placate antitrust investigators like
the EU is another matter.

Subscribe to get your next iPhone

Apple mulls hardware subscription service for popular devices

ead straight to
the Apple Store on would appe:

iPhone launch day? but not
Or do you wait for a deal? Or
get your iPhone second-
hand? If you opt for any of
these, you buy the phone
outright. That might not be
the case for much longer.

Apple is allegedly working

on a hardware subscription
service where you would pay
a monthly fee for your iPhone
or other Apple product. It's

Subscribing to hardy
o some,
Apple fans.

re §

unlikely this would totally
replace the option of buying
a device, though.

Apple already has several
subscription services, such as
iCloud+ and Apple Music, but
these are limited to software.
According to Bloomberg,
Apple is aiming to make

hardware purchases more like
subscribing to an app.

Rather than an instalment
plan that divides the hardware
cost into 12 or 24 months,

a subscription would use

a separate fee. Then, when
Apple launches new products,
people could upgrade easily,

perhaps even without an
additional charge. The plan
could launch in late 2022 or
early 2023. While the lack of
upfront cost would appeal to
many, the plan might receive
amixed welcome from those
who prefer to own their
devices rather than rent them.



APP OF THE MONTH
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Physciogy Clse 1773 — Homework
APP]

[MAC

OutlineEdit 32899
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e —

Work more efficiently with this productivity booster

Want to get your ideas organised
and take action on them? Rather
than trying to keep everything in
your head, an outlining app could
be what you need.

Version 3 of OutlineEdit adds a host of
helpful new features that can aid in getting
your ideas down. For instance, you can now
add inline images to your outlines, be they
photos, charts, diagrams, or something else.

There are new custom templates, new
themes, colourful category tags and filters,
and more. The app is now much faster and
smoother, its developer says, thanks to a new
editor core. In fact, this is OutlineEdit's biggest
update ever, with over 100 enhancements
to almost every aspect of the app.

So, if you want to plan out projects, tackle
tasks, or wrangle your writing, OutlineEdit 3
can help you do it quickly and simply.

[i0OS APP]

Endel: Focus,

Sleep, Relax

FREE (offers IAPs)
Sometimes key
tasks like focusing
on work and even

falling asleep can be difficult.

If that sounds familiar, try
Endel. It uses artificial
intelligence (Al) and inputs
from famous musicians to
craft soundscapes perfect
for relaxing, studying,
moving, and more.

Why you need it Bring peace
to everyday occurrences.

[i0S GAME]
Kanso
£3.49

Kanso combines
beauty and
relaxation into

a peaceful, meditative
experience. It tasks you with
tracing your finger around
on-screen objects, avoiding
obstacles as you go. It's aided
by over an hour of original
music that is designed to help
you relax and find a moment
of focus and reflection.

Why you need it It's a great
way to unwind.

A

[MAC GAME]
Alto's Adventure -
Remastered
£4.99/month (Apple Arcade)
_#  Alto's Adventure has
long been a popular
snowboarding romp,
Kknown for gorgeous graphics
and Zen gameplay. Now, the
Remastered edition has
arrived for Apple Arcade.
This version adds a new
character, new goals and
challenges, plus extra set
pieces to test your skills.
Why you need it A fresh
update to a classic game.

mes APPLE CORE

Media
Plcks1 )

What you should
be playing and
reading this month

<

[ALBUM]
We
Arcade Fire
£8.99

>Arcade Fire’s latest
work explores the
“loneliness of isolation”
and the “joy and power
of reconnection.”

[AUDIOBOOK]
Absynthe
(Unabridged)
Brendan P Bellecourt
£12.99

Set in an alternate-
reality 1920s, Absynthe
sees shell-shocked
veteran Liam discover
latent telepathic abilities.
Can they help save the
ones he loves?

[PODCAST]

Sport’s Strangest
Crimes

How conman Russell
King hoodwinked
the world's oldest
professional football
club, including a stint
schmoozing officials
in North Korea.
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kit

APPLE CORE Hot new

THE GEAR WE'RE
LUSTING AFTER

©
LG DualUp

£TBC > Igeomyuk

Kitted your Mac out with several monitors
to up your multitasking game? Turns out
you've actually been doing it all wrong - at
least, that's what the LG DualUp would have
you believe. This unusual monitor is shaped
like two 21.5-inch displays stacked on top of
each other, meaning no more craning your
neck side to side, scanning across your
screens to see all your work.

Although LG says that's better for your
neck, the 16:18 ratio means you'll still be
looking up and down fairly frequently. Still,
it could work really well in certain scenarios,
for example by enabling video editors to fit
more content on their screens at once. And
if it means one less monitor cluttering our
already packed desks, count us in.

2}
Samsung The Frame

£TBC > samsung.com/uk

Samsung's The Frame - and true to the real thing. And if you're
known as one of the brand's tempted to touch it? No worries, as it
“lifestyle’ TVs - is part TV, now has an anti-fingerprint coating.
part interactive art gallery. Previously, The Frame included an
At CES 2022, it was updated art store that let you buy artwork and
to make that art look even download it to the TV. That's now been
better thanks to a new anti- augmented with an NFT store, so if you
reflective coating. Samsung are crypto-inclined, you'll have a new
claims this is glare-free and home for your blockchain art as well.

can even mimic canvas, making Who needs to visit museums when
displayed art look even more lifelike you have one of these TVs at home?

10 | MACFORMAT | JUNE 2022 mage credit
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Razer Phone Cooler Chroma

£59.99 > [fazercom

Devices that try to keep
your iPhone icy cold have been
around for a while, but Razer's
Phone Cooler Chroma is the
first to use the magic of
MagsSafe to hold itself in place.
Just pop it on the back of your
iPhone and it stays put, no need
for bulky frames that get in the
way. If you regularly test your
iPhone to its limits, heating it

Top gear APPLE CORE

up in the process, that could
be a very positive thing.

And, this being Razer, the
device is festooned with RGB
lighting, letting everyone know
you're cooling your iPhone in
style (or lack of style, depending
on your taste). Whatever you
think of it, one thing is for sure
- you won't ever catch Apple
making an RGB phone cooler.

Samsung The Freestyle

£999 > samsung.com/uk

Starting in 1962, NASA began
taking Hasselblad cameras into
orbit to document the depths of
space, with the cameras being
heavily modified to survive the
rigours of weightlessness.
Unnecessary extras like the
leather covering and viewfinder
were removed to reduce some
bulk, and the cameras were also
painted in anti-reflective black
paint to minimise reflections.

The techno-hipsters of the world
would have you believe projectors
are old hat. Smart speakers? Passé.
Don't even get them started on
ambient lighting. But a device that
combines all three? Now that's
more like it.

Unveiled at CES 2022, Samsung's

The Freestyle is exactly such a device.

Its Full HD projector is lightweight at
0.8kg, and its compact shape makes

>Image credits:

camera.co

it portable. It also has a viewing
angle that's adjustable by 180°. When
it's not beaming out movies, you can
use it to cast ambient backgrounds
that create whatever mood suits the
occasion. And there's a smart Alexa
speaker built into it that blasts audio
in 360°. That means it could be a
handy alternative to forking out

for three separate devices when

all you need is one.

0o
NASA Mercury
Hasselblad 500C No 9

$4,800 (about £4,300) > Spacecameraco

Now, you can get your hands on
a working replica of one of those
cameras, all for the rock-bottom
price of $4,800 (about £4,300).
It's built to be just like the original
and comes with an 80mm f2.8
lens too. And as a bonus, you'll
even get a ‘flown-in-space
artefact’ with the purchase. The
replicas haven't actually been into
orbit, but they're as close as you
can get to a camera that has.

JUNE 2022 | MACFORMAT | 11
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¢ CONTACTS

Get in touch CONTACTS

> Email your queries

Wy Have your say on all things Apple!

LETTER OF THE MONTH!

CLEAN MACHINE

Just reading the ‘Fast Fixes' Feature in the
April 2022 [MF375] issue, most helpful -
thank you. One tip - no doubt among many
others you could have included - which |
have found most helpful, is what to do in
the event of a malfunction of the charging/
connection port, in my case a second-gen
iPhone SE belonging to my wife.

It was apparently becoming ‘loose’ and the charging/connecting
intermittent. A simple solution before visiting an Apple Store is to gently
‘clean’ the charging port first with a toothpick or similar to loosen any
debris, and then to give it a good old blast with an aerosol air duster.

Works a treat. You probably already know this, but it's possibly
worth including in a future 'tips’ feature?

BY SIMON GOODE

ROB SAYS...

This is something we have done ourselves (as pocket fluff does have
a habit of lodging itself inside the Lightning port), although it's not
something that Apple recommends. For
official advice on the best ways to clean
your iPhone, read the relevant Apple
Support article at apple.co/3veX5bl.
Having said that, though...

SO LOW VOLUME

1 write on behalf of an elderly person who
has a second-hand iPhone 7, as the sound
volume on it is failing. Having tried normal
user-based fixes, is there any diagnostic
or maintenance software | could run

to identify the problem or optimise

the iPhone's performance.

BY JAMES HARRIS

H LETTER O!
THE MONTH

Win a Devolo
Magic 2 WiFi
Starter Kit!

The author of our Letter
of the Month receives a
prize! Email us for your
chance to win a Devolo
Magic 2 WiFi Starter Kit,
which turns any power
socket into a potential
access point for high-
performance multiroom

i-Fi. Find out more at

ROB SAYS...

One reason why the volume could be
failing is due to clogged speaker vents at
the bottom of the iPhone, which can pick
up all kinds of dirt and detritus. These can
be carefully cleaned using a soft brush or

= even a cotton earbud dipped in isopropyl
L S ln\ 4 alcohol. The alternative might be to use a
\ pair of wired headphones connected either

12 | MACFORMAT | JUNE 2022

and your questions to
letters@macformat.com

‘ Contact us

We doubt that either Apple or Microsoft will ever
make Windows support on Apple silicon official.

directly to the Lightning port or by using
Apple’s Lightning to 3.5mm adaptor.
Otherwise a trip to your local Apple
Store may in order.

INTEL iMAC OR M1 MAC?

I have been using MacBooks since 2012 but

still have to use Windows for certain apps.

I have a MacBook Pro 16in (Intel) and | run

the Windows programs using Bootcamp.
Should | consider a ‘renewed" iMac 27in

which would enable me to continue using

Bootcamp or switch to the latest M1iMac?

BY STEPHEN C HALL

ROB SAYS...
While there is a version of Windows that uses
similar ARM architecture to Apple silicon, it's
unlikely that either Apple or Microsoft will
ever make Windows support on Apple silicon
official, and Bootcamp remains conspicuous
by its absence on Apple’s M-series systems.
In days past, you could have run Windows
using virtual machine (VM) software from
the likes of Parallels, but even that doesn't
support Intel machines on Apple silicon -
or even macOS versions prior to Monterey.
While it's tempting to consider a
refurbished 27-inch iMac, we'd urge caution
- as Apple has now discontinued it, ongoing
support long-term is no longer certain. We'd
suggest you use your Intel-based MacBook
Pro for Windows duties for now, and buy an
Apple silicon Mac - and seek out alternatives
to the Windows apps you use, if you can.


mailto:letters@macformat.com
http://devolo.co.uk/
http://apple.co/3vcX5bI
https://support.apple.com/en-gb/HT207123
https://www.devolo.co.uk/
mailto://letters@macformat.com

Facts & figures APPLE CORE

APPLE'S SUPPLY CHAININ I

NUMBERS

We know Apple loves to boast about its green .
credentials, but how green and employee-friendly 23 6
are the suppliers that makes its products? m""on

Number of supplier
employees who've been
trained on their labour
rights since 2008.

mber of Apple suppllers Apple is the first company The number of countries
in the industry to produce a where Apgle auditors h

million
s of waste diverted from landfill
Apple's suppliers since it introduced its c y > Number of organisations
ro Waste programme in 2015, including supported by Apple,
waste produced during final X N including those involved in

human rights work, as well
as enviromental protection.
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APPLE

It struck me just
how staticand
stagnant some built-
iniPhone apps are

In700m @ Marble
Arch Station

The Maps app is a good example

of Apple innovating -
designs and AR featu

updated how well it works.

CORE Opinion

s I write this, Apple has just announced that
WWDC 2022 will indeed take place this year.

I wasn't especially fearful that it wouldn’t, any more
than I am fearful that December will roll around and there’ll
turn out to be no Christmas (though, admittedly, that may be
areal danger this year at this rate). So I tried to think about
what big features I'd like Apple to add this year, and I realised
that I don’t really think about magic new features for the
iPhone any more. 15() years into its life, it's no surprise that
it's harder and harder for there to be game-changing new
things that a phone can do. No, all my gripes are more about
the state of things now, and it struck me just how static and,
perhaps, stagnant some of the built-in iPhone apps are.

The thought germinated in the Music app. Apple has
improved the service with new music quality options recently,
but the app itself didn’t
develop in the same way.
Did you know that on
Android, Apple Music can
crossfade between tracks in
a playlist, giving a smoother
transition? This has never
come to i0S. Who knows
why? Imagine all the
interesting things this app could offer around
discovery of new music. What if you could explore
a cloud of connected artists, listening to snippets
on the way to build a new set of recommendations.
What if the Neural Engine could power a system
of song mixing, where it pulls tracks that match
the beat from your library?

Think about the Contacts app. What was the
last thing you saw that signalled a change here?

Is there really no innovation to be found in how
our disparate online lives can be brought together
and presented to us? Apple does dabble in this,
particularly in how Siri will match things together,
but just look at the actual Contacts entry for
someone you know and love, and speak to all

the time, across different platforms. Look at how
impersonal it is. Has it changed - truly changed

- in the 14 iOS updates we've had so far? I have
changed how I interact with people a huge amount
several times during the lifespan of the Contacts
app, and the app has listened to the changes, but

new map
s really
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MATT BOLTON.

DOESN'T WANT THE NEW VERSION
OF iOS TO BUILD ON YET MORE
FEATURES, BUT TO MAKE MORE
OF WHAT WE ALREADY HAVE

X

What do you want
to focus on?

Choose a Focus to get started.

o Custom >
a oriving >
# Fitness >

105 15 gave us ways to avoid using our apps so much,
and to be fair, | can't say I'm not grateful for that...
ithasn’t participated in them. And is this
definitely still the best way to lay out the
Camera app? Are these controls still the
right things in the right place?

Have we really reached the peak of time
management and appointment viewing in
the Calendar app? Hasn't iMessage seemed
to stall after its big changes a few years ago,
while other chat apps keep evolving?

Iknow there’s a balance Apple has to
strike between changes they'd like to make
and fans who are furious every time a single
button is moved, but Id be very happy if i0S
16 spent some time, as so many teenagers do,
getting a bit introspective this year.

ABOUT MATT BOLTON

Matt is the editor for Apple and home
tech at T3and has been charting
changes at Apple since his student
days. He's sceptical of tech industry
hyperbole, but still gets warm and
fuzzy on hearing “one more thing".
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An amazing recording bundle from 512 Audio

If you love making podcasts,
creating music, or streaming
content, you know the value of a
top-notch recording setup. And if it's
time for an upgrade, you're in luck, as
this issue we're giving away two huge
recording bundies from 512 Audio.

First up, we've got the Skylight
XLR microphone that's perfectly
tuned for vocals. Its 34mm gold-
plated condenser capsule, cardioid
pattern, and custom frequency
response are all tailor-made to get the
best results for music and streaming.

Then we have a mic that's perfect
for podcasters, the Limelight XLR.

HOW TO ENTER...

>To enter, you can visit our website at BIIV/MESIZAUMS (web address is case sensitive).
> For fullterms and conditions, go tol
to these competition rules and confirm you're happy to receive details of future offers and
promotions from Future Published Limited and carefully selected third parties, if you have

given

us permission to do so on the entry form.

This comes with a ‘hyper-focused’
pickup pattern, which is 20%
narrower than standard cardioid
patterns, helping to separate your
voice. Its built-in pop shield and
low-frequency filter mean crystal-
clear audio that audiences will love.
As you also need to ensure that
your mic is held in position and
sounding great, we're also including
aboom arm and pop filter. The boom
arm provides a sturdy, adaptable
support that's super simple to use and
completely silent, while the pop filter
cuts out plosives and popping sounds
to ensure you sound great at all times.

By sending your entry, you agree

> This competition closes on 30 May 2022. Over 18, GB residents only.
> The winners' details will be shared with 512 Audio for the purpose of providing prizes.

And, as you need to know everything
sounds spot on, we're including 512 Audio
Academy monitor headphones. Custom
45mm drivers deliver detailed audio that's
super accurate, helping you to make sure
that everything sounds as it should do.

>THE QUESTION

Tobe in with a chance of winning one
of two amazing recording bundles from
512 Audio, just answer this question:

What recording pattern does
the 512 Audio Skylight
microphone use?

A) Cardioid
B) Stereo
C) Omnidirectional

> For more information about 512
Audio’s range of audio-recording
products, head to the company's
website at/S12audio.com.
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Apple an
podcasts

Lots of people consume lots of podcasts
on Apple devices, but is the company really
a big player in the podcasting world?

WRITTEN BY CHARLOTTE HENRY >

pple has always been
strongly associated with
podeasts, thanks in no
small part to the iPod.
There is a chicken-and-egg style debate
about the connection, but there’s no
doubt the device cemented the link
between Apple and podcasts in the
mind of many consumers. Despite
this, for years, Apple has only really
provided a distribution platform for
podeasters in both the hardware and
Software spaces.

Until very recently, it never looked
to produce podeasts itself, nor provide
creators with direct ways to make
money via its platform. As Joseph
Evans, Head of Tech at analysis firm
Enders Analysis, told MacFormat:

“Apple has been a bit of a neglectful
parent of podcasting. For years it
controlled most of the listening but
failed to invest in things that could have
helped creators, like analytics or
payment support. As podcasts grew,

16 | MACFORMAT | JUNE 2022

clunky workarounds came along to
fill some of those gaps, like Patreon
patreon.com] and advertisement
tech providers. But it took real
competition for listening to wake
Apple up - since Spotify made its
ambitions in podcasting clear, Apple
has started to launch many of the
obvious features that were missing.”

No doubt Apple would push back at
the “neglectful parent” characterisation.
It could legitimately point out that it has
provided a platform and resources for
podeasters, such as a directory of shows,
even when it was making no money
directly from podeasts. It also has
significance by virtue of the fact that
there are one billion iPhones with its
Podcasts app out in the world.

Podcast Subscriptions
‘While it does have some ground to make
up, things have changed, particularly in
the last year. So is Apple finally taking
podeasts seriously?

The Midnight Miracle  Above the Noise with,

My Channels

(5 JON )

The Athietic

Lominary Radiotopia

Channels to Try

We Won't Forget Them B @)

The Channels option enables you to see all
podcasts from a single provider on one handy page.

‘Well, in April 2021 Apple announced
Podcast Subscriptions. The idea was
that both independent creators and
premium studios could charge for their
shows directly in the Podcasts app.
Apple, of course, takes the same °

mage credi
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Apple and podcasts APPLE CORE
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APPLE CORE Apple and podcasts

© 30% cut it takes from many other
subscriptions. Amongst those to sign

up were the LA Times, sports outlet

The Athletic, and Pushkin Industries,

the company co-founded by renowned
author and podcast host Malcolm Gladwell.

Commenting at the time, Eddy Cue,
Apple’s senior vice president of Internet
Software and Services, said the company was
“proud to lead the next chapter of podcasting
with Apple Podcasts Subscriptions”.

Things didn’t go that smoothly. Apple
Podcast Subscriptions was originally slated
tolaunch in May but did not actually go live
until the middle of June. There was also
the launch of Channels, which allowed a
publication producing a variety of shows
to put them all in one place, making them
somewhat easier for listeners to find.

Has it worked?

Apple is typically circumspect about giving
precise figures for both the number of
Podcasts app listeners and the number of
peaple paying for subscriptions directly
through it. That makes assessing whether
the rollout of Apple Podcast Subscriptions
has been a success somewhat difficult. It
does not seem to have majorly shifted the
industry though. As Evans of Enders
Analysis noted, many creators had
already found workarounds.

Despite the huge numbers of iPhones and
other Apple devices in circulation, Spotify
announced during its earnings call for the
third quarter of 2021 that it had become the
number one podcast platform in the US.

Evans said that “Apple is not in a great
position, for a few reasons. First, its refusal
to work with other platforms; it won’t
launch an Android app, and Apple Podcast
subscriptions can’t be redeemed on other
listening apps. Apple-only subscriptions
would have been a great way to lock
podeasters in when Apple dominated.

“Now it just looks like a good reason to

solution - i
when Apple is claiming up to 30% of the
subscription price. Second, its aversion

Original content is now
a key battleground, as
it is in the world of
television and film
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2

TOP
SUBSCRIPTION
PODCASTS

According to a list released
by Apple in November
2021, these are the top
subscription podcasts:

with John Carreyrou

with Ariel Levy

with Jordana Abraham
and Jared Freid

with Terry Gross

with Don Lemon
and Chris Cuomo

with Guy Raz

with Josh Dean,
Vanessa Grigoriadis
and Trevor Aaronson

with Aleen Dreksler
and Sam Sage

with Amanda Aronczyk,
Erika Beras, Mary Childs,
Jacob Goldstein, Sarah
Gonzal

Yos
naeles
Times

PREMIUM

L.A. Times Premium
Get Bonus Episodes
Listen Ad-free

Sea Al inchuced Shows >

°

T Times: Dl news.

B o

LA. Times Prem

The Apple Podcasts app now offers thousands
of Podcast Subscriptions and dedicated channels.

to advertising: Spotify can sell ads for
podeasters on the basis of actual logged-in
impressions - Apple’s not going to sell
podeast ads. And ultimately podcasts are
always going to be too small for Apple to
care that much about, so it's not motivated
to solve things like podcast discovery, or
improve its app, in the same way that
competitors are.”

Apple can be said to be lagging behind
in its offer to creators in other ways too.
For instance, it took until March 2022 for
podeasters to be able to see how many
followers they have on the Podcasts
app, an important data point.

Original content

Original content is now a key battleground
between firms in the world of audio, as it is
in the world of television and film. Originals
area key part of the Spotify success story.
The company (in)famously put $200 million
into a deal with mega-podcaster Joe Rogan.
Tt also spent hundreds of millions of dollars
acquiring podeasting companies Gimlet
and Anchor in February 2019. Gimlet is a
production studio, while Anchor provides
the necessary tools for podcasters to host
and monetise their shows.

‘Amazon, too, has invested in original
podcasting. At the end of 2020, it bought
Wondery, the company behind shows such
as Dirty John, Dr Death, Business Wars, and
The Shrink Next Door. Its shows are available

>Image credit:
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on non-Amazon apps, and you can subscribe
to them in Apple Podcasts, but they also sit
alongside Amazon Music and its audiobooks
service, Audible. While Amazon Music does
not get anywhere near to competing with
Apple Music or Spotify on its own, Amazon
can claim to be offering an all-encompassing
audio solution to consumers.

Apple has not really struck major deals of
the kind its rivals have. In September 2020 it
bought Scout FM, an app that created podcast
stations on various topics. It's possible to see
athrough-line from this acquisition to the
creation of channels. However, there have not
been Rogan-style deals for original content.
Instead, its original podcasts offerings stem
from its streaming service, TV+. The Line
was first released as an Apple TV+ branded
podeast in April 2021. It told the story of
former US Navy SEAL Eddie Gallagher.

PUSHKIN

>lmage credits:

PODCAST
APPS

Apple Podcasts and
Spotify are not the only
players. Here are some
alternatives.

An easy-to-use

podcasts app with features
like Smart Playlists.

Home of original
shows like Freakonomics
Radio, as well as being
a highly functional
podcast player.

deezer Brings together
music and podcasts like
Spotify does.

A Hosts and

monetises podcasts for
creators, as well as lets
users listen to them.

°
T Provides a huge
number of live audio
streams from major
outlets as well as podcasts.

Apple and podcasts APPLE CORE

@ hop s ot — —

&y Hiking Treks™ c.... 3

Epiode paiomance

Apple Podcasts Connect allows creators to submit,
manage, and monitor their shows.
He was charged with committing war crimes
but was ultimately acquitted on all but one
count in a high-profile, controversial case.
A television documentary of the same name
followed in November that same year.

There was also the high profile signing
of former Daily Show host Jon Stewart. His
Apple TV+ talk show The Problem With...
‘was accompanied by a podcast of the same
name, and there is Oprah’s Book Club, which
is branded as an Apple Books podcast.

‘While small in number, these have been
shown to be significant interventions into the
inal podcasting space by Apple TV+. The
Linebroke news when Gallagher claimed on
the podcast that the SEALS conducted a range
of medical procedures on the injured detainee
he was accused of killing, with the intention
that the Islamic State fighter would die as a
result of them. Comments by Jon Stewart
about Harry Potter author JK Rowling also
caused controversy - something Apple is
never keen to court. Ultimately though, as
with streaming TV and films, if Apple really
wants to make a big impact on the world of
podeasting it is surely going to have to
produce more shows of its own.

Apple’s approach

Apple’s approach to podeasting is not all
that different to its approach to other sectors
of media - it dips its toe in, without fully
committing and deviating from its main
focus of making and selling hardware.

As with TV+ streaming, when it comes
to podeasts, it can often seem like Apple is
having to make up ground, instead of leading
from the front. Despite this, Apple's place
in podcasting is significant and is likely to
remain so, simply because so many people
listen to podcasts on Apple devices.
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ince we clapped
eyes on and fell in
love with our very
first Macs, we've

been blown away not just by

their performance or their

power, as impressive as they

are, but by the possibilities

they offer. Where else can

asingle device be an artist's

sketchbook and a guitarist's

amp, a writer’s notebook and

a photographer’s darkroom,

a space cruiser's cockpit and

an architect's easel? And that's

just scratching the surface

of what your Mac, iPhone

and iPad can do.

In this feature, we'll discover
how you can do all kinds of
amazing things on your Apple
kit. We'll discover the apps
that'll elevate your creative
projects into something truly
spectacular, and we'll look for
the cool tools that'll make your
life easier. We'll discover how
your Apple kit can help you
organise your biggest ideas
and your littlest tasks, how
it can make your days easier
when you're at work, school
or college, and how it can help
you learn to do new things and
do what you do even better.

JUNE
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Magical Mac

Make amazing art, learn to craft code
or make your very own podcast

literatureandatte.com, ulysses.app
Whether it's your debut novel or
a dissertation, if you're planning a
huge writing project then apps such
as Scrivener (£17.99) or Ulysses
(Free, offers IAPs) can help.

They're both described as writing
environments rather than word
processors because they enable you
not just to write but to organise your
research, keep track of structures and

Organlse your

everythin

culturedcode.com, omnigroup.com
Sometimes Calendar and
Reminders just aren’t enough

to keep you on top of everything

'you need to remember. That's where
productivity apps such as Things
(E17.99) or OmniFocus (Free, offers
IAPs) help, offering effective tools to
manage your time, tasks and thoughts.
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perform search and replace across
multiple documents. And everything's
stored as text files so they run very
quickly. Best of all, they also have
immersive writing modes that get

rid of every distraction and enable
you to focus solely on your writing.
While it's absolutely possible to write
entire books in Pages, these apps
make everything so much easier.

il } I!iam

Draw absolutely
anything
>tayasui.com/sketches

There are many drawing apps

available for the Mac, but not
many great ones that you can
use for free. That's why Tayasui
Sketches is so great; it's a realistic
drawing app with tons of tools, a
really user friendly interface and
stylus support, and the core app
is completely free. There is a Pro
version, which is modestly priced at
£17.99, that unlocks unlimited layer
support, tons more drawing tools,
a superb wet watercolour feature
and lots of extra colour tools.

There's also an iOS version,

and Pro subscribers can use iCloud
to sync sketches and drawings
across all your devices. We think
you'll enjoy Sketches so much that
you'll want the full thing so you can
take full advantage of its brushes.

Create a podcast
anchor.fm
You can record a podcast
using any Mac or i0S aut
app. We like GarageBand, which
makes recording and editing a
podcast super simple - but you need
to get that podcast to your audience.
That's where Anchor (Free) comes in;
it'll distribute your podcast to all the
key platforms for free.

Image credist; Literature & Latte Ltd, Tayasul, Cultured Code
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Learn to code
apple.com/uk/swift/playgrounds
Apple's Swift Playgrounds
app is a fantastic way to
teach yourself coding in the
Swift language. It's available for
Mac and iPad and, once you've
got the hang of it, you can use the
same software to build and test
your own apps and upload them
to the App Store for distribution.

lllustrate like
a pro, for free
>vectornator.io

Right now Vectornator is

the drawing deal of the year.
It's a direct competitor to vector
apps such as Adobe lllustrator but
it costs absolutely nothing until
the developers work out how
they're going to make money
from it, and the app is likely
to stay free even then.

It's one of the easiest vector
graphics apps around on the Mac
and on iPhone and iPad too, but
while it's simple to use it isn't a
simple app; it supports all the key
formats, works with digital input
devices such as Apple Pencil (on
compatible iPads) and tons of
styluses, and it's packed with tools
to create complex multilayered
images. It's also extremely
lightweight, running very fast even
on highly detailed illustrations.

Image credits: Lineari

affinity.serif.com
The Mac made its name in
desktop publishing, so it's
nice to see the tradition being
upheld by the likes of Affinity
Publisher. It's an easy to use but

wordpress.org, weebly.com

WordPress (Free) enables you

to build anything from a basic
blog to a massive news website.
While earlier versions were a lttle bit
intimidating the latest versions are
incredibly easy to use and powerful too.

There are tons of high-quality

templates that take care of the design
for you, and they're easy to edit to get
things just-so. There's also a version

Make your own website

very powerful publishing app
for print and digital publications,
and the price of £47.99 makes it
incredibly good value too - as
are all the other Affinity apps.

you can install on your own web space.
While WordPress is great for presenting
words, what if you want to sell stuff?
You can do that easily too.

Weebly, designed for small
businesses, is an affordable alternative.
Its online store option starts at £9
per month and includes payment
processing, a shopping cart system and
third-party payment provider support.
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Amazing iPad
Work, rest and play with these amazing apps A £t
for creativity, productivity and watchability ]

Learn an
instrument
> fender.com, gibson.com

Fancy being a guitar hero?

Guitar makers Fender and
Gibson both offer apps that'll teach
you to play like legends, and both
have free trials - 7 days in the case
of Fender and 14 for Gibson. They're
both brilliant apps for teaching guitar
(and in the case of Fender, ukulele
and bass too), but before you hand
over your card details make sure
'you check out GarageBand first.

GarageBand's Smart Instruments

enable you to mess around with
quitars, basses, pianos and synths,
and if you go over to your Mac you
can download free guitar and piano
lessons too. If there's a specific song
you'd like to learn, head over to
ultimate-quitar.com where you'll
find guitar, ukulele and piano tabs
and often video too.

Learn to DJ
>algoriddim.com/djay-ios
10 Fancy spinning the
(quite small) wheels of
steel? The excellent dJay (Free,
offers IAPs) app turns your iPad
into high-tech turntables, and
being able to physically control
the tracks with the touchscreen
makes it feel even more intuitive
than on the Mac. dJay makes it
easy to mix, add effects and
can also auto-DJ for you.

1
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Have a virtual

movie night

1 3 Want to watch a movie with
family or friends but can't

be together? SharePlay, added to

FaceTime in i0S 15.1, enables you to
watch Apple TV or listen to music
while sharing a FaceTime call. You all
enjoy the same content at the same
time, and you can use Messages to
chat or comment by text.

= “« >
. |

v
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- . .

Make your
own beats
1 Other music apps are
available, but if you haven't
already experimented with it
you'll be delighted to discover
GarageBand is great for making
beats for any genre of music.
GarageBand has three options
you can use, so you can build beats
from pre-recorded loops; you can
build beats using the Beat
Sequencer; and you can build beats
by using the Drummer tool, which
uses samples of real musicians and
enables you to pick not just what
they play but how they play it too.
You can choose between a collection
of different drum kits and electronic
drums, between different drums, and
from GarageBand's extensive library
of loops too. We've lost count of
how many hours we've spent on
GarageBand making all kinds of
exciting drum tracks.

Image credits: Maon Computer Gme,

maxon.net/forger
Most of the artistic
type apps we've
looked at so far are for
working in just two
dimensions.

With Forger you can
use your iPad to create
virtual sculptures in three
dimensions. It's fun to
experiment with while
powerful enough for
professional use, and at
£1.79 a month it's really
cheap for a pro-level app.

Organise all your ideas

noteshelf.net
If you're a student or just
need an app that's really
good for taking all kinds of notes,
Noteshelf (£8.99) will help
organise your ideas on your iPad.
You can make notes by
handwriting them, typing them or
recording them; you can record
meetings or lectures; you can mark
up PDFs and presentations; and you

[T
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can even search handwritten notes.
It ties in with all the major cloud
services and uses iCloud to sync
between devices, and you can create
voice notes using Apple Watch. While
Noteshelf works without accessories,
adding an Apple Pencil or similar
stylus takes things to a new level,
turning your iPad into the smartest,
most flexible notepad around.
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Incredible

iPhone

Replace reality, scan almost anything
and make the world a smaller place

Upgrade reality
1 Apple's augmented reality
(AR) tech is really amazing,
especially on more recent iPhones.
By overlaying graphics over real-time
images from your phone's camera you
can do everything from virtually trying
out furniture to playing video games,
and the number of AR apps (available
from the App Store) is growing. Many
of them also work on M1 Macs, albeit
without the live camera view.

IKEA Place enables you to see how
various items of furniture will look in
your rooms; NightSky overlays all
kinds of planetarium things over the
sky and even enables you to see space

stations in your living room; Pokémon
Go turns the real world into a Pokémon
playground. All of which are free (some
with IAPs). Human Anatomy Atlas 2021
(£21.99) shows 3D models of skulls and
skeletons wherever you point your
phone. For bones of a different kind,
Monster Park - AR Dino World (Free,
offers IAPs) brings dinosaurs to life
while Mammoth Mini Golf AR (£2.49)

is exactly what its name suggests: an
augmented reality game featuring
mammoths and mini golf. Fancy
making your own AR experiences?
Everything you need is at developer.
apple.com/augmented-reality.

Sign everything
electronically
1 8 The scanner in Notes
doesn't just scan
documents. It enables you to sign
them too. Simply scan the document
as normal and then tap on the share
icon and then the Markup icon. Now
tap on the '+ icon and choose
Signature. You can now choose
to use a previously saved signature,
or scribble a new one.

sy o

ey (D T

sgunce (O Signature
& Magnifier

ooo

Shelleywillems.
(415) 555-3046

Use Live Text
1 Live Text feels like magic
and it's available on iPhones
from the XS/XR onwards. It
automatically recognises text in the
Photos app and Camera app. It draws
a yellow frame around detected text,
and you can adjust the frame by
swiping or grabbing its edges. You
can then use five different options:
Copy Text, s0 you can paste it into
another app; Select All, to select
all text in the frame; Look Up, to
search the web for the selected
text; Translate, which translates
languages; and Share, which sends
the text to your messaging app,
AirDrop or other sharing options.
You can also tap directly on website
addresses or phone numbers to visit
them and call them respectively.

Image credit
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Reading

Automate everything
with Shortcuts
2 The built-in Shortcuts app
makes it easy to automate
all kinds of things. We use it to
email things to specific people from
inside apps, to control smart home
kit and even to automatically change
our Apple Watch face at certain
times. It's incredibly easy to create
pretty much any automation you
might want, so why not give it a try.

Translate in real time
2 Your phone can be a
universal communicator,
automatically translating your
words into another language and
someone else’s words into yours.
There are apps that can do this from
the likes of Google and Microsoft,
but it's worth checking out Apple’s
own built-in Translate first.

The app can translate text, voice
and even conversations in lots of
different languages and if you're
going to be travelling, you can

54 amazing projects FEATURE

Become a social
media star
2 Facebook, Twitter and
Instagram are so last
decade: if you want to be a viral
star, TikTok is where it's at. The
free TikTok app (Free) isn't just for
consuming TikTok clips; it's also for
recording, uploading, livestreaming
and sharing too, and its extensive
music library enables you to find
the perfect soundtrack.

English
UK

English (UK)
The train to Barcelona
is here

Spanish

El tren a Barcelona

esta aqui

FORMAT W
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Remember when digitising
documents meant giant
and desperately slow flatbed
scanners? Now ,ruu it with
Allyou

ou can also
an directly to your Mac.
To scan a document, open or
ate a noise and then tap on the
camera icon. Now choose Scan
Documents and place your came
over the document you want to scan.

download the languages so the
feature will work even when there's
no internet connection. Conversation
Mode is particularly good; it shows
each bit of the chat in both
languages, and if you tap "..." then
Auto Translate, you don't need to
keep tapping the microphone icon.

ers to fit the
and tap Keep S

You can now retake the s

it or scan more documen

>Image credit
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oreamazing EEa

2 Batman! There's an iPad

(]
app for making comic books! In
fact, there are lots. But if you'd like
to do things the easy way, Comic

Life 3 (£4.49) for iPhone or Mac or

Make travelling more friendly, craft Cormic Draw (Free, offers 1APS) on

iPad are great fun, and the latter

comics, and research your ancestors works wellwith Apple Penci

>tripit.com
Say goodbye to travel-
related stress such as
trying to remember flight
numbers or dig out etickets or
reservation confirmation codes.
Tripit does all for you to take the
‘aaagh’ out of travel.
Tripit comes in two flavours:
a free app, which makes it easy to
organise all the things you need
- & - | to keep and remember for your

Top Free Apps

. travels, and a paid-for pro version
Fix the web i (£38.99) that adds real-time flight
2 Safari Extensions and paid product (£6.99), stops sites from status alerts, tells you how busy

content blockers can disabling key features such as copy the security lines are likely to be |

completely transform your online and pasting, dragging and dropping 80l  and includes airport maps so you ;
experience. Vinegar (£1.79) stripsthe  and so on. It also gets rid of extra #1 won't get lost. And because it i
ads from YouTube and gives youmore  tracking bits from web links for easier | works across Mac, iPhone, iPad
control over how videos play. Adblock and clearer sharing, and removes 8ll and Apple Watch it's available on
Plus (Free) gets rid of pop-ups and most of the privacy invaders you'll Il every device you're likely to have
other irritations, Social Fixer makes find on commercial websites. Al the on your travels, ensuring that
Facebook less annoying and Stop The ~ extensions mentioned here are everything you need is right |

Madness, the only one here that's a available from the Mac App Store. there when you need it.

2 Tracing family histories is

big business online. Sites
such as myheritage.com (from £59)
and ancestry.co.uk (from £10.99/
month) help people find far-flung
connections all over the globe and
to explore and share their family
tree. If you'd rather use a desktop
app, MacFamilyTree 10 ($69.99,
about £85) is a good option.

Image credit S JUNE 2022 | MACFORMAT | 29
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>qrcode-monkey.com

QR codes are a great way

of cramming information
into a shareable, printable, iPhone
or camera scannable QR code. Be
that a website address, your contact
details or anything else you might
want someone to access. There are
tons of free generators online, but
QR Code Monkey is our go-to.

Cook up a storm
>paprikaapp.com
3 If you like to find recipes
online, you'll love Paprika.
The app makes it easy to grab
recipes and save them for later, and
can scale amounts up and down for
different serving numbers, and
create your shopping list too. When
cooking, recipes become tappable
checklists to keep you on track.

30 | MACFORMAT | JU

Get better podcasts

>overcast.fm

2 Apple's Podcasts app isn't
the best. We much prefer

Overcast, which is made for i0S and

also runs on M1 Macs. It's a labour of

love by a single person, and that

person really knows what podcast
listeners want their apps to do; we
use it to find and play podcasts at
home, on the train, and in the car.

[Er————

>mindnode.com
Mindnode enables you to
create mind maps on your
Mac or iOS device, helping you to
organise your thoughts and ideas
visually. It can be an effective way
of keeping tabs on projects, and
while Mindnode isn't expensive you
can try it out for free to make sure
it's the right mind mapper for you.

Image credits:
ia Production

>ikmultimedia.com
Today's music stars often
use simulations of pedals
and amps on stage because the
technology is so good. And you can
do the same at home with apps such
as GarageBand and Apple’s Logic
Pro X. Need more? Amplitube 5
enables you to emulate almost
any amp and effects.

Make websites work
>reederapp.com
33 If you're not already
familiar with the many joys
of reading websites’ RSS feeds,
Reeder will make your experience
better. It enables you to subscribe
to your favourite web destinations
without having to wade through all
the usual website clutter and it's a
great way to ensure that you never  If &
miss a post.

¢
{

Create shortcuts
and triggers
>folivora.ai
3 Better Touch Tool enables
you to customise your
Mac's input devices. Enabling you
to create triggers and shortcuts
such as keyboard macros and input
actions. And if your Mac has a notch
at the top you can create a Notch
Bar containing macros too.
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Record anything

>rogueamoeba.com

35 Whether it's a sound in
Safari, a tune in TikTok

or a meeting in a video messaging

app, if it's making noise on your
Mac you can record it in full

>bear.app, ia.net
Markdown is a writing
language that enables you
to write and format text. You can
then output, including formatting
and links, to all kinds of destinations.
quality with Audio Hijack. It's a Markdown apps include Ulysses
great app for podcasting, streaming (see p24), and other excellent
and other tasks that recording audio alternatives such as Bear (Free,
sources and it's easy to configure. offers IAPs) and iA Writer (£2!

Use one app for
many messages
>meetfranz.com
38 Franz enables you to use
the likes of Facebook
Messenger, Slack, Gmail, Discord
and more in a single app. However,
it doesn't work with Messages. The
free version of Franz is limited to
three services; if you need more,
extra-service support starts from
$2.99 (about £2.60) a month.

Al

54 amazing proje

Convert your

old videos

>handbrake.fr

4 If you've been gathering
video for a long time, some

of it may be in old, obscure and/or

inefficient formats. The free

Handbrake app can read pretty

much any kind of video and export

it in an array of modern formats. It

also has good tools for improving

video quality on older footage.

Chill with
background sounds
3 Fancy a soothing
soundtrack to block out
noise or to help you relax, work or
study? You can find what you need
right there on your iPhone. Go to
Settings > Accessibility > Audio/
Visual > Background Sounds and
pick the kind of audio you'd like,
such as ocean or rain sounds.

Image credits: Rogus
The Guote-Une

ts FEATURE
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Write your .
screenplay or script
>highland2.app
3 You can write a screenplay
or script in any writing
app, but some apps are designed
specifically for the job. We really
like Highland 2 - it makes it easy to
layout your script and also checks
for issues such as gender imbalance.
The basic version of the app is free.

Write more clearly
>grammarly.com
4 If you'd like a bit of help with
writing, try the Grammarly
desktop app. It works across
everything from email and word
processing to website forms,
offering suggested improvements
as you type. It goes beyond spelling
and grammar checking to help you
write more clearly and fluently.
The basic app is free.

Turn photos
into shapes
>adobe.com/uk
4 If you subscribe to Adobe's
Creative Cloud (£49.94/
month), you'll love Adobe Capture.
It can turn photos into editable
vectors you can use in apps such as
lllustrator. It can also identify fonts
and help create colour palettes from
whatever you point your iPhone at.
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>dayoneapp.com

Day One is the most

popular journaling app in
the App Store. It's fast and easy to
use; it works across Mac, iPhone and
iPad, and the full version isn't very
expensive (£3.49/month). It makes
keeping a journal as quick as posting
a Tweet, although here you can
protect it to keep everything private.

F Why Printers Add Secret Trac!

L] i

Airbrop  Pocket 9 Twitter

Copy S

Save everything

for later

>getpocket.com

4 Pocket (Free, offers IAPs)
is like Apple’s Reading List

in Safari. But more flexible, fun to

use and works on more than just

Apple devices. With Pocket you can

quickly share things you want to

refer to later, storing them in your

own personal library in the cloud.
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Record a screencast
4 You can record your Mac
screen using QuickTime
Player; open it from Applications
then select File > New Screen
Recording. Pick your microphone
if you'll be recording commentary.
If you need more control, try a
dedicated screen recording app
which includes editing features, such
as Capto (£19.99, globaldelight.com).

e~
acrurarned this gy 1. =
SEambied on

#GeglGadgets

=

>flipboard.com

Not an Apple News+

subscriber? You can create
a similar ‘Daily Me' personalised
newspaper in apps such as the free
Flipboard (i0S), which grab stories
from social media feeds as well as
learning what you like from news
sites worldwide. You can also publish
your own digital magazine.

Image credits: Auto
Coteater

Stop-motion animation
is great fun. Apps such as
Stop Motion Studio for iPad (Free,
offers IAPs) make it possible to
make your own without putting
in too much time and effort. The
tutorials are particularly good,
with lessons showing you how
do things like animate LEGO.

All-new panoramic
Apple Valley Fair opens
soon in Santa Clara

Get text

> textsniper.app

48 If you want to copy

text when the text isn'
copyable - such as text in an
image, a PDF, a video or an app

- TextSniper will help. Simply draw
around the words and TextSniper
will scan it and turn it into editable
text. It's a Mac app but you can use
your iPhone camera as its input.

ateat

attc Inc Global Defight Technologies Put
d it Later Inc. Fipboard, Valerls Boguekis


http://getpocket.com/
http://textsniper.app/
https://www.globaldelight.com/capto/
https://dayoneapp.com/
https://getpocket.com/en/
https://www.textsniper.app/
https://flipboard.com/

5

Honey makes Cash Back better.

& ® =) -

Pay less for things
49 If you install the free
Honey extension in Safari
it will automatically try to find
coupon codes to save you money
in the online shop you're visiting.
In many cases it can also tell
you if the deal you're looking at is
areal one or if the price history is
distinctly dodgy. It's a great little
app, and any savings are helpful.

The Measure app on your

iPhone and iPad is a little
gem of a thing. Measure enables
you to see how big items or spaces
are by simply pointing your camera
at them. We usi
of things like rugs, sofas, cars and
children, and it's really accurate on
‘iPhone or iPad Pro, where it u:

today. We have a lot to go over so let's get
started. First on the agenda is this new
marketing effort our client wants us to move
forwad with.

We've been working on different ideas on how
to portray the message. On screen are two

Highlight | Add Photo | Coy

Great turn around team |Could we increase the
size of the copy an option one? It weuldl
improve the composition, have we tried that?
For option two it's almost there perhaps
incorporate images of the target audience.

The user research came back and

Transcribe chats

>otterai

Change your look

4 amazin

5 Want to try out a hair
colour, a lipstick shade or
a pair of glasses? Fortunately, your
Mac, iPhone or iPad camera enables
you to use virtual try-on services
from the likes of L'Oreal and
Maybelline, among many others.
You'll find dedicated apps in the
App Store for big-name brands but
most have website versions too.

5 If you want to turn speech
in video calls, meetings
or lectures into editable text,
Otter (Free, offers IAPs) does it
incredibly well on iPhone or iPad.
It'll turn speech into text in real time
if you have an internet connection,
and you can train it to recognise
specific speakers.

g projects FEATURE

Write a song
>felttip.com
5 You don't need to know
much music to write a great
song. If you search the App Store
for the Circle of Fifths, Opus 1app
(£2.49), it'll enable you to find notes
or chords that work brilliantly
together in Western chromatic
music such as pop, rock and dance
music in both major and minor keys.

All Apps
) o o “™

POF Sewrch

Se  Nowran Uyssos

m
Why buy or subscribe
to lots of individual apps
when you can have every app for

a single payment? That's the deal
with Setapp, which starts at $9.99

(about £12) a month for one Mac
or $12.99 (about £16) for Mac and
i0S and gives you over 230 high-
quality, ad-free ap
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>Master Apple
shortcuts

mac0S

> (%] is the Command key,
which is also labelled cmd.

> =/ means the Option key,
labelled alt or opt.

> e means the Control key,
labelled ctrl, and shown as *
in shortcuts in the menu bar.
>l is the Shift key.

» <! is the Delete key, which
deletes to the left. [in +<|
deletes to the right.

> =l is the Tab key, which
shifts the focus between
'some controls.

ios

> A tapis a brief contact of
(usually) one finger on your
device's screen.

> To dragis to move a finger
across the screen to scroll

or pan around content.

> Swipe means move one or
more fingers across an item
or the screen, then let go.

5 A flickis like swiping, but it's
quicker, and is often used to
scroll content more quickly.

> Pinch means move two
fingers together or apart,
usually to zoom in or out.

> Touch and hold means lightly
rest your finger on an item
and wait for a reaction.

NEW
IDEAS
—

YYour in-depth guide to
getting more from

your Apple kit
=

Contact us

Email your queries and
your questions to
)

WHAT'S INSIDE
—

38 MANAGE MAC NOTIFICATIONS
> Master Notifications and Widgets in macOS 12

40 USE DYNAMIC LINKS

> Add links in Pages, Numbers and Keynote

42 MAKE WEBSITES BEHAVE
> Take control of Safari website pop-ups

44 CONVERT MULTIPLE IMAGES

> Use Preview to convert image formats

46 NEW i0S/iPADOS 15 FEATURES

> Discover what's new in the latest updates

48 MASTER MACRO MODE
> Capture eye-catching shots from your iPhone

50 HELP SCIENTIFIC RESEARCH

> Use your iPhone to power medical analysis

52 TAILOR YOUR HOME SCREEN

> Customise your device in just a few taps

54 HOW IT WORKS
> Apple's Magic Trackpad explained
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Manage macOS notifications

Stay focused and distraction-free while working on your Mac

IT WILL TAKE
>10 minutes

YOU WILL LEARN
> How to tweak
notifications and
widgets to suit the
way you work

YOU'LL NEED
>mac0S 12 or later

Genius tip!

>If you dismiss an alert
by swiping it away,
macOS stores it in the
Notification Centre. You

can take action on the
notification from here.

38 | MACFORMAT | JUNE 2022

With so many apps loaded on

to our devices, it's easy to get

overwhelmed with the sheer

number of notifications fighting
for our attention. That's particularly true on
the Mac, a device where so many of us do our
daily work - and where we really need to
concentrate the most.

Luckily, macOS Monterey has several
built-in features that can rein in the chaos
and let you get back to the things that matter.
From Focus mode to fine-grained notification

controls, there are plenty of ways to get more
control over the information thrown your way.

It's also worth looking at widgets, as
these handy mini apps can display pertinent
information right from the Notification Centre,
meaning you don't need to wade into each app
every time you get an alert.

We've taken the plunge and explored each
of these features to bring you the best in
notification management. Put our tips into
practice to restore some peace and quiet
in your daily Mac life. Alex Blake

HOW TO Manage macOS notifications >

€ oot

o= s e

App-specific alerts

Click System Preferences > Notifications &
Focus > Notifications, then choose an app. You
can disable the app’s notifications and change
their style, or tweak other settings, like
whether they are time-sensitive.

_

Q=
@
& oo

€ rowrtsers

Critical alerts

Some apps (such as Home) have an
option for critical alerts. In the case of Home,
this could mean sending you a notification
from a smoke detector alarm even when you
are using a Focus mode to block distractions.



macOS notifications APPLE SKILLS

CONTINUED... macOS notifications »

& =

General options

At the bottom of the settings pane are
some general options. You can tell macOS
when to show notification previews (only when
unlocked, for example), whether to allow alerts
when your display is sleeping, and more.

e @D

Location alerts

Under Turn On Automatically, click *+,
then Add Location-Based Automation. Enter
your workplace’s address, click the result,
then click Add. Now the Focus mode will
automatically turn on when you arrive at work.

7 Mac widgets

Now let's add some widgets. Click the date
in your menu bar to open Notification Centre.
At the bottom, click Edit Widgets. Now choose
an app. Apps may offer different widgets, plus
different sizes for each widget.

[
B o
B s

o

Work Focus

Now click the Focus tab. We'll create a
work Focus. Click the ‘+ in the bottom left and
click Work. Under Allowed Notifications From,
click Apps, then '+ and add some apps. Click
People and choose who can contact you.

Menu bar icon

Go to System Preferences > Dock &
Menu Bar > Focus and tick Show in Menu Bar >
Always. Now when you want to enable a Focus,
just click the Focus icon in your menu bar and
pick an option, like Work or Do Not Disturb.

8 Customise widgets

Open Notification Centre and '« -click a
widget, then click Edit [App]. For the Clock app,
for example, you can change which cities are
displayed. You can also change the size of a
widget by «=/-clicking it.

Jargon buster
>You can set important
alerts (like imminent
calendar events) to be
time-sensitive. These
are allowed through
even when a Focus
mode is active.

Genius tip!
>In Focus settings,
the Share Focus Status

option willlet your
contacts know you're
busy if they message
you while a Focus
mode is active.
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IT WILL TAKE
> 30 minutes

YOU WILL LEARN
> How to use links
n Pages, Numbers,
and Keynote

YOU'LL NEED
> Pages, Numbers,
and Keynote

Genius tip!

>To insert a link to web
video in a document,
click the Media button in
the toolbar, choose Web
Video and paste the link.

40 | MACFORMAT | JUNE 2022
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Use dynamic links in \Work

Discover how to add links in Pages, Numbers, and Keynote

The humble link has lots of
different uses, and they are
employed to great effect in
Apple's Pages, Numbers, and
Keynote applications. You can use them
for tasks as simple as directing your reader
to a web page or opening an email with the
address field populated. So far, so obvious. But
links can also be used to accommodate online
video from the likes of YouTube and Vimeo in
your documents and presentations, and to
direct readers to pages, or sections of texts.

There are a few different ways to create
links, depending on what you're linking to.
And there are some conditions attached. For
example, if you want to link to a bookmark in
Pages, you'll need to set your document to be
aword processing, rather than page layout,
document. Page layout documents can only
link to pages, not sections.

In this tutorial, we'll show you how to make
the most of adding links, whether that's in
Pages, Numbers, or Keynote.

Kenny Hemphill

HOW TO Add URL links >

g e s

nk sistgn vt i con].

suspendsa napratum. i
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‘] Web link on Mac

In Pages, Numbers, or Keynote, select some
text or select an object on the page orin a
slide. [-click and choose Add Link then ‘Web
page’. Paste or type the URL of the page in the
Link box. Click anywhere on the page.

Web link on iOS

Tap an object on the page, or select text
by tapping and holding then dragging anchors
over the text. Tap Link, then tap the Link To
box and choose ‘Web page’. Type the URL in
the Link box. Tap anywhere on the page.



CONTINUED...
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3 Email or phone number

The process on both the Mac and i0S is
the same as for a web page. In this instance,
choose Email or Phone Number after tapping
Add Link or Link To. Type the address or phone
number in the Number or Email box.

Edit a link

Click the link text, the link button on an
object, or double-click the cell with the link in
Numbers. In the link editor, make the changes
to the link or click Remove to get rid of the link.

Click anywhere outside the editor to close it.

Travel guide

Create a bookmark

You can bookmark text only in a Pages
word processing document. Select the text you
want to bookmark, or place the insertion point
before it then click on the Bookmarks tab in
the Document sidebar. Choose Add Bookmark.

Add dynamic links APPLE SKILLS

Add URL links >

4 Page or slide

In Pages or Keynote, select the object you
want to link from. «-click on it and choose
Add Link on Mac or Link To on iOS. Choose
Page (Pages) or Slide (Keynote) from the
menu, then choose the page or slide number.

1T SITGES

Turn off links

To display URLs, email addresses and
phone numbers as plain text, rather than links,
go to Preferences > Auto-Correction. Uncheck
the boxes next to ‘Automatically add links... for
web pages and emails, and phone numbers.

The Cathedral of the Holy Cross ar

nce you've had lunch, you'll want to walk aroun
better to head. th" ~ here?

Display: lunch

Linkto:  Bookmark

Goto Bookmark

Link to a bookmark

In the same Pages document, select the
text you want to link from, click Insert in the
toolbar, then choose Link > Bookmark. Or, click
%+ k| then Bookmark. Select the bookmark
from the Bookmark menu.

Jargon buster
> A bookmark is a
section of text ina
Pages word processing
document to which

you can link from

any text or object.

Genius tip!
>When you link an
object, such as an image
or shape, you will see

an arrow appear on it.
Double-clicking it allows
you to edit the link.

JUNE 2022 | MACFORMAT | 41



APPLE SKILLS Mac softw.

£ Notications

Websites

2.8,.8

Content Blockers
Adto-piay

B sctveriody com
] @ amazoncouk
Camers & chackatrade.con
oc designeuts com
Mictophone

& docs googlecom
g G googlecouk
Location = ke com

L. Heratureandiatte.com
Douriosds

D minimaidesksetups.com

 piseimatorcom

Alow 50p-up windows on the wabsites below:

When visiing other webstes:

Bock ana oty @
Bock and Notty @
Bock and Notty @
Bock and Notty @
ock anc Notty
ock and oty @
ock and Notty
Block and Nty @
Bock and oty @
Bock and Notty @
Bockanaaty @

Make websites behave

Fed up with pop-ups and auto-playing videos? Take control with Safari

IT WILL TAKE
>30 minutes

YOU WILL LEARN
How to stop annoying
online interruptions
in Safari

YOU'LL NEED
> Safari for macOS

Jargon buster
> Configured websites
are websites for which

you have previously
chosen an option

to either allow or

deny, say, location
information but which
are not currently open.
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Privacy has been at the
heart of many of Apple’s new
features and improvements
in macos in recent years. And
nowhere is this more evident than in Safari.
Whether it's preventing you from being
tracked by cross-site cookies as you browse,
or displaying a privacy report for the websites
you visit, Apple has done much to make
Safari more secure. In addition to those
improvements, there are a whole host

Safari's Website Preferences lsts stes that are currently
open and those you have previously configured.

of ways you can tweak how Safari deals
with websites that may want access to your
microphone or camera, or auto-play videos,
display pop-ups or notifications, or want to
Kknow your location.

You can control what data websites
have access to and how far they can go with
putting content in front of you using Safari's
preferences. And you can even tell specific
websites to always open in Reader mode -
ideal for sites that seem not to care whether
videos and other animated content prevent
you from reading the words on the page.
Preferences can be set on a global basis,

50 all sites follow the same rules, or ona
site-by-site basis, whichever you prefer.

Further control

And, by using third-party extensions such as
content blockers, you can add another layer

of control. If you do use a content blocker,

you can specify in Preferences which

websites it applies to. In this tutorial, we'll
show you how to fine-tune Safari's preferences
so that every website you visit behaves exactly
as you want it to. Kenny Hemphill
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HOW TO Configure Safari website preferences >

‘] Control pop-up windows
Click the Safari menu and choose
Preferences. Select the Websites tab

and scroll down to and click Pop-up
Windows. To control pop-ups for
currently open tabs, choose one, click

the menu next to it and choose an option.

2 Manage for other sites
Once you've set the pop-up
preferences for all the currently open

tabs, you can dictate behaviour for every
other website collectively. Click the menu

next to ‘When visiting other websites’
and choose an option.

Website notifications
Choose Notifications from
Preferences > Websites. Choose an
option for each website listed. To prevent
every other website from sending
notifications, uncheck ‘Allow websites
to ask permission to send notifications'’.

4 Configured websites

To change options for websites
that aren't open, scroll to the bottom of
the window and look under Configured
Websites. Choose a website and click
the menu to change its configuration.
To reset it completely, click Remove.

Content blockers

Choose Content Blockers in the
sidebar. This will configure all the
blockers you have installed. Click the
menu next to each website in the list
and choose On or Off. Choose an option
from ‘When visiting other websites'".

Open in Reader

If you're fed up with manually
clicking the Reader button for certain
websites, select Reader from the sidebar,
choose a website and set the menu to
On. If a website you want to configure
isn't listed, open it in a tab in Safari.

L —r )

8 Configure Auto-Play
There are three options for auto-
playing videos: Allow All Auto-Play, Stop
Media with Sound, or Never Auto-Play.
To configure it, choose Auto-Play in the
sidebar and follow the same process
for open tabs and the rest of the web.

Install content blockers

Before you can configure a content
blocker, you'll need to install one. Click
the Safari menu and choose Safari
Extensions to go to the relevant
section of the Mac App Store. Choose
an extension and click Get to install it.

9 Set Page zoom

You can control whether websites
open at 100%, or range the zoom from
50% to 300%. Select Page Zoom in
the sidebar. Choose an option for each
website that's currently open, then for
every other site on the web.
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Export menu
> The Export
menu allows you
to choose the
file format and
quality to use for
covered images.

(2]

Export image
as a PDF

>If you want

to export the
image as a PDF,
it has its own
command in the
File menu

Select
thumbnails

> You can use
the sidebar to
select multiple
thumbnails

to convert.

(]

Image
batches

> The Tools menu
houses other
options which
can be used

on batches

of images.

Convert multiple images

Use Preview for a quick way to convert lots of images to a different format

IT WILL TAKE
>30 minutes

YOU WILL LEARN
> How to convert
batches of images
in Preview

YOU'LL NEED
»macOs, Preview

Use Preview
to convert
images to and
from lots of
file formats

44 | MACFORMAT | JUNE 2022

The Mac's Preview app has
evolved into a very useful tool

m for viewing, editing, converting,
and annotating images and PDF

documents. In fact, if you need to quickly

resize an image, change its format, or add

a comment or visual note to i, there are

few better tools available.

In this tutorial, we'll focus on using it to
convert multiple images in a batch from one

IMG_0394.HEIC
D e, 1 tota pooe

Preview's sidebar can display thumbnails of images, a
table of contents, highlights and notes, or bookmarks.

format to another. One use case for this
could be when you take photos on an iPhone,
AirDrop them to your Mac and need to upload
them to a website or server, or email them to
a friend. By default, the images are saved as
HEIC (High Efficiency Image File) format.
That's the format Apple has used since i0S 11
for iPhone camera images. However, it's a
proprietary Apple format, not an open
standard like PNG or JPEG, and so is no good
when it comes to uploading to a website or
sharing with someone who doesn't use a Mac.

Various file formats

You can use Preview, however, to convert
images to and from lots of file formats, 18 in
total, including BMP, TIFF, native Photoshop
files, and PostScript formats. And it's not just
file formats you can convert. You can resize
batches of images too, using the same
technigue. Or, you could rotate or flip

images in batches.

Sadly, there's no way to add a watermark
to a batch of images, or to rename them.
Hopefully those will come in a future update.
In the meantime, here’s how to batch convert
images. Kenny Hemphill
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HOW TO Convert image formats >

d |
=) vmm Selcton (1 )

‘] Choose your images

Locate the images you want to convert

in the Finder and % -click on each one. Once
you've selected them all, if Preview is the
default app for opening them, double-click. If
not, [« -click and choose Open With > Preview.

Nonsoseptens

Convert file format

With the thumbnails selected, click
the File menu and choose Export Selected
Images. Navigate to the folder where you
want to export the converted images and
click the Options button.

[—r—

5 Batch resize images

Follow steps 1and 2 to choose images and
select them in Preview. Click the Tools menu
and choose Adjust Size. Choose dimensions
from the ‘Fit into" menu, or choose Custom to
set your own. Set the resolution and click OK.

oo (@ Moosa

i

Tableof Contents
Highlights and Notes
Booimarks

Contact Sheat
Continuous Seroll
Single Page.
Two Pages

2 Select images in Preview
Click the sidebar icon in the Preview
toolbar, or the View menu, and choose
Thumbnails. Click in the sidebar, but not

on an image, and then click [z +4| to select
all the images you have just opened.

4 Set parameters

Click the Format menu to choose a file
format for the exported images. Then use the
Quality slider to choose the image quality. Note
that the file size changes as you move the
slider. When ready, click Choose to export.

o

=3
'
6 Rotate or flip images

Some other options in the Tools menu can
be performed on batches of images. You can't
adjust the colour or annotate batches, but you

can choose the Rotate or Flip commands to
perform those actions on multiple images.

Jargon buster
> The format an image
is saved in dictates
what data the file
holds, how it's stored,
and whether the

image is compressed,
among other things.

€

Genius tip!
>When you click the
Format menu to choose
an image format, hold
down the = key to

see the full range of
available formats.
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New features from Apple

Discover Univer

Find out
about the
latest hrm“
features iniOS
and iPadOS 15

>Face ID can also
tore

gnise you

you're wearing glasses.
Todo that, tap Add
Glasses in Settings >

ID & Passcode.
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Control, Face ID v

i0S and iPadoS 15.4 were
significant updates that
introduced a host of new
features. Among them are Face

D while wearing a mask, Tap to Pay on iPhone,

improved SharePlay integration, Shortcuts
notifications, changes to the TV app, Notes
in iCloud Keychain, and custom domains in

vith a Mask, Tap to Pay and more

iCloud Mail. There are also new emoji
to choose from, and plenty of other tools
to discover and take advantage of.

All devices from the iPhone 65 onwards
can use IS 15.4; this includes the original
iPhone SE, the 2020 iPhone SE, and
the seventh-generation iPod touch.
Charlotte Henry

EXPLAINED... What's new ini0OS15.4 >

a1

Use Face ID with
aMask

Face ID is most accurate whenit's set up for
fullface recognition only. To use Face ID
while wearing a mask, iPhone can recognise

‘] Face ID with a Mask

Go to Settings > Face ID & Passcode. Turn
‘Face ID with a Mask' on and follow the on-
screen instructions. You can also add glasses
here. Again, go to Settings > Face ID & Passcode,
and tap the Add Glasses option.

Daredevil | Disney+ X

/& SharePlay

=)
®
Chartote’s

Mac mini

2 Easy SharePlay access

A new button makes accessing SharePlay
easier. If a service supports SharePlay, the
option will be available in the Share menu,
accessed by tapping the Share icon or *..." (top-
right corner) and opening the share sheet.

>Image credit:
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CONTINUED... What's new ini0S 15.4 »

£) icloud Mail

5. Learn more.

&% Custom Email Domain

iCloud email

Users can now set up iCloud email for
custom domains directly. Go to Settings > Apple
ID > iCloud. There, you can set up email for a
domain that you own or add existing email
accounts from a custom domain.

5 Tap to Pay

Tap to Pay is an exciting development.

It enables you to accept contactless payments
directly via your iPhone - there's no need for
any additional hardware or software. The
feature is only available in the US for now.

Do

Play Music

Ask Before Running

Shortcut automations

In Shortcuts, tap the Automation tab and
choose ‘Open an Automation’, then switch off
Ask Before Running; the Automation will now
run without asking for permission. There's
also a new Notify When Run option.

<1V Up Next Display
Still Frame v
Poster Art
roc how or mov ayed i
e, n hat
4 TV app art choices
In the TV app, you can now change the

art displayed in the Up Next section. By going
to Settings > TV > Up Next Display, you can
choose between seeing a still frame from

the TV show or film, or its poster art.

¢ Settings  Face ID & Passcode

iPhone Unlock
Tunes & App Store
Wallet & Apple Pay

Password AutoFill

Ll

Other Apps 2

Notes in iCloud Keychain
i0S and iPadOS 15.4 now allows you to
add Notes in iCloud Keychain. It means you
can leave yourself a reminder about what a
particular service is, or any other info related to
the account you might want to store securely.

Ccanen p—
[ —
o ©
[——— e

Universal Control

Universal Control enables you to control
your Mac and iPad using just a single mouse
and keyboard. On an iPad, go to Settings >
General, then tap AirPlay & Handoff, and
turn on ‘Cursor and Keyboard'.

Small things...
Other notable changes
and improvements in
the latest update

Sscrotons

| App Store
notifications
A new notifications
panel in the App Store
enables you to opt

in to alerts for New
Features & Updates,
and Recommendations
&Offers.

Podcast
filters
There are new podcast
options for shows you
are subscribed to that
filter Unplayed and
Downloaded Episodes.

® @
3 New emoji
As with all i0S/

iPadOs releases, i0S/
iPadOS 15.4 introduces
new emoji. There are 37
additions this time
around, including a
melting smiley face,

a face with hands
covering the eyes, and
there are handshakes
using hands with
different skin tones.
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Master Macro mode

Capture eye-catching shots and see the world afresh from your iPhone

IT WILL TAKE
>15 minutes

YOU WILL LEARN
> How to capture sharp
shots of small subjects

YOU'LL NEED
>iPhone 13 Pro or Pro
Max; Halide MK 2.7.5
(Free, offers IAPs)

HOW TO Trigg

Macro photography enables

you to capture a close

encounter with a wide range

of objects, plants or creatures.
With the release of the iPhone 13 Pro range
(and i0S 15.2), you can snap details that aren’t
easily visible to the naked eye - such as a
pollinating bee's proboscis or flakes of
peeling paint on a rusty sign.

Unlike older iPhone models, the Ultra Wide

camera on the iPhone 13 Pro and Pro Max has
an autofocus capability that enables you to

er the Macro mode »

capture sharp macro shots from about an inch
(or two centimetres) away from your subject.
We'll demonstrate how to shoot a variety
of subjects using Macro mode and capture
the classic background blur (bokeh) that's the
hallmark of macro photography. Your iPhone
13 Pro (or Pro Max) will automatically switch
to the Ultra Wide (0.5x) camera if you get very
close to your subject and this can change your
shot's composition, so we'll show you how to
toggle Macro mode on and off for
more control. George Cairns

S Munesy
® Game Conter

B ™ Provder
‘I Macro settings
Macro mode is triggered

The big picture

2 Macro opens up a

new world of texture and detail. From

when in close proximity to your subject.

To have the option to toggle it on or off,

go to Settings > Camera and swipe down
to Macro Control. Tap the toggle button

toturn it green.
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a distance this vintage sign has a retro
charm, but if we take a closer look we
can capture more abstract textures
such as peeling paint and rust.

Get close

Here we've set the iPhone to use the
Wide camera. As we move the iPhone to
2cm from our subject it automatically
switches to the Ultra Wide camera, and
the flower-shaped Macro icon appears.
Tap to snap a macro shot.

»Image credit: Lux Optics Inc
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HOW TO Capture a macro bokeh »

1 Add depth
The metal sign in the previous step
was flat. By shooting a subject that has
more depth (such as chain links here),
you can capture a background blur that
helps the eye focus on a particular
foreground detail.

2 Toggle macro

To see the difference between the
results produced by the Ultra Wide and
the Wide cameras, simply tap the flower-

shaped Macro icon to toggle it on and off.

When it's off, the Wide (1x) camera can't
focus when 2cm away from the subject.

| S§ .
3 Sharp shooter

Tap on a particular object in the
image (such as a chain link) to set the
focal point. Place the main subject in
the centre of the frame as this is where
the Ultra Wide (0.5x) camera will be at
its sharpest focus.

HOW TO Use third-party macro solutions »

‘I Software solution

On older iPhones, shoot macro
pictures using Halide MK 2.5. In manual
focus mode, tap the flower-shaped Macro
icon to switch to the lens with the closest
focal distance. Fine-tune the focus with
the focus dial.

2 Focus peaking

It can be a challenge to get the key
subject looking sharp in a macro shot
because of the shallow depth of field.
Halide MK 2.7.5 has a focus-peaking
tool that outlines the sharpest areas

in green to help you stay focused.

Macro footage

Hardware

iPhone X, XR and 11 users can use
the ShiftCam MultiLens Case's 10x and
20x macro lenses (shiftcam.com). These
produce classic macro shots that have a
beautiful background blur (as you can
see in our main bumble bee image).

Capture small, fast-moving subjects in macro clips >

Subjects such as insects don't stay still for long enough to snap a sharp macro
shot. Set your Camera app to Slo-mo mode. In Slo-mo the iPhone 13 won't
automatically switch to Macro mode but you can tap the 0.5x icon to use the
Ultra Wide camera. Tap record and film your insect from as close and you can
get, following it as it flies. On playback, what would be a jerky handheld clip in
real time will now look steadicam-smooth in slow motion. You can share the
sharpest frame as a still macro image using File > Share > Image in iMovie.
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ing

Corona-Al (Phase 5)

ftware

¥

i} [

You're supporting
Corona-Al (Phase 5)

Power scientific research

Fight Covid and other scientific investigations with this clever app

IT WILL TAKE
>5 minutes
to set up

YOU WILL LEARN
> How to help solve
scientific pro
using your

YOU'LL NEED
>DreamLab (free), iOS
13.1 or later, macOS
10.15 or later

Aslongasit's
charging and
unlocked, your
device can be
put to use
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The world is full of complex

scientific problems, with even

more thrown into the mix

thanks to Covid. Even at the
planet's foremost research facilities, the
process of solving these issues can be slow,
and helping out can obviously seem like an
impossible task when all you have in your
arsenal is an iPhone and a Mac.

Currently powering

Corona-Al
(Phase 5)

You can find out how much your device has helped your
chosen research project on the Contribution tab.

Thankfully, you don't need a room full of
million-dollar supercomputers to help. All you
need s the DreamLab app, a compatible Apple
device, and a bit of time where you can let it
work uninterrupted. As long as it's charging
and unlocked, your device can be put to use.

Algorithm ability
DreamLab is a distributed computing platform.
It uses the processing power of thousands of
devices - including your own - to help tackle
scientific problems. In the case of DreamLab,
that power helps speed up the algorithms hard
at work at Imperial College London, enabling
them to find potential cures faster. Thanks to
the power of the crowd, you can do your part
in helping the fight against Covid and cancer.
DreamLab’s developers suggest you run
the app overnight while you sleep, but you can
run it whenever you have some free time and
don't need to interact with your device. And
if you have a spare iPhone lying in a drawer,
DreamLab can give it a new lease of life
helping to power vital research. Alex Blake
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HOW TO Help scientific research »

Vodatone
Foundation

Dreamlab

You're supporting
Corona-Al (Phase 5)

| B

‘] Quick start

Getting started in DreamLab only requires
a couple of taps. On the app’s home page, you
will see which project is automatically chosen.
In this case, it's Corona-Al (Phase 5). Let's
leave that one selected.

You're supporting
Corona-Al (Phase 5)

00:45:17

Hands-free operations

While DreamLab is working, leave your
device alone. If you close DreamLab, lock your
device, or stop it charging, DreamLab's session
will also end. This can also happen if your
internet connection is interrupted.

You have powered
DreamLab for

00 04 25

Lifetim

calculation: runched

Your contribution

The Contribution tab shows how long
you've powered DreamLab and how many
calculations your device has crunched. It also
shows your chosen project’s progress. To see
the latest goings-on with DreamLab, tap News.

B

To power DreamLab

1. Charge your phone

2. Open the app

3. Press Power DreamLab
4. Don't press home or lock

2 Connect to power

DreamLab only works when your device is
connected to power and unlocked. When you're
ready, tap ‘Start session’, connect a power
cable or use a wireless charger, then tab

‘Got it!". DreamLab will now get to work.

4 Project selection

At the bottom of DreamLab’s home

page, tap Projects. Here, you can choose what
problems to help solve. At the time of writing,
we could choose the Corona-Al and Cell
Identity Hunter projects. Tap one for more info.

< Settings Reminders

PUSH NOTIFICATIONS.

Daly Reminder

Set a reminder

Tap Settings > Reminders for a daily
prompt to start using DreamLab. Tap the time
box to set when the alert is sent. The Settings
tab also lets you set data usage limits (for Wi-Fi
and mobile data separately) and more.

Jargon buster
>DreamLab’s research
involves calculations.

It downloads small
parts of large data
sets, crunches the
numbers, then sends
off the results.

L3
R
‘ &P
S
Genius tip!
>You can also run
DreamLab on your Mac.
Plug in your computer
and leave it undisturbed
while DreamLab runs.

=7 V=t

0440
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17:07 9
® <

Live

Wallpapers

Q
still

Show All

3 Aesthetic

Tailor your Home screen

Give your device a whole new customised look in just a few taps

IT WILL TAKE

>5 minutes

YOU WILL LEARN
> How to install and
customise themes,
icons, wallpapers, and
widgets with Themify

YOU'LL NEED

> Themify (premium
subscription optional),
i0S 14 o later

Genius tip!
>When viewing a theme,
tap the heart to save

it to Favorites. To find
your saved themes,

tap the heart on the
Themify home screen.

< [
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Ever since iOS 14 brought
widgets to the iPhone and iPad,
people have been looking for
ways to spruce up their Home
Screens with fresh new looks. With the
Themify app (free, with IAPs) close at hand,
that's easier and quicker than ever before.

In this guide, we'll show you how to
customise your Home Screen so it's truly
personal to you. Whether that means adjusting
afew app icons and adding a video wallpaper
or going for a complete visual makeover,

0::

10:09

Themify makes creating a new style quick
and, dare we say it, even fun.

Themify's free version gives you plenty of
content, but its premium version unlocks even
more, including exclusive themes and extra
widgets. It also removes ads and lets you
install more than five app icons at a time.

Whether or not you decide to pay for the
full version, Themify is a great way to refresh
your device's style without requiring a ton of
fiddly hacks and workarounds. Let's find out
just what it can do. Alex Blake

HOW TO Sort your Home Screen >

Q Themes &

) Aesthetic Show All

‘] The Theme tab

At the bottom of Themify's home screen
is the Theme tab. Here you will find pre-made
designs that marry icon sets, widgets and
wallpapers for a total Home Screen overhaul.
Tap a theme you like the look of, then tap Try.

S teons Select All
Paired Up Unpaired
Evernote
> G Install &,

2 Unpaired icons

You will see the theme's icons paired to
each app. For any not done automatically, tap
Unpaired, then tap the '+' and choose an app.
Tap Install. Safari will open. Tap the Share
button, then ‘Add to Home Screen’.
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CONTINUED... Sort your Home Screen »

Evernote

Install &,

Install &,

3 Add multiple icons

To add icons for multiple apps at once,
choose your icons, then tap the checkboxes
next to the apps. Now tap Install Selected Icons
and download the icon profile. Go to Settings >
Profile Downloaded to install it.

Reset Background

6O B O &
s O+

wckgrownd ot E

Spring

Icon Maker

Tap Icons, then tap Icon Maker. Tap
Background and choose a colour, then tap
Content to choose a logo for the icon. Give
it a frame if you like, then tap App to assign
it to an app. Tap Save when you're finished.

7 Add some widgets

Back in Themify, tap Save next to Widgets.
On your device's Home Screen, long press an
empty space, then tap '+ Choose Themify, pick
a widget, then tap Add Widget. Widgets are
listed in the order you saved them.

Cancel

Widget Color [x]

¢80 O

Quick tweaks

To create custom icons, choose a theme,
then tap Customize. Tap Wallpapers, Widget
Font, or Widget Color to make some quick
changes to the appearance of the theme. We'll
get more in-depth with Icons in the next step.

Set Lock Screen
Set Home Screen

Set Both

Set a wallpaper

Let's add a wallpaper. Next to Wallpaper
at the top of the theme's Try page, tap Save.
Open Photos, tap the Share button, then tap
Use as Wallpaper. Adjust the fit, tap Set, then
choose Lock Screen, Home Screen, or Both.

) Aesthetic

Show All

P

€ &
e o0 BE

L ¥ @

Individual elements

If you'd rather just install icons,
wallpapers, and widgets without a whole
theme, you can simply tap one of the bottom
buttons on the app’s home page. The process
is similar to that used when installing themes.

Jargon buster
>Unsurprisingly,
Themify is built on
themes. These combine
icons, wallpapers, and
widgets, all united by

a similar aesthetic

or visual style.

Genius tip!
>Tap the gear icon

to adjust Themify's
settings. Here, you can
change formats used
on widgets and reduce
motion when tapping
on app icons.

o
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P2 siow 17 works | .
Apple Magic Trackpad

Apple mice may not be perfect - but the Magic Trackpad is the future

YOU WILL LEARN
> How the Magic
Trackpad works,

and how to use
Multi-Touch gestures

Simple
two-finger
gestures

are easy

to remember
and use

Key fact
> Apple is increasingly
pitching the iPad as a

device that can be used
for serious work, and
the iPad has been able
to use mice and
trackpads since i0S
13.4. Multi-Touch
gestures work well on
iPad too, such as
swiping up with three
fingers to go to the
Home screen, and
swiping sideways with
three fingers to switch
between apps.
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For all its legendary design
skills, Apple has managed
to make some truly terrible
mistakes with its mice (and
keyboards) over the years. The infamous
‘hockey puck’ mouse was a bit of a laughing
stock back in 1998, and even today the current
Magic Mouse is marred by Apple's bizarre
decision to put the charging port on the
underside of the mouse - which means that
you can't actually use the darn thing while
it's charging. However, Apple has also come
up with a really attractive alternative to the
traditional computer mouse in the form of
its Magic Trackpad.

Of course, the MacBook range and other
PC laptops have been using trackpads since
the mid-90s, but these early trackpads were
quite small and still had to provide separate
buttons that worked like the buttons on a
conventional mouse. It was only in 2008
that Apple introduced the MacBook Air
with a larger, button-free trackpad that
also supported Multi-Touch gestures,
such as pinch-to-zoom.

Then, in 2010, it released the first Magic
Trackpad, which was a separate, self-contained
trackpad that could sit on your desk and be
used with desktop Macs as well (and, more
recently, with iPads too). The Magic Trackpad 2
followed in 2015, providing a much larger
trackpad surface to work with, as well as
introducing new Force Touch features.

The latest version - simply known as the
Magic Trackpad once more - arrived in 2021,
although in reality this was really just a
cosmetic update designed to match the
look of the latest iMac models.

Now on ts third-generation, the
Magic Trackpad is a great altenative:
toa conventional mouse.

The Lightning connector on the back
is used for charging, but lets you
use it as a wired trackpad too.

Two-finger salute
Modern trackpads use electrical sensors
underneath the surface of the trackpad to
detect the movement of your finger - or
multiple fingers - so that you can control the
movement of the cursor on your computer
screen. The ability to detect two or more
fingers is generally referred to as Multi-Touch,
and Apple’s Magic Trackpad supports a variety
of Multi-Touch gestures, such as pinch-to-
zoom, and rotating two fingers in order to
rotate an image. You can also swipe with
two fingers to scroll up and down or side-to-
side, and if you're addicted to checking your
Notifications then a two-finger swipe from the
right-hand edge of the trackpad (not the Mac
screen) will open Notification Centre for you.
These simple two-finger gestures are
easy to remember and use, and have proved
popular with many people, but there are more
complex gestures that use three or four
fingers as well. These gestures aren't quite
so well known, simply because they're a bit
fiddly to use at times, but if you open System
Preferences on your Mac (running macOS
10.11 or later) and select Trackpad > More
Gestures, you'll see a list of gestures that are
available. For example, you can swipe down
with three fingers to activate Exposé, which




Magic Trackpad APPLE SKILLS

The Taptic Engine >

The Magic Trackpad doesn't have
any buttons or moving parts, but
you can still feel - and hear - the
trackpad ‘click’ when you press it.
This technology is known as haptic
feedback, and it enables devices such
as trackpads to create the sensation
of movement in response to actions
such as pressure from your fingers.
Apple's version of haptic feedback
is called the Taptic Engine, and it uses
magnetic coils - similar to those used
in speakers and headphones - to
create vibrations that make it feel

N
e W

The copper wire coils form
electromagnets that flex against a steel bar

located on the underside of the trackpad.
the vibrations of the Taptic Engine
create the sensation that the trackpad
is moving when press down on it.

&> System Preferences > Trackpad
also enables you to turn on Silent
Clicking which mutes the sound the
trackpad makes when you press on it.

as though the trackpad is responding
to your touch. If you turn the Magic
Trackpad off and press down on it,

you can feel that the surface of the

trackpad is fixed in place and doesn't
move. But when it's turned on again,

shows all the open windows for the current
application, but the more advanced four-
finger gestures are not for everyone.

Feel the Force (Touch)

As well as enabling you to perform Multi-
Touch gestures, a modern trackpad also has
to be able to recognise when you press down
- performing the equivalent of a mouse-click
- so that you can select a file or folder, move
it around on screen, or perform other tasks.

The first version of the Magic Trackpad
had an old-fashioned mechanical design that
simply treated the entire surface of the
trackpad as one large button that you
could push down to perform a mouse click.
However, the Magic Trackpad 2 introduced
a pressure-sensitive Force Touch sensor
that has no moving parts, but is able to
detect different degrees of pressure.

As well as being able to tap on a file to
select it - or double-tap to open it - you can
use Force Touch to perform additional tasks
by applying different amounts of pressure.

A quick tap still acts like a simple mouse click,
while pressing and holding allows you to
drag-and-drop. However, pressing down
more firmly activates Force Touch, which

can perform a variety of different tasks
depending on how you use it.

Using Force Touch on a document or
photo file activates your Mac's Quick Look
feature, so you can see a preview of the file
without having to open it first. You can also
use Force Touch to click a link on a web page
and see a quick preview of the linked page,
while using Force Touch to select a word in

>Image credit: GG
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The Trackpad Preference panel
provides tips for using the more
complex Multi-Touch gestures.

a text document enables you to quickly look up
its definition in your Mac’s built-in dictionary.
But for all its versatility, the Magic
Trackpad hasn't changed or improved very
much in recent years, suggesting that it's
probably gone about as far as conventional
touch-technology can go. But, of course,
we're all waiting for Apple to unveil a new
VR headset at the moment, and Apple has
recently registered patents for wearable
‘force sensors’ that can be used in VR
gloves or even shoes, enabling the wearer
to control objects in virtual reality.
So, rather than waiting for Magic Trackpad
3, it may be that the next version of Force
Touch technology breaks away from the
desktop at last and takes the next great
leap into virtual reality. Cliff Joseph

Mors Gasturss

SotUp Bltoon Trackpad. 7

Key fact

>Unlike the daft design
of the Magic Mouse,
which can't be used
while charging, the
Magic Trackpad can be
charged and used at the
same time - hallelujah!
Even better, you can
also turn Bluetooth off
while the USB charging
cable is connected and
just use it as a wired
trackpad - great if you're
security-conscious and
prefer to avoid using
Bluetooth altogther.
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EXPERT
ADVICE

Our resident genius
solves your Mac and
i0S problems

GENIUS
TIPS

Contact us
—

Email your queries and
your questions to

£0iTED BY HOWARD OAKLEY >

You have
custom access

elect your Home
S folder, or any of
the standard

folders inside it like
Documents, and Get Info.
In the lowest of the
sections, Sharing &
Permissions, does it report
that “You have custom
access"? Do you know
what that means?

Custom access is
Apple’s jargon to let you
know that macOS has set
an Access Control List
(ACL), in this case to
prevent anyone from
deleting those folders. If
you're good with Terminal,
you can use the command

1s -led ~

there to see the details
that the Finder is too coy
to reveal. But oddly Apple
doesn't explain any of this.
If you've invested in a
utility like TinkerTool
System (bresink.com),
you can view and change
ACLs with ease. While they
can get you into trouble
if you're not careful, it's
frustrating that Apple uses
them but doesn't trust us
to know about them.
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How a processor can reach 1,600%

What does CPU % mean in Activity
Q Monitor, and how can it exceed
100%?
by CHRIS PARRY

Although Apple doesn't provide any
explanation, this figure seems to
derive from what's known as active

residency, the percentage of processor cycles

that each core in the CPU is processing
instructions rather than being idle. The
number shown is the total of those
percentages for each core, 5o if your Mac has

eight cores, the maximum comes to 800%.

There are two complications. Intel cores
can use hyper-threading to effectively double
their throughput when under stress. Each core

can then run up to 200%, so those eight
cores could come to a total of 1,600% when
the pressure is on. ARM cores in M1 chips
don't have hyper-threading, instead their
frequency or clock speed can change, most
often seen in Efficiency cores. Unfortunately
at present no allowance is made for this, so
100% could be at a frequency of less than
1GHz, or over 2GHz, which represents a big
difference in work done.

So CPU percentage is an approximate
indicator of the total workload performed by
your Mac's processor, on a scale from O to
over 200%, depending on the number of
cores, and whether they're hyper-threaded.
More accurate figures are available from the
expert's command-line tool Power Metrics.

This eight-core Xeon processor in an iMac Pro has almost reached 1,300% CPU as ts cores go fully hyper-threaded.

genius@macformat.com
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Quick-fire
questions

As of i0S/iPad0S 15.4
you can't remove an
app from the App
Library without deleting
it altogether. All apps
nstalled, even those
offloaded to iCloud,

are automatically added
to the App Library
Touch and hold an
app’s icon and you're
given the option

to delete it altogether,
not to remove it

from the library.

Removing it and
reinstalling is often
curative, but deletes
allits data. Less
destructive is offloading
it by tapping Settings

> General > iPhone
Storage > [app name] >
Offload App. A minute
ater, tap Reinstall App,
and it may be fixed.
Also check for updates
in the App Store.

@

noosan

gueries and your que:

il you
 genius@macformat.com

I0S software

Swipe away your touchscreen troubles and
rekindle your love of Apple's mobile devices

Where to
back up to?

Should | back up my iPhone
Q to iCloud or my Mac?
by MARY BRIDGER
A you choose one or the
other, although which
comes down to personal preference
and convenience. The most
immediate difference between them
is that backups made to iCloud use
up some of your paid-for storage
allowance. If you're already using
most of that and would need to
increase your subscription, that's a
significant step. Although you don't
pay monthly for storage on your Mac,
you still need free space there.

Both types of backup exclude
most of the data already stored in
iCloud, such as Contacts, Calendars,
Notes, iMessages and text (SMS and
MMS) messages. Neither do they
include data from Apple Mail, or
content purchased through the
App Store, Music or Books. iCloud
backups don't include Activity
or Health data, although they're
always encrypted; if you encrypt
your backup to a Mac, that will
include both.

Accessibility is another concern.
So long as you can hook up your
iPhone to a decent Wi-Fi connection,
you can back it up and restore it anywhere.

If your backups are on your Mac and that's sick
or unavailable, then you have no backups. On
the other hand, you control how long you keep
'your backups on your Mac, which you can
archive to more permanent local storage.

It's really important that

iCloud

iCloud+

® Docs ® Messages @ Mail

Manage Storage

Photos

iCloud Backup

Keychain

Private Relay (Beta)
Hide My Email
iCloud Drive

iCloud Mail
Contacts
Calendars

Reminders

olellelellofle)

Touse iCloud Backup, you need ample free space in
your storage allowance and a good Wi-Fi connection.

Many users have been caught out by the fact
that iCloud backups are only kept for 180 days
after you stop or disable iCloud Backup, and
there's no option to retain them any longer
than that even when you have space.
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GENIUS TIPS Mac hardware

Mac hardware

We help to solve your hardware hassles, from
interrupted upgrades to running diagnostics

Quickfire
questions

Cleaners are useful for
removing dust and gunk
which accumulates in
cooling slots, through
which air is ducted to
stop the internals from
getting too hot. It's wise
to do this before the
summer. Don't apply
excessive suction,
though, and use a small
nozzle with great care.

Unlike Intel Macs, M1
models don't have
dedicated video
memory, as their GPUs
access main memory.
You can check how
much s allocated for
use by the GPU, and
how much is being used,
with CPUSetter from Bif.
ly/mac378cpusetter,
but there's nothing that
you can do to change it,
as memory is fixed,
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Aim to minimise storage
‘space use for virtual
memory, as indicated

by Swap Used in Activity
Monitor, and the VM volume.

More memory or storage inan M1?

When | choose my new M1 Mac,
Q should I get more memory or
abigger SSD?
by RODDY MARTIN

Apple silicon models come with
A special high-speed memory mounted

in the M1 chip carrier which can't be

upgraded or replaced, and their internal

storage i soldered in, again for performance

and security. While you can always add

external storage, it's essential to get both

right when you order.

M1 Macs use memory differently from
Intel models. They don't have any graphics
memory, as all parts of the chip including the
GPU share main memory to deliver the best
performance. This doesn't mean that you have
to add on an allowance for graphics use, like

the dedicated memory in graphics cards, as
they use memory much more efficiently. But
you do want to avoid them using ‘swap’ space
in storage. For most users, 16GB is a good
minimum, rising with your need for more
heavyweight apps.

Although it's possible to put your Home
folder on external storage, and some external
SSDs make claims of speeds approaching
those of M1 internal SSDs, unless they have
active cooling systems with fans they'll
undergo thermal throttling when used hard.

Apple’s pricing may seem high, but its
SSDs are high performance, and larger SSDs
not only perform better but last longer too.
What you save by skimping on internal storage
could increase wear and shorten life, as well as
being more work to manage. For most users, a
minimum of 1TB is a good starting point.

Email yor

r queries and your g 0s
* genius@macformat.com
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Replacing internal storage of most
iMacs isn't easy, and should be left
to a trained technician to perform.

Mac hardwa

Replace a Fusion Drive

What should | replace the Fusion
Q Drive in my iMac 27-inch 2017 with?
by BRENDAN SMITH

As your Mac is still supported by
Apple, you should be able to obtain

a replacement Fusion Drive, although
that will need to be fitted by an Authorised
Service Provider, and will possibly cost close
to the resale value of the Mac. A better option,
available at lower cost, would be to replace it
with an SSD, which will also be faster. The

most common problem doing that is the Mac
then struggles to update its firmware with its
new internal storage. You may be able to sort
this by installing new versions of macOS on an
external disk, which also updates the firmware
in the Mac itself, but some Macs refuse.

Either way, replacement requires tricky
internal surgery, as the display has to be
separated and left speaker moved, as shown
in iFixit's quide at bit.ly/mac378imacdrive.
You'll almost certainly want to pay a qualified
Apple technician to do that for you.

Is the internal SSD wearing out™?

Is there a reliable way to

check whether my Mac's

internal SSD is wearing out?
by DAVID WRIGHT

the condition of internal
storage using SMART status

indicators, the most information it gives inan SSD can only be
about this is in Disk Utility, where it written to around 10,000
simply reports the disk status as times. That means that
‘verified’, which is of no help in a 500GB SSD can have
assessing SSD wear. 10,000 x 0.5TB written

There are two ways to estimate
wear in an SSD. One is to check the
disk's SMART health indicators such as

according to the amount
of data written to the
drive. For either of these
you'll need a third-party
app such as DriveDx
Although macOS does monitor from

Each storage unit

to it before it's likely
to fail through wear.
If the indicated Data

e GENIUS TIPS

Because of its
materials and s

ucture,

you can't do anything

e remove

scratches. Cleaning

nt can damag

ng, petroleum jelly
d toothpaste

asive. De

whether to live with it or

pay for a replacement

holding the 0 key
during startup (Intel), or
through Recovery (M1)
Try this with your Mac
cold, first thing, and
arm later on,
Micromat offers tests
n Techtool Pro, and

ts dedicated ATOMIC

Specialist third-party disk utilities like DriveDx are needed to discover
ow worn out your Mac's SSD is.

Life Percentage Used, which should be
available for all recent Apple internal
SSDs. The other is to work out what
proportion of its life has been used

Units Written is 1,000TB, then it's

roughly 20% of the way through its life.
Both of those options are also

available for most Thunderbolt disks,

10ail your gueries and your questic
genius@macformat.com

but not for those connected by USB,
which require a free kernel extension
installed before their SMART indicators
can be read.
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GENIUS TIPS macOS

Quick-fire
questions

t the messages,
click and select
Archive. To free up
reat

storas

mailbox, and m

messages to that before

exp

ting that mailbox.
You can also set up
Smart Mailboxes to
automate this, and apps
like Moth's Mail Archiver
at mothsoftware.com
are even bettel

Most user apps run on
the MI's Performance

en they hog
rticularly with
sks to perform,

you can force them to
be run on Efficienc

slower but use less
power and don't get in
the way of other apps.
This is a feature of St
Clair Software’s App
Tamer from Bitiy/
mac378apptamer.
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MacOS

Shine a spotlight on the solutions to
your most irritating Mac problems

App Dock icons don't work properly

I normally open recent documents

Q through an app's Dock icon, and
clear that list in the app itself. Why

doesn't that work the same with apps like

NeoOffice, LibreOffice and OpenOffice?

by DAVID LISTER

Normally, when an app opens
a document, details of that are
recorded by Launch Services, part
of macOS which operates many of the features
associated with the Finder and common
human interface. Launch Services adds
that to the list of documents opened by
that app, and puts it into the list shown in
the app's Open Recent menu command.

Not only is this accessible within the app,
but those recent documents are also listed at
the top of the menu shown when you [« -click
on that app's icon in the Dock. That lets you

o teach them best practice.

saint, The Young Artist. Children are particularly vulnerable, and }

open any of those documents immediately,
without having to open the app first then
use its Open Recent menu command.

For this to work, apps have to work
with Launch Services, something built
into support in the AppKit framework in
macOS. Some apps, like OpenOffice and
its descendants LibreOffice and NeoOffice,
bypass that mechanism and provide their
own replacement services for opening
recent documents. Because those aren't
integrated with Launch Services, they
don’t work outside the apps, most obviously
in the Dock. As this can't be fixed readily
in the apps’ code, nor altered by the user,
it looks as if it's here to stay in those apps.

As with any bug in an app, you should
report it to the developer, but in this case
they're probably only too well aware of this
particular shortcoming.

@ A Practice of Painting2aa.odt
© CoHaRGITtests.doc
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New >
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Some apps like NeoOffice don't fully support mac0S features for managing recent document lists in the Dock.
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How to un-Setapp

About 40 new apps suddenly
appeared in Launchpad, none of
which linstalled. When | click on
them, I'm told | need a Setapp account.
How to remove them?

byDAVY HENDERSON

This is probably because you
inadvertently installed Setapp,
which is a subscription service to
those apps. If you can find the Setapp app
in your Applications folder, open it and use

Manage wireless devic
from your menu bar

g o

You can then opt to retain the apps, but they'll only
work when you sign back in to your Setapp account.

Toko btter Nover lose anyting
scroenshots nd GiFs youcopy

its Uninstall command in the Help menu
to remove it and installed apps.

If that doesn't work, you'll need to try
amanual removal. You'll find there's a full
list of all the components the service could
installin 3

These include the contents of ~/Library/
Application Support/Setapp, and two launch
agents whose names start with com.setapp
in the ~/Library/LaunchAgents folder.

You can also remove any of the apps
installed by Setapp in the normal way.

How to wrap
text to fit cells
in Numbers?
ail-click on a single
cell, and select Wrap
Text in the shortcut
menu. For whole rows,
columns, or tables
select the area then
click the Text tab in the
Format sidebar. The
Style button offers
Wrap Text in Cell.
How to start
chapters with drop
caps in Pages?
Select the letter you
want to set as a drop
capital, then select the
Style section in the
Format sidebar. Tick
Drop Cap and set style,
depth and options. You
can also then add this as
anew style to apply it
easily at the start of
each chapter.

FaceTime's preference settings control
which app is used to make calls from
other apps like Messages.

> Email your gueries and your questions
tol
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The

iPad

Written by Cliff Joseph >

With a range of screen sizes and more
power than ever, there's now an iPad
to suit everyone's needs

hen the iPad first

launched in 2011, it was

very much intended as a

device for entertainment,
rather than work, with a focus on web
browsing, music, video and FaceTime.
More recently, Apple has attempted to
position the iPad - especially the iPad
Pro - as a versatile and lightweight
alternative to a laptop, providing
enough graphical horsepower for
serious design and video-editing work.

Last year's adoption of the M1

processor in the 11- and 12.9-inch iPad
Pro - and now the 10.9-inch iPad Air in
2022 - takes the iPad into entirely new
territory. A decade on from the iPad's
inception, these three iPad models now
provide the same levels of power as the
Mt-based 13-inch MacBook Pro, Mac mini
or 24-inch iMac, making them a genuine
alternative to a MacBook Pro or even a
larger desktop Mac.

2021 saw the continuing convergence
of iPadOS and macOS, with features
such as Universal Control promising to
make the iPad a versatile companion for
your Mac. Admittedly, Universal Control
only arrived with the macOS Monterey
12.3 update in March 2022, but your Mac
and iPad can now share the same mouse
and keyboard while you work, and even
enable you to quickly drag and drop files
from one device to the other.

Of course, not everyone needs a
top-of-the-range iPad with M1 chip; the
standard 10.2-inch iPad still provides an
affordable option for entertainment and
web browsing. And, for people who need
to opt for an ultra-portable device,
there's the iPad mini, with its 8.3-inch
screen and max 297g weight.

The current iPad range really does
have something for everyone, so read
our Ultimate Guide to find the iPad
that's right for you.
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FEATURE iPad buyer's guide

Choose
your size

The iPad now comes in
four models with five
different screen sizes

here are now four

different iPad models

available, ranging from

the 8.3-inch iPad mini
to the 12.9-inch iPad Pro. So the
first thing to do when buying a new
iPad is simply to decide on the
screen size that you need.

The iPad mini's compact design
is ideal for travelling, and the A15
Bionic chip provides plenty of power.
However, the 8.3-inch display doesn't
lend itself to precise graphics or
video-editing work, and the small
on-screen keyboard isn't ideal for
typing anything longer than a few
emails. It's a great option for
entertainment on the go, though,
from simple web browsing and
ebooks, to gaming or watching
a few films on a long journey.

Portable pad
If you don't need an ultra-portable
design, the 10.2-inch iPad is the most
affordable option. The size and weight
means it's still very portable, and is
great for most forms of entertainment,
and it'll enable you to type up a storm
in Pages, Mail or other apps. Its A13
Bionic chip is a few years old, though,
and doesn't have the graphical
horsepower needed for the latest
games or top-level graphics apps.
The next step up in screen size is
the 10.9-inch iPad Air - although this
is where things get a bit tricky. The

screen size and resolution of the iPad
Air are very similar to those of the
1-inch iPad Pro, and both models have
the same M1 chip, which provides
strong performance for graphics,
design and video work. However, the
iPad Air is limited to 256GB storage,
while the iPad Pro can go up to 2TB.
The iPad Pro also includes Face ID and
a Thunderbolt 4/USB 4 connector,
while the iPad Air sticks with USB-C.

And, of course, the iPad Pro is also
available with a 12.9-inch screen. It's
the heaviest iPad of the lot, but it's still
only around half the weight of an M1
MacBook Air. It has a higher screen
resolution than the MacBook Air too,
making it a great option for pro-level
graphics work on the go.

The screen size and resolution

of the iPad Air are very similar

to those of the 11-inch iPad Pro
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Professional video-
editing work uses a standard
known as P3 - or DCI-P3 - to
ensure that video files display

consistent colours on a variety
of different devices. Most iPad
displays now support P3,
so they're well suited to
graphics and video
work.

Aside from display resolution
and storage, the screen size and
weight of the iPad will play a big
part in your decision process.

Display differences

The entry-level iPad has a Retina
display with 2160x1620 resolution,
but the latest iPad models step up
to newer Liguid Retina technology.
A Liquid Retina dis

I quality that
, reading of MacFormat
printed on paper.



Which

processor?

The chips in the latest iPads are as
powerful as those in desktop Macs

he CPU - central
processing unit
- is the heart of
any computing
device, providing the speed
and power that it needs to
perform a variety of tasks.
For many years, the iPad was
limited in power compared
to the various desktop and
laptop Macs, as the iPad's
compact design simply
couldn't handle the power-
hungry Intel processors used
in the Mac range, or the heat
generated by those powerful
processors either.

All that changed when
Apple began to develop its
own range of Apple silicon
chips, starting with the M1
system-on-a-chip (SoC) used
in most of the latest Macs.
Apple also introduced the M1
to the iPad range with the
1l-inch and 12.9-inch iPad Pro
in 2021, which meant that the
iPad Pro could now provide
the same impressive
performance as the Mi-based
MacBook Pro, Mac mini and
24-inch iMac. The iPad Air
was also updated recently,
gaining its own M1 processor
in early 2022. However, the
current ninth-gen iPad and
sixth-gen iPad mini still have
older A-series processors, so
it's worth thinking about your
choice of processor when
choosing a new iPad.

The ninth-gen iPad is
very much the affordable,
entry-level option, and is
powered by an A13 Bionic

chip that is a few years

old now. It's no weakling,

as the A13 Bionic is a 6-core
processor running at
2.6GHz, along with an
8-core Neural Engine that
handles advanced machine
learning tasks, such as the
Live Text feature introduced
with iPadoS 15. That's more
than adequate for routine
tasks such as web browsing,
watching films and video,

or doing some office work
with Pages or Numbers.
However, the A13 Bionic
lacks the graphical
horsepower of newer
processors, o it won't be
able to handle the latest 3D
games, or high-end graphics
or video work.

Different league
There's a similar Bionic chip
in the current sixth-gen iPad
mini, although the mini steps
up to the more recent A15
Bionic. This is a 6-core chip
running at 2.9GHz, with a
more powerful 16-core Neural
Engine. It's also backed by a

Put aSoCinit

The M1 processor is known
as a system-on-a-chip
(SoC) as it includes all

the main components of

a powerful computer
system combined together
on a single chip. The Mi
processor includes an

The 12.9-inch iPad Pro boasts the M processor,
making it a great choice for graphics work.

5-core GPU that provides
extra power for demanding
graphics tasks, which means
that the little iPad mini can
provide surprisingly strong
all-round performance for
such a compact device.
However, the M1 chip used
in the latest iPad Air and iPad
Proiis in a different league
entirely, with Apple claiming
that the M1iPad Pro models

8-core CPU running at
3.2GHz, with four of those
being high-performance
cores for handling the most
power-intensive t

with four ‘efficiency’

that can handle more
routine tasks without

provide 50% faster CPU
performance than previous
versions, and 40% faster
graphics performance. This
means that the current iPad
Air and Pro provide a genuine
alternative to conventional
laptop and desktop Macs
(such as the MacBook Air)
because they're now using
the very same processors

as the Mac for the first time.

ning the iPad's battery
too much. The M1 has a
16-core Neural Engine, and
also adds an 8-core GPU
(graphics processing unit)
to provide extra power

for demanding games,
graphics and video work.
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iPad cameras

Neglected in the past, iPad cameras
have had big updates recently

hile the iPad
can't quite match
the Hollywood
ambitions of the
iPhone 13 Pro, with its three
cameras and telephoto lens,
it's no slouch when it comes
to high-quality video and
photography.

The cinematic baby of the
group is the ninth-gen iPad, whose
rear camera provides a relatively
modest 8-megapixel (MP)
resolution, which only allows
it to record 1080p HD video at
25-30 frames per second (fps).

However, all other iPad models
can now record 4K video, with the
iPad Air and iPad mini providing
wide-angle 12MP rear cameras that
can record super-smooth video
at up to 60fps. The two iPad Pro
models go one step further,
providing two rear cameras -
a12MP wide-angle camera and
a10MP ultra-wide camera that
provides 122° field of view. The
iPad Pro also offers 2x optical
zoom, while other iPads are limited
to less effective digital zoom only.

The front camera on the iPad
has been a little underpowered in
the past - it took Apple ages to
ditch the ageing 720p cameras.
used on many Macs and iPads -

6

o
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The rear cameras on the latest iPad models
offer such a vast improvement over earlier
incarnations in terms of stills and video.
but it has had a number of
improvements recently. This
reflects the ‘new normal’, which
sees many people now working
from home and using FaceTime

or Zoom for video calls with family,
friends or work colleagues.

All five current iPad models
now have a 12MP ultra-wide front
camera to provide a good field
of view for video calls. Video
resolution is still only 1080p for
all models, but they can all record
at 60fps. The iPad Pro can also
use Face ID with its front camera
in order to unlock the device.

Centre Stage

LIDAR, AR
and VR

he LIDAR (Light Detection and
Ranging) sensor used by the rear
cameras of the iPad Pro and
recent iPhones is a key part

of Apple's grand plans for the future of

AR and VR technology.

The LiDAR sensor helps to improve camera
performance in low-light conditions, but it can
also calculate depth within an image or scene.
This is similar to the TrueDepth technology
used with the front-facing camera to map
the contours of your face so that you can use
Face ID to unlock the iPad Pro or an iPhone.

However, the LIDAR sensor is more precise
than Face ID as it uses lasers to bounce rays
of light off objects and measure their distance
from the camera. This enables you to shoot
photos and videos that contain accurate
3D data, which can then be used in AR
and VR apps - all ready for Apple’s long-
awaited VR headset.

The LiDAR sensor used by the rear cameras of the iPad
Pro will play a significant role in Apple's AR/VR future.

As well as updating the iPad's front
camera to improve the quality of
video calls, the current iPad range

can all use Apple's Centre Stage
feature too.

Centre Stage u
learning technology to automatically
pan the camera and keep you in the

machine

centre of the image at all times. This
enables you to put the iPad dow
move around, perhaps while giving a
presentation to colleagues or clients
at work. If someone

image, Centre Stage

out to make sure that both of you
are kept in view.
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Expand your iPad's
abilities with the latest

accessories and add-ons

s we've mentioned, the
iPad is a tremendously
versatile device, but
most iPad owners still
need to buy an assortment of cables
and adaptors in order to connect the
iPad to other non-Apple devices.
Apple makes its own range of
cables and adaptors, with options
such as its Digital AV adaptors (£49-
£79) for HDMI displays and TVs
proving essential for many. Apple’s
accessories are expensive, though, so
it's worth exploring alternatives from
companies such as Belkin, which makes
awide range of Lightning and USB-C
adaptors that enable the iPad to work
with external displays, wired Ethernet
networks, and audio devices.

Just in case

Folio Cases are one of the most
popular purchases for any owner
of a new iPad, providing wrap-
around protection for both the
back panel and the front screen.

Apple has two options; the basic
Smart Cover (£45-£99), or the
Smart Keyboard Folio with built-in

board (£159-£329).

Apple cases are expensive
though, and there are some great
alternatives, such as the rugged

Defender cases from Otterbox
(£59-£89.99), or Logitech's
Keyboard Folio cases with built-
in trackpad (£89.95-£199.95).

Apple accessories come at a premium price, but they do of course work like a dream with your iPad.

Of course, many iPad owners also
have an iPhone, as well as AirPods and
an Apple Watch, and we've seen some
great multi-charger devices, such as
the BaseLynx from Scosche (£139.95)
and Kensington's StudioCaddy (£125),
which can charge multiple mobile
devices at the same time.

Adding extra kit

Beyond basic chargers and adaptors,
you'll no doubt want accessories and
devices that can improve your
productivity when working with an
iPad. The Apple Pencil (£89/£119) has
been a great success, proving popular
for graphics and design work, and
iPadOS now works with Bluetooth mice
and keyboards, so popular models

Compatibility

As well as coming in five different
sizes, the iPad range includes a
range of connectors for charging
and accessories. The entry-level iPad
still has a Lightning connector, while
the iPad mini and Air have USB-C
ports. The iPad Pro now has

such as Logitech’s MX range for the
Mac will also work with the iPad too;
in fact, Logitech had a feature similar
to Apple’s ‘innovative’ new Universal
Control about five years ago.

It's also worth remembering that
the USB-C and Thunderbolt ports used
on the iPad mini, Air And Pro enable
you to connect USB storage devices for
backing up your work files too. And
if you really want to go to town, you
can buy a device such as Kensington's
StudioDock (£369.99), which turns
your iPad Air or Pro into a proper
desktop computer, with a multi-charger
for the iPad and other devices, multiple
USB ports, headphone socket, SD card
reader, Ethernet port, and HDMI for
an external display.

Thunderbolt 4/USB 4, which still uses
the oval-shaped USB-C connector,

o that's compatible with many
accessories that also use USB-C.
Howeve ntial to check
the compatibility info provided by

ssory manufacturers first.
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Connectivity
Wi-Fi and 4G/5G

You're always online and connected
with the latest iPads

ost iPad models
now support the
latest Wi-Fi 6
standard, with
only the entry-level iPad
still using the older Wi-Fi
5 (formerly known as
802.11ac). However, mobile
broadband - referred to as
cellular in the US - is an
optional extra that costs
£120-£150, depending on which
model you're buying.

The iPad draws the short
straw, only offering 4G LTE
support for mobile broadband.
In the UK, the Uswitch
comparison website reports
that the EE network provides
the best 4G performance with
average download speeds of
20-30Mbps. All other current
iPad models support 5G mobile
broadband, which currently
provides average speeds of
around 150Mbps. However,
speeds vary a lot depending
on your network provider and
coverage in different parts
of the country.

If you buy a ‘cellular” iPad
model then it will have a slot for
anano-SIM card that works
with most mobile broadband
networks. Current iPads also
contain an eSIM though, which
is a small chip that can work
just like a SIM card in order to
connect to mobile phone and
broadband networks.

Ordinary SIM cards are
locked to individual networks,
like Vodafone or EE in the UK,
soif you travel to another
country, or simply want to
switch to a different network,
then you have to go to the
hassle of getting a new SIM
card to install in the iPad.

An eSIM is generally a
better solution - especially
when travelling - as it can work
with many different mobile
networks. However, not all
networks currently work
with eSIM technology! So
you should check on eSIM
compatibility before you go
travelling. Find out more

at apple.co/3NNhs86.

Apart from the entry-level iPad, all other models now support Wi-Fi 6.
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How much
storage?

pple can be really annoying at
times. The iPad, iPad mini and iPad
Air all start with just 64GB of built-in
storage - which really isn't enough.
This means you're pretty much forced to pay
around £140 to upgrade to 256GB. However,
that's the maximum storage available for those
iPad models, so if you need more than 256GB
of storage, you'll have to pay for a top-of-the-
range iPad Pro. The iPad Pro can be upgraded
to 512GB, 1TB and even 2TB - although that
2TB option weighs in at almost £2,000.

But don't forget that the iPad mini, Air and
Pro now have USB-C ports, which enable you to
connect an external USB drive or a flash drive.
It's not an elegant solution, but it's a lot cheaper
than Apple's storage upgrades.

Consider what you want to do with your iPad the most. If
it's editing photos and videos, plenty of storage is a must.

iCloud storage

There's one other option for adding some
extra storage to your iPad - or any other
Apple device for that matter.

As well as features like Hide My Email,
all iCloud+ subscriptions include a certain

amount of online storage too. They're not
d value either - 50GB of

p per month, while 200GB ¢
and 2TB costs £6.99. Many apj

iMovie, enable you to store your

on the iPad itself, or in iCloud. And, of coL
files saved in iCloud can be shared with all
your other Apple devices too.

R


http://apple.co/3NNhs86
https://support.apple.com/en-gb/HT212780

iPad buyer's guide FEATURE

. .
iPad mini iPad iPad Air iPad Pro 1lin | iPad Pro 12.9in
(6th gen) (9th gen) (5th gen) (3rd gen) Sth gen)
Colours| @@@ @ ° e00e ° L
Space Grey, Starlight , Space Grey, Starlight,
Pink, Purple Space Grey, Silver Pink, Purple, Blue Space Grey, Silver Space Grey, Silver
Screensize| 8.3 inch 10.2 inch [ 10.9 inch | 1inch 12.9 inch
Display | Liquid Retina Display Retina Display Liquid Retina Display | - Liquid Retina Display Liquid Retina
| XDR Display
If'i"s‘::“ 2266x1488, | 2160x1620, | 2360x1640, | 2388x1668, | 2732x2048,
specification | 356,51 p3, True Tone |  264ppi, True Tone | 264ppi, P3, True Tone | 264ppi, P3, True Tone | 264ppi, P3, True Tone
Price/storage 64GB £479 64GB £319 64GB £569 128GB £749 128GB £999
(Wi-Fi only) 256GB £619 25668 £459 256GB £719 256GB £849 256GB £1,099
51268 £1,049 51268 £1299
1TB £1399 1TB £1,649
2TB £1749 2TB £1999
Mobile £140 £120 £150 £150 £150
broadband
(upgrade)
Broadband WirFi 6/56 WirFi 5/4G WirFi 6/56 Wi-Fi 6/56 WiFi6/56
connectivity
SIM support
Rearcamera | 12MP 8MP 12MP
Wide Wide Wide Wide +10MP Ultra Wide | Wide + 1OMP Ultra
ide
Rear camera
video recording 1080p
@ 24/25/30/60fps; @25/30fps ®24/25/30/60fps; | @ 24/25/30/60fps; | @24/25/30/60fps;
1080p @ 25/30/60fps 1080p @ 25/30/60fps | 1080p ® 25/30/60fps | 1080p @ 25/30/60fps
ot 12Mp 12MP 12MP 12MP 12MP
Ultra Wide, Ultra Wide, Ultra Wide, Ultra Wide, Ultra Wide,
Centre Stage Centre Stage Centre Stage Centre Stage Centre Stage
Front camera
videorecoraing|  1080p 1080p 1080p 1080p 1080p
@25/30/60fps @ 25/30/60fps @25/30/60fps @ 25/30/60fps @25/30/60fps
Chip
M1 M1 M1
Charging
- - - -
Lightning, Smart USB-C, Smart Thunderbolt 4 /USB 4, | Thunderbolt 4 /USB 4,
USB-C Connector Connector Smart Connector Smart Connector
ht 2939/297g 4879/498g 46lg/4629 4660/470g 6820/6859

Weig!
(Wi-Fi/Cellular)
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Introducing Shortcuts

Get started with
Shortcuts on Mac

Automate repetitive tasks, save time, and
be more productive with the Shortcuts app

hortcuts started life as

a way to automate tasks

on i0S. So, you could, for

example, create a shortcut
that played the latest episode of your
favourite podcast in the Podcasts app
and trigger it by activating Siri and
saying the podcast name, or by tapping
an icon on the Home Screen.

With the release of macOS Monterey,

Shortcuts arrived on the Mac, taking over

WRITTEN BY

from the Automator app. Shortcuts on
the Mac works the same way as, and
syncs with, the iOS version. Though
shortcuts you create on one platform
won't necessarily work on the other.
Shortcuts are comprised of actions.
Each action is a step in the process
like, say grabbing some text from an
application, or passing that text to a
different application. Actions are created
and made available by app developers.

So if you want to use Shortcuts with a
third-party app, the app needs to have
support built in. You can see the available
actions for applications installed on your
Mac in the Shortcuts app.

Actions have parameters you need
to set to make the Shortcut do what you
want; you build a shortcut by dragging
and dropping actions in a series of steps.
It really is very simple, and we'll show
you how to get started. L]
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The Shortcuts app has a Gallery
4 full of ready-to-use shortcuts,
making it easy to get started

Create your first Shortcut

Start simple and, before you know it, you'll have mastered the process

reating your own
Shortcuts if you're
starting from scratch
can be quite daunting.
So Apple has built a Gallery of pre-
cooked Shortcuts in the app. All you
have to do is decide which ones you
want to use and how you want to
activate them. Once you've got used

to the way shortcuts work, you can edit
them to make them do different things,
or dive right in and create your own.
When it comes to triggering

shortcuts, you have a choice of using
Siri, a keyboard shortcut, Spotlight, or
placing an icon for the shortcut in the
menu bar or Dock, or by including it in
Quick Actions or the Services menu.

In this section, we'll start by showing
you how to use and modify an existing
shortcut and then move on to creating
your own simple shortcut. We'll use stock
macOS apps for the tutorial, but once
you've got to grips with how Shortcuts
work, you'll want to explore how you can
improve them, perhaps by replacing
stock apps with third-party tools.

EXPLAINED... The anatomy of a shortcut »

Actions view

Add
comments > You can view
>You can add e all the available
comments s st srell +.. actions at once,
to actions to ——————— choose a
describe what guw category, or
they do and et Shortcuts

how they work. suggest some

I8 e

) st i 08

Settings

Action types

>Action types o ——— > The Settings
are denoted by button enables
icons. ‘X' for a e you to choose

how you will
activate the
shortcut.

variable, '?* for a
request for your
input, and so on.
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HOW TO Create and use your first Shortcut »

.
[ EesE T )
R

'] Explore the Gallery

Launch the Shortcuts app and click
Gallery in the sidebar. Explore the
available shortcuts as you would apps
in the App Store. Click one to find
out what it does. Click the "+ to add
a shortcut to All Shortcuts.

4 Start a simple shortcut
This shortcut will take text from the
clipboard and read it aloud. You will need
to copy the text before running it. Click
the "+ in the toolbar to create a new
Shortcut. Click in the Shortcut toolbar
and type a name for it.

7 Modify the shortcut

You can now play around with the
shortcut to modify it. For example, you
could reduce the volume of your Mac's
speakers. Find the Set Volume action,
drag it above Get Clipboard and choose
avalue to set the volume at.

Examine a shortcut
Having a poke around under
the hood is a good way to understand
how shortcuts work. Choose one in All
Shortcuts and double-click it. Examine
the way actions fit together. Press the
Play button to run it and see it in action.

Add actions

Click Action Library (a '+ inside
abox) on the sidebar and search for
‘clipboard'. Drag the Get Clipboard action
on to the main window. Next, search for
‘speak text’ and drag that action on to
the window under Get Clipboard.

Add it to the menu bar
There are a few ways you could
activate this shortcut, including using
a keyboard shortcut or adding it to the
Services menu. We'll add it to the menu
bar. Click Settings > Details (in the
sidebar), and check 'Pin in Menu Bar.

- =
RS EE.
[ [~ == IS ]
- - B
=2 = -]
1 [

3 Organise shortcuts
Once you have lots of shortcuts,
you should put them in folders. Hover
the pointer over Folders and click the
‘+'. Give the folder a name and press
<. Drag shortcuts from All Shortcuts
on to the folder to add them.

Finish and test

The variable in the Speak Text
action should automatically change to
Clipboard. You can now test the shortcut
by pressing the Play button. You should
hear the text you previously copied being
read back to you.

Share the shortcut

You can share a shortcut with other
Mac users by generating an iCloud URL.
With the shortcut edit window open, click
the Share icon in the toolbar. Click Copy
iCloud Link, then click Share. The link is
now in the clipboard. o
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Shortcuts actions can

include questions that wait
for your input and use the
answer to complete a task

Do more with Shortcuts

There's much more you can do with Shortcuts when you dig a little deeper

nce you've mastered
the basics of choosing
shortcuts from the
Gallery, running them,
creating your own and sharing with
others, you're ready to dig deeper.
The shortcuts we've discussed so far
are simple, with only a few actions and

limited inputs. However, they can include

questions that ask for your input before
running. Apple’s Home ETA shortcut, for
example, asks for your home address
and who you want to notify before it
calculates an ETA. Shortcuts can also
have ‘if then else’ statements, where the
result of the action varies according to
conditions set. And you can set and call
variables to store content in a shortcut.

Third-party apps you've installed on
your Mac may have their own pre-cooked
shortcuts. The note-taking app Bear, for
example, has a shortcut that enables you
to dictate a note directly to that app.

You can also change the name of an
app at any time, and even change how
it looks in the Gallery, menu bar and
Dock by changing its icon.

HOW TO Add a shortcut to Quick Actions >

‘I Choose a shortcut

Quick Actions are performed in the
Finder by clicking a button in the preview
window, so choose a shortcut that makes
sense to be triggered in this way. One
example is a shortcut that renames

files in batches.
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Enable Quick Actions
Double-click the shortcut in All
Shortcuts. Click the Settings icon in the
sidebar and then choose the Details tab.
Check the box labelled ‘Use as Quick
Action’. Check the box next to Finder

so it appears in Finder windows.

Use the Quick Action

In a Finder window, choose the file
or files you want the shortcut to apply to.
In Columns or Gallery views, look for the
Shortcut icon at the bottom of the
preview window and click it. If it's
not there, click More and select it.



macOS shortcuts Beginner's Guides

HOW TO Customise shortcuts »

‘] Change its name

The name of a shortcut isn't just
important for identifying it, it's how

you trigger it from Siri or Spotlight. To
change a name, double-click the shortcut
in All Shortcuts and click anywhere in

its name. Edit the name as required.

HOW TO Add a question to a shortcut >

2 Change its icon

With the shortcut still open from
step 1, this time click its icon. Choose

a colour from the options, and then
choose a symbol for its icon. Make it as
easy to identify as possible from Quick
Actions, the menu bar, or the Dock.

Work with folders

To add shortcuts to folders you've
created, drag them from All Shortcuts
onto the folder in the sidebar. Do the
opposite to remove them from a folder.
To change a folders icon, [« -click on it
and choose Edit Icon.

‘] Create shortcut

We'll create a shortcut to play a
podcast. Click “+' in the toolbar and give
your new shortcut a name. Drag Play
Podcast from the Action Library to the
main window. Click the blue Podcast
badge and choose Ask Each Time.

——

2 Add question

When you run the shortcut on your
own devices, you will be able to select a
podcast from your library. If you want
to share it, you can type a question to
prompt the recipient to choose. Click
Settings and then choose Setup.

Type the question

Click the '+' beneath Import
Questions, then click Podcast. Type
a question in the text box, then choose
a default answer if you want to set one.
Click Done when you're finished. You
can add as many questions as you need.

Introduction to variables
Use variables to do more with Shortcuts

Variables are containers used to label and store content like text

or images. Shortcuts has two types of variable besides the regular
manual ones. The most useful of these is Magic Variables, which can
store the output of any action for use later in a shortcut. The other
type is Special Variables - variables you can add to text or to a
parameter setting. For example, you can use the Current Date
variable to append the current date to text, or the Clipboard
variable to use the contents of the Clipboard in an action.
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>Our ratings

> Our reviews are totally
independent; we're not
affiliated with Apple or
anyone else, nor are we
influenced by advertisers.

> A truly exceptional product.
Award given solely at the Mac Studio

discretion of the editor.
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78 Mac Studio
> The best example of its 81 Studio Display
kind when pitted against
comparable products. 82 Lenco LS-440 Turntable

83 Joby Swing Complete Kit,
%k ok kok ShiftCam ProGrip Starter Kit
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over-ear headphones
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KohkAk 92 DxO PureRAW 2
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—_— 93 Effie, WonderPen 2
Hok ok ok 94 Book of Travels
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groeies 95 Get Sum
2. 8.8.8.8.¢ 96 6 apps for reading and
> A waste of your money listening to literature
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APPLE CHOICE Mac hardw

Mac Studio

Apple's most powerful desktop Mac is brilliant
for creative pros, but it won't be for everyone

>£6,199 (model on test) > FROM Apple, applecom/uk
>FEATURES Apple M1 Ultra chip (20-core CPU, 64-core GPU, 32-core Neural Engine), 2TB storage, 128GB of unified memory,
Wi-Fi 6 (80211ax), Bluetooth 5.0, 6x Thunderbolt 4 ports (2x front, 4x rear), 2x USB-A ports, 1x 10Gb Ethernet port, 1x HDMI 2.0
port, 1x 35mm headphone jack,1x SDXC card slot, 197x197x95mm, 36kg

Jiin.

Paulsays...
> If you're a creative
pro, the Mac Studio

ticks all the right boxes.
Dedicated hardware

for video encoding, a
powerful GPU for running
multiple 4K screens -

if you need this, go buy!
But if you don't deal

with ProRes codecs and
don't need gigabytes of
memory, your best bet
for a desktop Mac is to
grab a Mac mini and save
some serious money.
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ver since Apple introduced its
first Apple silicon Mac in 2020,
its direction of travel has been
crystal clear. First toarrive were the
Mi-powered MacBook Air, Mac mini and
13-inch MacBook Pro in 2020, followed by the
gorgeous 24-inch iMac in April last year. Last
October, Apple moved things on again with
the new 14-inch and 16-inch MacBook Pro
offering up new members of the M family,
the M1 Pro and M1 Max. Now there’s this, the
new Mac Studio - a Mac mini on steroids,

armed with a choice of either an M1 Max
or the new Mi Ultra, making it the most
powerful desktop Mac ever made - or at least
until the new Apple silicon-sporting Mac Pro
arrives sometime in the next few months.
Thanks to the power of Apple silicon, even
an Mi1-powered Mac mini or MacBook Air
should have enough oomph for most of us, so
it should come as no surprise to find that the
Mac Studio isn't really aimed at us - instead
Apple’s target market is the creative pros
who edit 8K videos, render complex graphics-
heavy scenes and produce multitrack audio
streams all day long. And the new Mac Studio
is priced accordingly. £1,999 buys you a Mac

H >

TTT—

The Mac Studio is festooned with ports, including four
Thunderbolt 4 ports on the rear as well as 10Gb Ethernet.

Studio equipped with an M1 Max
chip with a 10-core CPU, 24-core GPU and
16-core Neural Engine), 32GB of unified
‘memory and 512GB of solid-state drive (SSD)
storage. Spending £3,999 takes you into M1
Ultra territory, complete with a 20-core CPU,
48-core GPU and 32GB Neural Engine, 64GB
of unified memory and a 1TB SSD. The model
on test here shows just how far Apple can
push even that. Priced at £6,199 (via the Mac
Studio’s Configure To Order options), it comes
with a 20-core CPU, 64-core GPU, 32-core
Neural Engine M1 Ultra, plus 128GB of
unified memory and 2TB of SSD storage.
Increasing the storage to 4TB will cost you
another £600, while adding 8TB costs £1,800.
It's not really a machine for a spot of web-
surfing and the odd email then.

No matter which build-to-order Mac
Studio you buy, the rest of the specs largely
remain the same. On the front, you'll find
two USB-C ports (M1 Max versions) or two
Thunderbolt 4 ports (M1 Ultra versions),
plus an SDXC card slot, while on the rear all
variants get four Thunderbolt 4 ports, a 10Gb
Ethernet port, one HDMI 2.0 port and a
3.5mm headphone jack. On the underside
of the unit yow'll also find a security slot,
enabling you to lock the Mac Studio to your
desk, making it less likely someone will walk
off with your prize possession.

When it comes to design, the Mac Studio
really is just like an oversized Mac mini
has the same 197x197mm footprint as the
‘mini, but stands taller at 9smm (compared
to the Mac mini's 36mm), and its aluminium
shell has cheesegrater-style vents on its rear
and underside, enabling the huge twin fans
inside to suck in air and draw it over the
built-in power supply and logic board. Like
‘most other Macs, these days, the Mac Studio
also comes with Wi-Fi 6 (802.11ax Wi-Fi) and
Bluetooth 5.0 wireless connectivity.



http://apple.com/uk
https://apple.com/uk

It's worth noting at this point that just like
the Mac mini, the Mac Studio is sold without
either an accompanying mouse, trackpad or
keyboard. To that end, Apple has launched
special black editions of the Magic Mouse
(£99), Magic Trackpad (£149), and Magic
Keyboard with Touch ID and Numeric
Keypad (£199). It hasn’t taken the opportunity
to change the way the Magic Mouse charges,
though, or added backlighting to the Magic
Keyboard's keys (which seems like a bit of a
missed opportunity given that the Mac Studio
is likely to be used studio environments with
low lighting, especially when editing video).

The Mac Studio is also decidedly non-user
upgradeable, with ifixit.com awarding it 6 out
of 10 for repairability, noting that while you
could potentially swap out the removable
storage using another SSD of the exact same
specification, attempting to replace it with
higher capacity storage is a no-go (for now).
As for rest of the components, you're stuck
with what you chose when placing your order.

When it comes to design,
the Mac Studio really is just
like an oversized Mac mini

Mac Studio APPLE CHOICE

@
v

Ultra powerful
While you could buy the Mac Studio with an
M1 Max (instead of, say, the far more portable
MacBook Pro with the same chip inside),
‘most creative pros are likely to opt for the
M Ultra, as that’s where this machine’s true
power lies. As Apple pointed out during its
Peek Performance event, the M1 Ultra is
essentially two M1 Max die ‘joined” together
with computing tasks distributed between
them using Apple’s proprietary UltraFusion
architecture. This, Apple says, delivers up
to 2.5TB/s of low-latency inter-processor
bandwidth, which in turn helps the M1 Ultra
deliver up to 3.8x faster CPU performance,
4.5x faster GPU performance and 3x faster
‘machine learning performance than the
Intel-powered Mac Pro and iMac models
Apple chose to benchmark the Mac Studio
against. Apple even says the Mac Studio
outperforms many desktop-class PCs, and
that’s true to an extent, although in reality
things are somewhat more nuanced than that.
Just like all the other Apple silicon Mac’s
we're tried, the Mac Studio is quick to start
up and super-slick to use, with almost every
application we tried typically launching
within a single bounce of its icon in the Dock. ©

““n;

.
¥

You also get two USB-A ports
and an HDMI port, as well as
23.5mm headphone jack.
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BENCHMARKS Our analysis explained >

[ Mac Studio 3.22GHz Wi Uitra (2022)

* Mac mini 3.06Hz 8-core M1 (2020)

Mac 2Tin 3 6GHz 10-core Intel Core 19 (2020)

e
B
Index score (higher
GEEKBENCH 5
SINGLE-CORE TEST
> This tests the capability of a single
processor core. Many more common
tasks on a Mac will only use a single
core at a time. Geekbench 5 is a
universal app running on Monterey.

5 0
s better

ac Studio 3.226Hz M Ultra (2022)
9 mins, 0 secs

" Mac mini 3,06Hz 8-core M1 (2020)
23 mins, 48 secs

" iMac 27in3.66Hz 10-core Intel Core 9 (2020)
F 7mins, 3 secs

(shorteris better
HANDBRAKE

VIDEO ENCODING

> We transcode a Blu-ray-quality
video file into H.264 format using
HandBrake to test the multicore
processor performance. Handbrake
14 or later runs natively on the MI.

Mac Studio 322GHz Wi Ultra (2022)

[ Mac mini 306Hz 8-core M1 (2020)

iMac 27in 3.66Hz 10-core Intel Core 13 2020)

e e
o 0 0 s
Frames per second (higher is btter
RISE OF THE TOMB
RAIDER (1920X1080)

> For a real-world gaming test, we
use the benchmarking tool in this
game, with the graphics quality set
to High and the resolution set to
1920x1080. Not yet optimised for MI.

Mac Studio 3226Hz Mi Ultra 2022)
3mins, 39 secs
Mac mini 3.06Hz 8-core M1 (2020)
28 mins, 42 secs
iMac 2Tin 3 6GHz 10-core Itel Core 19 (2020)
6mins, 30 secs

(shorter s
DAVINCI RESOLVE

> In Blackmagic Design's editing tool
for video professionals, we exported
an effects-laden, 2.5-minute project
to the H.264 format. The app has
been optimised for M1 performance
since the release of version 171

e

o

The front of the Mac Studio
gets either two USB-C ports
or two Thunderbolt 4 ports,
depending on configuration.

FORMAT

VERDICT
> Super-quick and
powerful, the M1 Ultra
Mac Studio is overkill
for the most of us.

Kok ok
© Ultra-fast CPU
performance
© Good port selection
© Very, very expensive
© Not for gamers.
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©  Asyowd expect, editing images in apps

such as Photos, Pixelmator Pro or Affinity
Photo is friction-free too and even rendering
3D scenes in Blender gave us super-quick
results, often taking just minutes where it can
take hours on the Intel-based MacBook Pros
we normally use in the MacFormat office.

In Geekbench 5's single-core processor
test, the Mac Studio hit a consistent score of
1,784, putting it on a par with other M1 Macs
(see the M1 mini score in the table above).

This isn’t too surprising as the underlying
architecture is the same. Where the Mac
Studio really hits it out of the ballpark s in
the multicore test, where that 20-core M1
Ultra CPU achieved 23,944 - or over twice
that of a 27-inch iMac with a 3.6GHz 10-core
Intel Core i9, which averaged 10,002.

The Mac Studio aced our DaVinci Resolve
benchmark test too (which involves rendering
an effects-laden 2.5-minute video), taking just
3 minutes, 39 seconds to produce the finished
clip, compared to 6 minutes, 30 seconds on the
27-inch Intel iMac, and 28 minutes, 42 seconds
on a Mac mini equipped with a standard Mi.

; g
I EWII=-
:

The two huge fans behind the Mac Studio's grile are
mercifully quiet, even when the machine is working hard.

The Mac Studio may be
a great rendering machine,
but games console it is not

However the Mac Studio delivered mixed
results in our next two tests. In Handbrake,
the Mac Studio managed to transcode a
one-hour long 4K video into MP4 in 9
minutes, 10 seconds; 2 minutes, 13 seconds
slower than an Intel Core i9 iMac. Gaming
performance in Rise of the Tomb Raider was
also sub-par, averaging 30 frames per second
(fps), compared to the Intel Core i9 iMac’s
5ofps. That could be because the game isn’t
optimised for the M1, but the Mac Studio also
performed surprisingly poorly during our
Shadow of the Tomb Raider test. While there
it managed to clock up 117fps, it did so only by
frequently dropping frames using the in-game
b setting at i
while actual use in-game resulted in the same
jerky performance. The Mac Studio may be a
great rendering machine, but games console
or even gaming PC replacement it is not.

So should you buy the Mac Studio? If
you're a creative pro who edits 8K video
or renders graphics all day, the answer is
undoubtedly yes. But for the rest of us? You
could just about justify buying the £1,999 M1
Max version as an ageing iMac replacement.
But the M1 Ultra? No. As interesting and as
powerful as it is, it's overkill for the day-to-
day tasks you're most likely to want to do and
we're not convinced (yet) that it’s worth the
premium you have to pay. Rob Mead-Green




Studio Display

The 27-inch 5K Retina display
has surprise hits - and misses
;,499 > FROM Apple, apple.com/uk

> FEATURES 27-inch 5K Retina display (5120x2880 pixels), 600
nits brightness, True Tone, 1x Thunderbolt 3 port, 3x USB-C ports

The Studio
Display is
powered by
the same A13
Bionic chip
used by the
ninth-gen iPad

FORMAT

VERDICT
>While it's great to
have another monitor
option from Apple,
the Studio Display
has limited appeal

Jokok

© Bright, colourful

5K Retina display

© Built-in USB-C hub
© Costly stand options
© No HDR or high
refresh rate support

Studio Display APPLE CHOICE

ow that the 27-inch iMac has joined
the Power Mac G4 Cube and the
original MacBook in the great big
Apple resting place in the sky, the new
Studio Display could be the next best thing.
Maybe. Released alongside the new Mac Studio,
the Studio Display sports a 27-inch 5K Retina
display (just like the 27-inch iMac) and even
bears a passing resemblance to the 24-inch iMac.
Itis also only Apple’s second display of the
‘modern era, joining the 32-inch Pro Display
XDR (£4,599), but at a more reasonable £1,499.

We say ‘reasonable’, but there's a catch. The
£1,499 price either gets you a Studio Display with
afixed height but tilt-adjustable stand ora VESA
‘mount. For a height-adjustable stand you'll need
tospend an extra £400. Where rival monitors
often include a height-adjustable stand and a
'VESA mount option as standard, Apple forces
you to choose the one you want at buying time
~ unless you change your mind later and take
the Studio Display to your local Apple Store and
get the stand swapped out for another. And if
you want non-reflective nano-texture glass?
That'll be an extra £250 please.

Also controversial is the use of a braided
power cable that comes pre-attached to the
display and can only be removed usinga

The Studio Display only has a single Thunderbolt 3 input,
but at least it can charge your MacBook at the same time.

———

The perfect partner for the new Mac Studio - but it doesn't
have all the bells and whistles that you might expect.

proprietary tool (or very carefully). The Studio
Display also comes with a single Thunderbolt 3
input. While this means you only need to
connect one cable to your Mac (and have it
charge at the same time if it’s a MacBook Air
or MacBook Pro), anyone needing HDMI or
DisplayPort connections will need to buy

an adaptor (there are none included).

Missing in action

While the Studio Display’s sK Retina screen
looks great, it's also missing the kind of features
you'd expect to find in a monitor at this price -
such as High Dynamic Range (HDR) support or
a100Hz or higher refresh rate. The lack of the
former seems particularly egregious when the
Studio Display is supposedly aimed at creative
pros (or anyone who wants to watch HDR
videos they've bought on {Tunes), and also odd
given that the Mac, iPhone and iPad all support
HDR, with some (the iPad Air and iPad Pro)
supporting 120Hz refresh rates too.

Things get odder still when you discover
that the Studio Display is powered by the same
A13 Bionic chip used on the ninth-gen iPad and
runs i0S 15.4. Still at least there’s always the
12MP Ultra Wide webcam and Centre Stage
- only thejury’s still out on that one, as Apple's
promised update to fixa webcam quality issue
is still to materialise as we went to press.

Atleast the Studio Display sounds as good
asitlooks - with six speakers and support
for Spatial Audio as well as three studio-quality
microphones. It also comes with a three-port
USB-C hub, enabling you to hook up peripherals
directly to the display rather than your Mac.
Rob Mead-Green
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L.enco

. S-440
Turntable

ith
tﬁe minimum of fuss

> £249.99 > FROM Lenco, [6AGoIUK
> FEATURES Bluetooth 5.0, four built-in
speakers, S0W RMS power, 33 and 45rpm
turntable, moving magnetic cartridge

Enjoy your vinyl w

The four
speakers kick
out a pleasing
sound stage
with a range of
musical styles

FORMAT

VERDICT

> A compact and
stylish solution for
listening to records,
but lacking computer
integration.

Yk ok
© Amp and
speakers built in
© Solid and
warm sound
© No USB audio
© No Bluetooth out
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inyl continues to enjoy a
renaissance but not everyone has
space for a full hi-fi setup. Lenco’s
small range of all-in-one turntables offer a
way to listen to records while taking up as
little space as possible, combining a belt-drive
platter with four built-in speakers, two rated
at 15 watts and two at 10 watts, and running
off mains power. The LS-440 is finished in
beige or grey fabric which lends it a pleasingly
retro feel and the design is sure to be a talking
point in any home. Other models in the series
use plastic or even wood finishes.

There are two speed switches for 33 or
45tpm playback and the cartridge is from
pro audio specialists Audio Technica. The
arm is nicely counterbalanced and the unit
comes with a plastic dust cover to keep
everything running smoothly by minimising
buildup on the record’s surface. A 3.5mm
headphone jack lets you listen privately,
while tone and pitch knobs let you adjust the
playback speed and the high- and low-end of
the signal respectively. The headphone jack
could ideally have been on the front panel
for convenience, but it's not a deal breaker.
The tone control also provides an easy
way to squeeze a bit more, top or bottom
end, out of the sound.

Sonically it's quite evenly balanced, and
capable of going fairly loud. While a compact
unit is never going to challenge floor-standing

speakers for clarity, the LS-440’s four
speakers kick out a pleasing sound stage
with a range of musical styles. You can use
Bluetooth to connect other devices wirelessly
tothe speakers, though the turntable itself
can't send sound to a Bluetooth speaker,
which seems like a missed opportunity.

More options

Around the back are a couple more options,
starting with dual RCA phono outputs,

for connection to an external amplifier or
powered speakers, which can be switched
between phono o line out modes depending
on what you're connecting to. There’s also a
3.5mm aux input for connecting external gear
to the speakers via a cable. So you are able to
send the audio from the vinyl out to bigger
speakers if you want though only over an
analogue connection. It would have been nice
to seea USB option here to send audio toa
computer for playback and also for digitising
your records, especially since this model is

at the pricier end of Lenco’s lineup.

Most audiophiles are going to go for a
dedicated separates system and the associated
costs that entails, but this all-in-one system is
a great way to enjoy your vinyl collection with
the minimum of fuss and wiring. It looks
good, sounds decent and doesn’t cost the
earth. Adding USB audio would have been
the icing on the cake. Hollin Jones

> Image credit:
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Joby Swing Complete K|t

Add pro tracking moves with this slider

> £164.95 > FROM Joby, [OBYIEOR > FEATURES GorillaPod
3K stand, BallHead 1K, phone mount, Bluetooth

FORMAT

VERDICT

> The Swing’'s range

of movement may be
subtle but it works well
with the right subjects.

kK

© Smooth tracking shots
© Relatively expensive

rofessional movie
makers can make
aclip look more
interesting (or tell a story)
by tracking the camera.
The Joby Swing enables you to
track your iPhone as smoothly
asatop cinematographer.

Hardware APPLE CHOICE

The Joby Swing tracks
slowly so the moves that it
‘makes are subtle. For more
noticeable results, you need

The dedicated Joby Motion  toh: bject in the
you toset the sothatyou
Swing's start and end points can track from it to reveal
by tapping on the iPhone’s abackground subject.

display. Tap Goand t tracks
in either Video or Timelapse
mode. The Kitalso ships with
asturdy GorillaPod 3K tripod,
S0 you can mount the device
in a variety of locations using
the tripod’s flexible legs.

The tracking span is also
short at 42cm, so your range
of movement is fairly limited
(and it risks toppling over
when fully extended unless
your place the tripod legs
carefully). We also found that

Add precise and smooth
motion-controlled tracking
moves to your video and
timelapse sequences.

the tripod could
occasionally vibrate
while tracking, but applying
pressure with a finger can
smooth things out.

The Joby Swing will be
useful to add a ittle movement
toyour clips but for an
electronic tripod that's has
more range of speed and
movement, we'd recommend
the panning Joby Spin -
which s also cheaper than
its swinging sibling.

George Cairns

ShiftCam ProGrip Starter Kit

Turn your iPhone into a pro camera

> £129.99 > FROM Shiftcam, Shiftcamicom > FEATURES Wireless
powerbank, Bluetooth shutter, ergonomic grip, landscape/portrait

he act of capturing
aperfect shot on The starter kit ships with a
your iPhone can protective case and cold shoe
TaEi s G s mount for external devices.
hands to snap a shot safely grip lets you hold your iPhone When mounting an
when tapping the Camera comfortably (and securely, iPhone 13 Pro Max into the
app’s shutter button. When thanks to a strap) in one hand. ProGrip, we were concerned
switching between lenses, you You can captureashotby  aboutit slowly sliding out of
EORMIAT, rmay not realise that one of pressinga buton (riggering  the rubber gips due o the
VERDICT themisohscuredbya finger. theC: ia  iPhone'sshiny surface. The
>Helps you shoot On an intensive shoot, you'll Bluetooth). Thanks to a built- smaller 13 Pro felt very loose.
like a DSLR user and drain the iPhone’s battery in wireless powerbank you However by enclosing both
prolongs your ability to more quickly and may miss can shoot for up to three times ‘models in a protective case, we
keep on shooting. aphoto opportunity. longer, so there’s no need to were then able to safely secure
The ShiftCam ProGrip carry an external charger: Like  themin the ProGrip and shoot
2. 0.0 .0 ¢ solves these problems, and aDSLR it feels sat ith The ProGrip
© Bluetooth shutter ‘makes your iPhone feel more heavy, encouraging you to will certainly take your iPhone
@ Doesn't grip like a traditional camera. Its shot than hy to the next level.
tightly enough ergonomic non-slip rubber grabbing a quick snap. George Cairns

>lmage credit:
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NOISE CANCELLING
OVER-EAR
HEADPHONES




Group test

Reviewed by

ON TEST...
Apple AirPods Max
Bowers & Wilkins PX7
JLab Studio Pro ANC
Sennheiser Momentum 3
Shure Aonic 40

Sony WH-1000XM4
SoundCore Life Q35
Urbanista Los Angeles
YYamaha YH-E700A

APPLE CHOICE

hen it comes to audio
W fidelity, over-ear

headphones are almost
always going to offer a superior
listening experience compared
to earbuds. This is due to their
bigger size and the fact that their
drivers are many times larger,
‘which enables them to move more
airand thus achieve a richer
soundstage. An over-ear design
‘means that the ear cups completely
surround each ear, minimising
sound leakage both in and out.
Additionally, noise cancelling
technology, when activated,
analyses ambient sound and
then cancels it out, providing you
‘with an even more immersive
listening experience.

Allof this phus wireless
operation uses power of course,
but these larger bodies are able to
house batteries with impressive
performance, often going for 20
hours or more on a single charge.
These models will pair with any
device that has Bluetooth, though
they're designed less for sporting
use than for the enjoyment of music
and movies from your Mac, i0S
device, Apple TV, or Bluetooth-
enabled hi-fi system. Any of these
headphones will significantly
enhance your listening experience.

The ease of pairing and switching
between Bluetooth devices was
tested, as well as overall comfort
during long listening sessions. A
range of audio sources was used
incuding Apple Music, movies
streamed over Netflix, and ripped,
lossless audio originally from CD.
The headphones were tested with
noise cancelling on and off, and an
assessment made of the quality
and accuracy of reproduction.
Where advanced features like
Apple's Spatial Audio were
available, these were also tested
with a range of relevant sources.
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Things to consider...

Size and weight

> All the models are designed
for comfort but some with farger
batteries will be a itte heavier.

Battery life

>The less often you have to
recharge, the better. All these models
will see you through at least half a
day of listening, but some go much
further than that.

Extra tech

>Some models offer
advanced features, particularly
Apple's AirPods Max vith Spatial
Audio, dynamic head tracking, and
the tight mac0S and i0S integration
that only Apple can offer.

i0S integration

> Many of the models can
be customised in various ways, ke
changing their EQ via a companion
105 app, while others are more
standalone products.

Apple AirPods Max

> £549 > FROM Bpplelcorm/uk

F "he most expensive
headphones on test,
the AirPods Max feature
Apple’s high-end build
quality and design.
Naturally, the headphones
integrate well with macOS
and 08, with seamless
switching between Apple
devices. The AirPods Max
sound rich and balanced with
any source, and boast an
array of features powered by
Apple’s multicore Hi chips.
Constantly listening with
six external and two internal
microphones, the processing
adapts the EQ based on the fit
of the ear cushions. As well as
superb noise cancelling, you
getan optional Transparency
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mode that allows outside
sound in. Gyroscopes and
accelerometers enable Spatial
Audio with head tracking,
moving sounds dynamically
when used with Apple Music,
or providing virtual
surround sound for movies
and TV. You'll get 20 hours
of power on a single charge.
Always-on Siri, notification
announcements, and on-head
detection round out this
highly advanced feature set.

> VERDICT I—
© Gorgeous sound

© Excellent Apple integration
© Very advanced feature set
© Expensive

Kook kK

Eowers & Wilkins PX7

> £249 > FROM bowerswilkins.com

B&W has an
illustrious history
in high-end hi-fi and the
43.6mm drivers used in
the PX7 are larger than
most of the others on test.
Despite this, the headphones
still only weigh 310g. They
use the aptX Adaptive codec
over Bluetooth, which
delivers up to 24-bit/48kHz
sound while minimising
interference from devices.
Comfortable to wear, a
three-button panel lets you
control playback, and a
proximity sensor will pause
and restart sound when you
lift a cup from your ear.
Battery life is 30 hours, with a
15-minute charge giving you

up to five hours of playback.
Although they look less
iconic than some models on
test, the PX7 headphones
sound excellent, providinga
detailed soundscape,
beautifully balanced in terms
of tone. Noise cancelling has
low, medium, and high
modes, and all work very
well, as does the ambient
listening mode. A companion
i0S app lets you manage
connections and noise

> VERDICT IE——
© Excellent, detailed s
© Fast charging

© Effective noise canceling
© No EQ support in app
Kk kk
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.lLab Studio Pro ANC

>$99 (about £90) > FROM iintljlab.com

BW By far the most

Rl affordable pair on
test, JLab’s Studio Pro
ANC headphones have a
battery life of 45 hours,
dropping to 43 hours with
noise cancelling on. Not
bad considering they weigh
just221g.

AACand SBC codecs are
supported as well as wired
operation, and they’re
comfortable, though have a
‘more lightweight build than
some. Three EQ modes are
available, changed on-body
not via an app. There’s a
in’ app, curiously, that

plays tones to break them in’.

Four microphones power
the active noise cancellation

which has four modes - high,
low, off, and passthrough. It's
pretty decent, though can’t
compete with the costlier
contenders. The microphone
quality is acceptable and
audio playback is solid
though a little flat and
‘mid-heavy. These are decent
headphones for the price,
which is much more
accessible, though you also
have to accept some of the
evident compromises.

> VERDICT HE—
© Very affordab
© Great battery life

@ Middling performance
© No aptX or HD

ok k

APPLE CHOICE

§ennheiser Momentum 3

> £349 > FROM ensuk:sennheisercom

Able to fold down to
avery portable size,
Sennheiser’s Momentum 3
are beautifully designed
and come with a 3.5mm
cable and USB-C, as well
as USB-A options for
charging. Their battery life
is slightly disappointing by
comparison at just 17 hours,
though you get not only
transparent listening but
three types of noise
cancelling - max, anti-wind,
and anti-pressure. Ranging
from most to least intense,
these are all very effective in
everyday use. Frequency
response is a low 6Hz-22kHz.
On-body controls let you
take calls and activate Siri,

and the Smart Control app for
108 lets you set up EQ presets
and enable smart pause when
one cup is lifted. Sennheiser’s
proaudio pedigree really
shines through when it comes
to sonics too, with music and
‘movies coming across as
dynamic, nuanced, and
detailed, closer to audiophile
quality than wireless
headphones. These are an
excellent meeting point
between hi-tech and hi-fi.

> VERDICT IE—
© Stunning, detailed sound

| © Flexible ANC modes

© Superb build quality

© Battery e

Kok ko
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§hure Aonic 40

> £215 > FROM ShFeicom

5 With their all-plastic
design, the Shure
Aonic 40 headphones are
comfortable to wear
though lack the premium
feel of other, admittedly
pricier options. The
headphones use Bluetooth 5.0
and support aptX, HD, AAC,
and SBC codecs, as well as
wired use viaa 3.5mm port.
A decent 25-hour battery
life can be topped up with a
15-minute quick charge for
an extra five hours of use,
and there are three noise
cancellation modes which
work well, though others
on test do better here. An
‘environment’ mode allows
ambient audio in.

Audio performance
overall is good, with most
sources coming across as
punchy and rich. Multipoint
Bluetooth is supported
‘meaning you can flip easily
between devices, and there’s
afree ShurePlus PLAY app
that includes among other
things a range of EQ presets,
as well as the ability to set up
your own. These are solid
headphones, even if they
perhaps lack a killer feature.

> VERDICT EE—
© Decent all-rounder

© Fast charging

© ANC is middiing

@ Build is lightweight
Hokokok

Sony WH-1000XM4

> £259 > FROM Sony.com

Sony’s popular
‘WH-1000XM4
headphones have a unique
aesthetic and fold down to
a portable size. With 30
hours of battery, a 10-minute
charge will get you another
five hours of playback with
an optional AC adaptor.
Alexa and Google Assistant
are supported, as well as a
feature that pauses playback
ifyou speak. They use the
LDAC codec, which transmits
at a higher bit rate and boasts
afrequency response of
4Hz-40kHz. Wired operation
is also available.

The soundstage is
pleasingly wide and rich,
and the headphones handle

O
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dynamics brilliantly,
producing a powerful sound.
They are excellent with
music, movies, and also when
making calls. The onboard
QNinoise cancelling
processor constantly
monitors audio and noise
both inside and outside the
cups, resulting in excellent
noise cancellation
performance. A companion
app provides useful tweaking
and set-up options.

> VERDICT HE—
© Superb sound

© Excellent ANC performance
© Comfortable and stylish

© Good app

Jookok kA
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§oundCore Life @35

> £129.99 > FROM UkSoundcore.com

7@ Designed for use on the

move, the Life Q35 are
lighter than some others at just
272g. Nevertheless they boast a
battery life of 60 hours with noise
cancelling off, or 40 with it on. Fast
charging is also supported and a
five-minute charge can provide up
to four hours of playback.

They use LDAC tech to
transmit at a higher bit rate of up
to 990kbps as opposed to SBC's
328kbps, which does seem to make
a small appreciable difference.
There’s also a wired option via
the 3.5mm port, chargingis over
USB-C, and they can pair with
two separate devices.

They tend to be bass-heavy and
while solid with most sources, they
won't trouble the pricier models on
test. The onboard microphones do
agood job with voice calling and
though noise cancelling is average,
there’s handy features like tap-to-
activate transparency mode. The
Soundcore iOS app lets you set up
custom EQ profiles and control
other settings.

> VERDICT I
© Great for using on the move
© Fast charge, good battery

© Sonicaly a litle average
© ANCis just OK

KAhk

Codecs explained

> All Bluetooth audio must be compressed
and converted to some extent before it
can be streamed to your headphones. As
things stand, sending uncompressed sound
requires too much bandwidth. The codecs
used for this have improved a great deal,
and as well as AAC and SBC there's now
aptX and HD, supported by many of the
models on test, that improve sample and
bit rates along with the reliability of the
stream. Some use the LDAC codec,
which transmits at a higher bit rate.
Although higher data rates are
preferable, they're only one part of the
signal chain. A ‘simple’ AAC stream still
sounds good, and it's things like the design
of the cups and the tuning of the drivers
that also play a big role in how headphones
sound. Most models on test support wired
listening as well as wireless, where codecs
aren't in use at all.
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Urbanista Los Angeles

> £169 > FROM urbanista.com

5] Urbanista’s Los
Angeles have a

remarkable and unique
feature in the form of solar
charging that works both
indoors and out. They also
charge over USB-C and offer
amassive 80 hours of use,
or 50 hours with noise
cancelling on, but exposed
to light they are essentially
always charging and this
works surprisingly well.

With a simple design,
they support SBCand AAC
codecs over Bluetooth 5.0
and have a companion app
that lets you monitor
charging and turn features
on and off, with controls
also available on-body.
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Sonically they area ittle
bass-heavy and not as sharp
as others, though perfectly
decent, especially with
electronic music. The active
noise cancelling struggled
alittle with higher-pitched
sounds, though ambient
listening mode worked well
and on-head detection is
handy. Voice assistants are
also supported. If you're a
bit eco-conscious, these are
certainly worth a look.

> VERDICT I—
© Staggering battery life

© Innovative solar charging

© Alittle bass-heavy

© ANC is middiing

Kok ok k

!amaha YH-ETO00A

> £369 > FROM Ukiyamaha.com

Yamaha's history
as a pro audio
company informs the tech
in these headphones,
which provide 35 hours
of battery life on a single
charge. They also offera
3.5mm audio jack and are
also one of the largest models
on test. A frequency response
of 8Hz-40kHz ensures an
accurate sound, with an
excellent balance across low,
‘mid, and high frequencies.
There’s plenty of tech,
with Listening Care
Advanced constantly
analysing volume, and
optimising EQ over time to
smooth out variations
between tracks.

A combination of in-ear
and external microphones
power the active noise
cancellation, which uses a
unique algorithm and is
among the best-performing
here. Ambient listening is
available, too. A Listening
Optimiser function can train
the headphones to suit your
ear shape and a companion
app lets you control functions.
These are excellent all-
rounders - ideal for music.

>VERDICT I

© Crisp, d
[}

© Excellent ANC

© Physically quite large
kA
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THE WINNER

Sony

WH-1000XM4

Superb all-rounders with bags
of features and great sound

pple’s AirPods Max
1\ [P
advanced and most

convenient for users of
Apple hardware, but their

high price is an issue. They're

far and away the costliest
models on test.

Special mention goes to
the Yamaha, Sennheiser, and
Bowers & Wilkins models, all
of which reflect the long track
records of their respective
companies in the high-end hi-fi
and pro audio worlds. They all
toa degree feel as much like
audiophile headphones as they
do high-tech ones. Urbanista’s
Los Angeles also have a unique

@

take on proceedings with their
solar charging technology.
Ultimately though, it's
Sony’s WH-1000XM4 that
build on that company’s vast
experience of audio and design
to provide stunning sound and
excellent noise cancelling
performance, at a price that’s
slightly less than you might
expect given the competition.
While perhaps lacking the
sheer style of Apple’s AirPods
Max, they offer the best of all
worlds when it comes to sound,
price, and performance. And
the software, for so long Sony’s
weak spot, appears to be
much improved too.

=S
[

s

e )

2

Apple
AirPods Max
Price £249

Website apple.com/uk

_ANC modes |2
Battery life
Fast charge | Yes
Codecs | AAC

20 hours

Wired No
option
Companion | ma
app

Bowers &
Wilkins PXT

bowerswilkins,

aptXLow
Latency

JLab Studio
Pro ANC

1899 (about £90) | £349 | £215
jlab.com

Sennheiser
Momentum 3

en
|  seheisercom
4 4
5 hours
No [N

T aac, sae aptX, AAC
SBC, aptKLow

17 hours

Shure
Aonic 40

shure.com

aptX, HD, AAC
and $BC

Sony WH-
1000XM4

£259

sony.com

SoundCore
Life @35

999

uksoundcore.

Yamaha
YH-ET00A

Urbanista
Los Angeles

£169

urbanista.com

80 hours

SBC, AAC
Qualcomm
| aptX Adaptive
Yes

final verdict s

re not necessarily an average
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APPLE CHOICE Soft

DxO

PureRAN

Polish a Raw picture's
pixels to perfection

> £115> FROM DxO, dxo.com
>NEEDS mac0S 10.15.7 or later

PureRAW 2
enables you to
revisit very old

Raw filesin
Lightroom
Classic and
givethema
new lease
of life

FORMAT

VERDICT
>Makes your DSLR's
old camera Raw files
look better than ever

before thanks to
Al assistance.

ok ok
© Standalone app
© Plugs into
Lightroom Classic
© Doesn't support
native iPhone DNG files
© Takes a while to
process on older Macs
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E

X0 PureRAW 2 uses DeepPRIME
[B) i g

range of artefacts that can spoil
a Raw format photo. It will reduce noise,
correct optical lens distortion and colour
fringing, counteract vignetted edges and
sharpen details. It does this more effectively
than the native tools in apps such as Adobe
Lightroom Classic. And once PureRAW 2 has
preprocessed a shot, you can use Lightroom
Classic or Photoshop’s Camera Raw tools to
process other picture properties such as
colour, composition and tone.

The app enables you to revisit old Raw
files in apps such as Lightroom Classic. For
example, some of your old Raw shots may
have been rejected by a stock photography
site’s inspectors for suffering from too much
1S0 noise. Now thanks to PureRAW 2's
‘machine learning powers you can smooth
out unwanted noise while preserving (and
sharpening) important info.

Prior to this latest version, you needed
to export your Raw files into the standalone
PureRAW application, preprocess the pixels

On the left is a soft and noisy look from Lightroom Classic.
On the right, a sharper clearer shot from DxO PureRAW 2.

PureRAW 2 runs in Lightroom
Classic as a plug-in,
streamlining your workflow.

to reveal more detail, reduce lens distortion
and denoise them. You then had to export a
DNG version of the cleaned-up file back into

a digital darkroom app such as Lightroom
Classic for further tweaks. With PureRAW 2,
you can access the app directly from within
Lightroom Classic as a plug-in. The plug-in

is implemented well and any previous noise
reduction or lens corrections made with
Lightroom Classic’s native tools are ignored in
favour of PureRAW 2's more effective results.
The downside is that it can take a minute or
so before the PureRAW 2 processed version
appears in Lightroom Classic.

The streamlined workflow lets you
browse shots in Lightroom Classic, apply the
Al-assisted tools to clean them up and then
process them to perfection using Lightroom
Classic’s wide range of digital darkroom tools.
Sadly, you can't enjoy the app directly from
within Photoshop Camera Raw as that
workspace is already a plug-in to Photoshop.
However, you can still process a file in the
standalone version of PureRAW 2 and then
open it in the Photoshop Camera Raw editor.

Swings and roundabouts
If you shoot Raw files on iPhone and organise
them in Photos, give PureRAW 2 a miss. It
doesn’t support native DNG files created by
the iPhone’s Camera app. However If you'rea
traditional DSLR photographer who has shot
in Raw format for years, it's worth investing
in, especially if your shots have been
organised into a Lightroom Classic catalogue.
PureRAW 2 does do an amazing job of
revealing detail while reducing artefacts,
making it a valuable addition to Lightroom
Classic’s toolset and a valuable stand-alone
resource. George Cairns
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Effie

Focus on your writing

> Free (IAPs)> FROM 7S2P Inc, Effieipre

>NEEDS macOS 10.13 or later

FORMAT

VERDICT

> A great writing tool
that has potential
for more.

ekk ok
© Well thought-
out features
@ Some small bugs
and issues

ffie is a minimalist
Markup editor and
mind map app.
While stripped back, it has
afew handy tools. It’s free to
download, but some options
require a subscription.

Effie uses a three-column
layout, with folders, files, and
workspace ordered left to right,
and you can hide the first two
columns to aid concentration.

Press /’and you'll see
acheat sheet of Markup
shortcuts - helpful if youre
new to the syntax. You can also
add Markup stylings from the
Markup menu bar. You can
display a character counter and

WonderPen 2

Useful writing tools at a low price

> £8.99 > FROM Tominlab, teminlabicom/wonderpen

>NEEDS macOS 10.11 or later

FORMAT

VERDICT
>There's a lot to like
about WonderPen,
but many rough
edges, too.

Kok Kk

© Split-screen mode
© No 0S version

>Image credits: tominiab.com

he feature that
differentiates
WonderPen from
many other writing apps is
its document tree. This
sidebar contains thumbnails
of docs that you drag and drop
to change where they sitin the
final document. In that sense,
itsabit like Serivener's binder.
‘WonderPen shares a few other
features with Scrivener, such
as the ability to add memos
todocuments. And there’sa
whiteboard where you can
keep tables, notes, or images.
Many of WonderPen’s
features are not immediately
obvious. There’s a typewriter

pinit on your writing space.
You canalso export to various
file types and publish to Effie’s
companion mindhub:pro
website or to your own
WordPress blog. Publishing
afilecreatesa QR code so you
can view it on another device.
Effieis also strongas
amind map tool, with five
‘mind map styles to choose
from, including a family tree.
There's a dark mode with a
“Match System’ option, but this

‘mode, and a split-sereen mode
to view two documents side by
side, and snapshots that allow

9 interface is unconventional.

are APPLE CHOICE

Effie’s interface lets you organise
documents into folders and
sub-folders.

didn't work for us, so we had
toset dark mode manually.
While =+ »_ highlights entire
wordsasit should, =)+ </ does
not. And there doesn’t seem to
bea way to move documents
from one folder toanother.
Effic lacks some of the
advanced tools of rivals, like
iA Writer’s movable text
blocks or syntax highlighting.
Overall though,it's an adept
Markup editor with some
clever touches. Alex Blake

WonderPen offers lots of options
for exporting documents but its

Share one in most Mac apps,
butis an export button.
Also, there’s n0i0S or

you to create a backup of a iPadOS version, so you can’t
document at any stage and syne with iPhone or iPad. And
return toit should youneed to.  while you can change the
Text options backup location toa shared
are tucked away so that the drive, there’s no easy way
interface remains uncluttered.  to sync with another Mac.
The interface itself doesn’t At £8.99, it can’t compete
conform to standard macOS ‘with the Word or Scrivener.
practice. For example, there’sa  Butifother apps seem a little
button in the toolbarat thetop  overwhelming, WonderPen is

of the app that looks like the

worth a try. Kenny Hemphill
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APPLE CHOICE Softy

Book of

Travels

Who said RPGs have to be hectic?

>£23.79 > FROM Might and Delight
>NEEDS macOS 10.15 or later

You delight in
every chance
encounter,
forming
wordless
bonds with
complete
strangers

FORMAT

VERDICT

> A deep, engaging
world that rewards
patience and
cooperation. It breaks
the RPG mould,

20,00 ¢

© Makes human
interaction magical

@ Lots of original ideas
© Gorgeous,
immersive world

© Early access quirks
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E

t, tmorpg.com

ook of Travels bills itself as a
E ‘tiny multiplayer online RPG’,
or a TMORPG. It eschews the huge

battles and multitudes of players that yowll
find in traditional massively multiplayer
online RPGs for a much slower pace of life.
The game is in early access, but it was so
intriguing we couldn’t wait to giveita try.

We were hooked right from the off. At

Abeautiful world created
in a very distinctive style.

You can’t type or talk to other players,
but you can call out or display images and
emotes. Conveying your meaning isn't always
ard, but if you'
you can pool your abilities, such as working
together to lift a heavy boulder that reveals a
secret passage. Because it’s so unusual to see

another player, you delight in every chance
encounte, forming wordless bonds with

character creation, each archetype has
various unusual buffs and debuffs, such as
having items move around in your backpack
because you're disorganised. The land of
Book of Travels - the Braided Shore -~ is a
place where magical teas are brewed and
letters are written with knotted ropes. The
music is esoteric and enchanting, the graphics
beautiful and peculiar. Diving in, everything
feels otherworldly and original.

Book of Travels’ best moments come from
interacting with real-world people. While
there are reams of AI characters, each server
can only host seven human players at a time.
The map is large and travel is slow, so meeting
another human is a rare and exciting event.

You can't type messages to other players, but you can
communicate with emotes.

pl gers to solve problems, find
riches, or simply explore the world together.

Quest notes

Being an early-access game, some elements
needed work when we played. Bugs and
unfinished ideas were not uncommon.
Trading and inventory management, such
staples of RPGs, were both lacklustre and
uninformative. Combat was also a tad
confusing, especially for beginners, but
luckily you can mostly avoid it if you want.

Book of Travels is meant to be a slow game
where you take a moment to breathe in your
surroundings, and it requires patience. There
are few fast-travel points and no quest log (so
keep a pen and paper handy). However, not
every area rewards this pace, and some feel
empty and unfulfilling. The lack of fast-travel
points makes walking from one side of the
map to another feel laborious, especially since
you have so little stamina when you run.

Still, that doesn’t take away from the
magic Book of Travels conjures up. Whether
yow're immersing yourselfin its lore or
working with a stranger to overcome an
obstacle, it is deeply rewarding, and no matter
what you do, it feels like the Braided Shore
has more to offer. If you want an RPG
bursting with different and original ideas,
this is a must-try game. Alex Blake

> Image credit
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Get Sum

Shopping for a grocery app?
Youre in luck

> £1.79 > FROM Shihab Mehboob, BRGUINERA
>NEEDS 05 15 or later

The app's . or many of us, plans for grocery

AL shopping are often relegated to a
power lies in its simple bulleted list in Notes. But

flexibility and this option isn’t really up to the task, and it
) ! quickly falls apart when you want to track
it can be as prices and sort things into categories. Luckily,
simple or as Get Sum is a great solution.
Open it up and you'll see a large “+ button
complex as - tap this to add the name of a grocery
you like product. You can leave it at that, or tap the

item to add details, such as price and quantity.
At the top are buttons for settings, filtering,
and sorting. The rest of the screen is taken

up by your shopping list.

The app's power lies in its flexibility, and
it can be as simple or as complex as you like.
For instance, you could simply add a few
items to a bulleted list in Get Sum and call it
aday. At the other end of the spectrum, you
can add prices, quantities, images, and store
locations. You can define a grocery item as a
priority or set a reminder for it. Get Sum gives
you the power to add these details if needed,
but doesn’t require them in order to work.

Options galore

Underneath all these features lies an almost

unbelievable level of customisation. You can

change the theme, set new gesture controls,

FORMAT toggle haptics and shadows, enable

VERDICT highlighting, capitalise titles. There are

> Get Sum overhauls plentiful sorting choices, filtering options,

grocery lists in and categories (and you can add your own).

a clever, attractive

e — . ———
way, all for a very
Femconas pres O surtace lener
: Household
© Plenty of Mark as Completed @
helpful features
© 50 much Mark as Priority ~
customisation e A
© Looks great SoRemincen
© Budgeting options Simply long-press on a st item to access an impressive
are a bit weak bevy of filtering or administrative options.

>Image credit

< settings

Themes and Tints

@ wik >
150 Dairy and Eggs
O Mik 2

O wik

oo
O Mik 2

150
O Mik 2

£150  Dairy and Eggs
O Mik 2

1.50  Dairy and Eggs

Get Sum looks gorgeous while stil conveying plenty
of important information.

If control is what you're after, Get Sum
provides it in spades.

Get Sum’s budgeting tools are somewhat
rudimentary. These are mostly confined to
spending limits, which can go up to £100 per
item (with a custom option as well). If an item
exceeds that limit, there are options to remove
it or ignore its price. However, in our testing
this didn’t seem to work - expensive items.
were added to our lists without consequences,
regardless of whether we defined the prices
when entering the items or afterwards.

There are a few other things we'd like
to see improved. Pricing, for one thing, lacks
clarity. When you tell Get Sum that two boxes
of cereal cost £2, does that price refer to the
cost per box or for both boxes combined? The
app doesn’t make it clear. As well as that, you
can’t search for a store’s address when adding
one. Instead, you need to drop a pin on a map,
which isn’t ideal if you don’t know the shop’s
location beforehand.

But compared to most of the other options
out there, Get Sum is leagues ahead - and
it’s affordable, too. A deeply customisable,
tailor-made grocery list app for just £1.79?
That’s a bargain we can't resist. Alex Blake
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Book the First—
Recalled to Life

1. The Period

It was the best of times,
it was the worst of times,
it was the age of wisdom,
it was the age of foolishness,
it was the epoch of belief,
it was the epoch of incredulity,
it was the season of Light,
it was the season of Darkness,
it was the spring of hope,
it was the winter of despair,

we had everything before us, we
'had nothing before us, we were all going
direct to Heaven, we were all going dir-
ect the other way— in short, the period
‘was so far like the present period, that
some of its noisiest authorities insisted
onits being received, for good or for evil,

B — "

i’

Kindle

> Free (IAPs) > FROM Amazon, amazon.
‘com/kindleapp > NEEDS i0S 12 or later

The Kindle app has a
huge library of titles,
including comics and
magazines as well as

books. It also gives you plenty of

control over how those titles appear.

You can tweak alignment, margins,

fonts, and more to give yourselfa truly

comfortable reading experience on your
device. With bookmarks, zoom, word
look up, and many other useful features,
the apps is ideal for anything you want
to read - and it syncs with apps for the

Mac and iPad too.
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6 apps to...
read and listen to literature

Step into a new world of digital storytelling

The Adventures of
Tom S:

oM
SAWYER
uiNEEN

Play Sample

Libby

> Free (IAPs) > FROM OverDrive,
overdrive.com > NEEDS iO0S 10 or later

You don’t have to buy
books to enjoy their
content - your local
library has plenty on
offer. You can register your library
card, browse your library’s catalogue,
and access titles from the comfort of
your couch. The app enables you to
download content to your device for
offline reading, and it can also play
audiobooks if you prefer to listen to
literature. There are customisation
options, too, like background colour,
book design, and text size.

-~ —

a3 e

[ ...

Love and lifein lockdown

Home

Wattpad

> Free (IAPs) > FROM Wattpad, wattpad.
com > NEEDS i0S 12.2 or later

/ ‘ and their fans. Helping
readers discover new

literature to love, and writers to find
and expand their audiences. With a
huge community of 90 million users,
‘Wattpad always has something new for
you to explore - from sci-fi to comedy,
action adventure to romance. With this
app's help, you could unearth your next
favourite novel, or even write your own,
and content is available in over 50
different languages too.

This app is all about
connecting authors

> Image crecits ARGZGNEGH
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hese days, you needn’t read

. physical books to enjoy
literature, because you

can do it on your iPhone instead.

‘Whether you want to wolf down the

latest bestseller or listen to spooky

Black Friday
> brey

Realm

> Free (IAPs) > FROM Serial Box Publishing,
realm.fm > NEEDS iOS 13 or later

Sometimes, listening to
literature is even better
than reading it. This app
shows how true that s. It

hosts a plethora of curated shows and

stories from best-selling authors, all
narrated by famous names such as

George Takei (Star Trek’s Mr Sulu)

and Canadian actress Tatiana Maslany.

Each audio story is accompanied by a

transcript, so you can read along or take

it at your own pace. There’s even a sleep
timer so you can drift away to the dulcet
tones of George Takei’s voice.

>Image credit

podcasts before bed, there are plenty
of apps available to sate your appetite
for prose, poetry, and more. Here are

six of the best - from lending library app

Libby to comic book app ComiXology.
Alex Blake

Overcast

> Free (IAPs) > FROM Overcast Radio,
overcast.fm > NEEDS i0S 14.5 or later

Podcasts have changed
the way we listen to
literary content. Authors,
storytellers, and reporters

are taking to the airwaves to share their

tales and experiences in bite-sized
chunks. Whether you want to listen to
works of fiction or the latest dispatches
from famous journalists, Overcast is
one of the best podeast players you'll
find. With tons of clever features - like
avoice booster and smart speed controls

- it's the ideal companion for your

well-deserved downtime.

rature apps APPLE CHOICE

Discover

READ FOR FREE
WITH UNLIMITED

Great Entry Points

ComiXology

> Free (IAPs) > FROM ComiXology,
omiXeloayIEanh > NEEDS i0S 12 or later

Love Comics? Try

4 comiXology, which has

over 100,000 comics,

' graphic novels, and
manga to choose from. This app
serves as an all-in-one comic catalogue,
letting you buy and download your
favourites from Marvel, DC, Image,
Dark Horse, and many more publishers.
1t’s full of features that make reading
comics on your device easier, like its
Guided View that displays strips panel
by panel, making it simpler to enjoy
content even on a small iPhone screen.
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eniTED BY ROB MEAD-GREEN >

Your complete guide to the
best Apple hardware and

third-party accessories

.
IM ac i
£1,249
> Ever since the Bondi Blue iMac
debuted in 1998, Apples all-in-
one desktop computer has been
setting standards in gorgeous
design and powerful performance.
And Apple’s April 2021 Spring
Loaded event delivered the new,
colourful 24in iMac, available in
Green, Yellow, Orange, Pink, Purple,
Blue, and Silver. The larger screen
has also been bumped up to a
4,5K Retina display with a
4480x2520 resolution.

Inside, Apple's own M1 chip
combines with macOS Monterey,
and Apple promises up to 85%
faster CPU performance and up
to two times faster graphics
performance than the 21.5-inch
iMac models. All the models come
with 8GB of unified memory
(upgradeable to 16GB). The 8-core
CPU/7-core GPU option comes with
a256GB SSD (configurable to
512GB or 1TB). The 8-core CPU/
8-core GPU versions come with
either a 256GB or 512GB SSD and
can be upgraded to 1TB or 2TB.
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The new iMacs all feature a
1080p FaceTime camera, a high-
fidelity six-speaker system, a studio-
quality three-mic array and support
for spatial audio. You'll also find two
Thunderbolt/USB 4 ports on each
model, with middle- and high-end
options gaining two additional
USB-C ports. Thunderbolt 2, HDMI,
DVIand VGA are supported using
adaptors. All come with a Magic
Keyboard, with the mid- and high-
end versions boasting Touch ID.
Prices start at £1,249.

In a surprise move, following its
Peek Performance event in March
2022, Apple discontinued the
27-inch version of the iMac - one of
the last Intel holdouts in its Mac line-
up. While Apple is currently said to
have no plans to replace its biggest
all-in-one desktop, it may not stay
that way for long. Several analysts
are predicting that a new iMac Pro
may surface either later this year or
in 2023, echoing the design of the
current 24-inch Mac and possibly
sporting M1 Pro or Mi Max chips.

The 24in iMac released in April 2021 brought
with it a return of colour to the Apple spectrum.

>Choose an iMac

[T

24in M1 | MEMORY 868 of uri £1.249
H GRAPHICS
z STORAGE 25668 SSD
£ DISPLAY Retina 4 5K (P3 gamut)
ALSO Magic ouse Magic Keyoard | QP

unifed memory £1849
U

gamut
with Touch ID, ¢

> | 24in, M| MEMORY 16GB of unifed memory £2449
GRAPHICS Eight-core GPU

STORAGE 27B SSD
DISPLAY R
ALSO M
Magic K
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EXPECTED
ocT 2022

Mac Studio

> From £1,999

—_
~—
> Launched in March 2022, the
new Mac Studio takes all the
things we love about Apple
silicon and turns them up to 1.
Looking like an oversized Mac
mini, its capacious aluminium
body is still remarkably compact
for a desktop Mac, measuring
197X197x95mm, but it's what's
inside that really counts.

MacBook Pro

> In October 2021, Apple released the first
MacBook Pros with its revolutionary new
M1 Pro and M1 Max chips. While the 8-core,
13-inch MBP s still available with an M1 chip,
Apple launched new 14- and 16-inch
supercharged MacBook Pros.

The base 14-inch model comes with an
8-core CPU but can be configured to 10-core.
The 14-inch also comes with either a 14- or
16-core GPU but can be customised with
an up-to-32-core GPU. All the 16-inch
variations come with a 10-core CPU as
standard and an up-to-32-core GPU.

The upgraded CPU is said to offer up
t03.7 times faster performance over its.
predecessor, while going for the 32-core
GPU means up to 13 times faster graphics
performance. Combined with the 16-core
Neural Engine, the new models boast up
to 11 times faster machine learning.

Both models start with 512GB of storage
but this can be upped to 8TB. And both can
be ordered - thanks to the M1 Max chip -
with up to 64GB of unified memory.

The 70W battery in the 14-inch MBP
provides up to 17 hours of movie playback
and 11 hours of wireless web browsing, while
the 100W battery in the larger model offers

The MacBook Pro 14- and 16-inch
models can be specced with either
an M1 Pro or an M1 Max chip.

> From
£1,299

up to 21 hours movie watching and 14

hours' web surfing. Both models boast
aLiquid Retina XDR display, with a 3024x
1964 resolution on the 14-inch model, and
3456x2234 on the 16-inch. Both offer
Extreme Dynamic Range (XDR) for up to
1,000 nits of brightness. There are also more
ports - an SDXC card slot, HDMI port, 3.5mm
headphone jack, MagSafe 3 port, and

three Thunderbolt/USB 4 ports. Al three
models are available in Space Grey or Silver.

>Choose a MacBook Pro

MODEL
13in, M1
8-core CPU,
8-core GPU

KEY S
MEMORY 868 of
unified memory
STORAGE 25668 SSD
TOUCH BAR Yes
TOUCH ID Yes

ICATIONS PRICE

ENTRY LEVEL

T4in, M Pro
8-core CPU,
1-core GPU

MEMORY 1668 of
unified mem:
STORAGE 5121
TOUCH BAR No
TOUCH D Yes

UPGRADER

16in, M1 Max
10-core
32-core GPU

MEMORY 6468 of
unified memory
STORAGE 8T 55D
TOUCH BAR No
TOUCH ID Yes

= Liquid Retina XDR

HIGH END

§

The £1999 entry-level model
packs the same M1 Max chip as.
the MacBook Pro, with a 10-core
CPU, 24-core GPU and 3268 of
unified memory, but t's the
step-up models that are the
most interesting.

That's because you can also
buy a Mac Studio with the M1
Ultra - a powerhouse piece of
Apple silicon with a 20-core CPU,
and up to 64 graphics cores, as
‘well as up to 128GB of unified
memory. Storage options also
scale up to animpressive (and
impressively expensive) 8TB.

With M1 Ultra Mac Studio
prices starting at £3999,it's not
for everyone - particularly as
you'lalso need to add a display,
akeyboard and a mouse or
trackpad too. But even the base
model gets a decent array of
connectivity options, including
4x Thunderbolt 4 ports, 2x USB-C
ports, 10Gb Ethernet, HOMI 2.0,
Wi-Fi 6 and Bluetooth 5.0.

The rear of the Mac Studio is
awash with ports, including
HDMI and a headphone jack.
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> Apple’s thinnest, lightest laptop
now also gets the M1 treatment.
And without a price hike too, as
prices still start at just £999. The
next-step model (with increased SSD
storage and 8-core GPU) even costs
£50 less at £1,249. Like the MBP,
Apple’s own unified memory silicon
enables faster performance and
better graphic speeds. And the
16-core Neural Engine results in nine
times faster machine learning.

It may be Apple's most
affordable laptop, but the MacBook
Air certainly doesn't feel like a
budget machine, thanks to its
100% recycled aluminium unibody,
and 13.3-inch LED-backlit Retina
display, which has a resolution of
2560x1600 (227ppi) and True Tone,
which automatically adjusts the
display’s colour temperature
depending on the ambient light.

The inclusion of the M1 chip has
changed none of the Air's physical
characteristics - the portable laptop
is still just 1.61cm thin, and weighs.
1.29kg. Despite the performance
boost, the Air is now fanless, using
an aluminium heat dissipating panel
instead - which also means that it
runs in complete silence.

The base model comes with an
8-core CPU, but a 7-core GPU, and
256GB SSD storage. While on the
step-up model, the CPU and GPU
are both 8-core, and the storage
starts at 512GB. Both offer the
option to upgrade to 16GB memory,
and are configurable with increased
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The Mi-equipped MacBook Air
(Late 2020)is an incredible

portable performer.

MacBook Air ::

storage; you can add up to 2TB

of SSD storage for £800 on the entry-
level model or £600 on the 8-core
GPU version.

The M1 MacBook Air can be
teamed with Apple’s Pro Display XDR,
although none of the M1 Macs can be
used with an external GPU (eGPU).
You also get Touch ID for secure
logins, and a Force Touch trackpad.

The MacBook Air is also equipped
with two Thunderbolt/USB 4 ports
and a headphone socket. The laptop
now supports 802.1lax Wi-Fi (aka
Wi-Fi 6), has Bluetooth 5.0 onboard,
and comes with a 720p FaceTime
camera for video chats.

So with the new internal upgrades,
does the MacBook Air still boast its
legendarily long battery life? Yes, and
some! You can now get up to 18 hours
of Apple TV app movie playback, or
15 hours of wireless web surfing,
thanks to its 49.9W battery. Like the
earlier 2020 incarnation, the new
MacBook Air comes with Apple’s
Magic Keyboard for fast, fluid typing.

>Choose a MacBook Air

MODEL - KEY SPECIFICATIONS PRICE

o 13in, M1 MEMORY £999
| 8-core CPU, | unified mer
2 GPU'| STORAGE 25668 55D
TOUCH BAR No
TOUCH ID Yes @
MEMORY 16 GB of 2,049
unified mem
STORAGE 278 SSD
TOUCH BAR No
TOUCH ID Yes ®

Mac mini &

> Despite a near two-year wait for the
last update to the Mac mini, within
just eight months Apple released it
again, adding the homegrown M1
chip in December 2020.

The processor boasts far superior
processing and graphics performance
to the Intel innards of the previous
incarnation. Like the MacBook Pro
and MacBook Air, the base model
starts with 8GB of memory that can
be boosted to 16GB. The SSD options
go from 256GB all the way up to 2TB.

The Mac mini now supports
Wi-Fi 6 and Bluetooth 5.0. You get
two Thunderbolt/USB 4 ports, as well
as two USB-A ports, an HDMI 2.0
port and a 3.5mm headphone jack.

The entry level Mac mini is
available for £699. Taking it to its max
memory and SSD capacity will set you
back £1,699. The 3.0GHz Intel Core i5
model is still available from £1,099.

Studio Display

> £1,499
> Launched alongside the Mac Studio
in March 2022, the Studio Display is
a great addition to any Mac setup.
Powered by Apple's A13 Bionic and
running i0S, it features a 27-inch Retina
display with 5K resolution (5120x2880
pixels) and True Tone, a 12MP Ultra Wide
camera with Centre Stage, and a six-
speaker sound system with support for
Spatial Audio. A range of stand options
are available, and you can choose
nano-texture glass for £250 more.



iPhone .

> In September 2021, Apple launched
the iPhone 13 family of handsets. All
four models boast many of the same
features... Apple's A15 Bionic chip, Super
Retina XDR screen with True Tone,
Portrait mode, HDR video with Dolby
Vision, 5G, Face ID and Haptic Touch.
The Pro model has a 6.1-inch display,
and there's a 6.7-inch screen on the Pro
Max version. These two handsets boast
LIiDAR scanners and ProMotion tech, and
5-core GPUs. The Pro and Pro Max come
in 128, 256, 512GB or 1TB storage
options. While all the handsets offer a
12MP camera system, the Pro and Pro
Max boast an additional Telephoto lens.
The iPhone 13 and 13 mini only come
in 128, 256 and 512GB storage options.
The display measures 6.1in on the
standard handset, and 5.4in on the mini.
All the handsets are water resistant
up to 6m and compatible with MagSafe.

>Choose an iPhone

[ KEY SPEC]

CAPACITY 1286
PROCESSOR A15 Bionic
FACE ID Yes

(ual e 5”’”’,}7.\:9‘ ©

CAPACITY IT8 £1549
15 Bionic

;
iPad v

> This autumn, Apple brought out the
9th-gen iPad 10.2in featuring an A13
Bionic chip with Neural Engine and a
20% faster GPU. The front-facing
camera finally incorporates a 12MP Ultra
Wide lens, with support for Apple's new
Center Stage feature, and the display
boasts True Tone technology.

The iPad is great at multi

STORE GUIDE

iPad Air

> After a major redesign
in 2020, this year's
model builds on that success. Still
sporting the same slim chassis and
10.9-inch Liquid Retina display, the
2022 model now comes with an M1
chip, making it 60% faster than before.
Other additions include a 12MP Ultra
Wide camera with Centre Stage, 56

on Wi-Fi+Cellular models and a faster
USB-C port. Storage options start at
64GB and top out at 256GB.

> From £369 (Series 7)
> The world’s number one
smartwatch now has a bigger,
always-on Retina display.
Along with the two new
t 4 45

You can slide a second app over the
right side of the one you're working on.
Picture in Picture enables you to watch
video in a corner of the screen. There's
also Split View, which lets you work
on two apps side by side. iPad also
supports external drives and, since
the i0S 14.5 update, Xbox Series X and
PlayStation 5 DualSense controllers
for more immersive gaming.

The new iPad comes in 64GB or
256GB options. Now only available
in Silver or Space Grey.

>Choose an iPad

MODEL

2 102 iPad

AMERA 8P
ook Touchs @

109in CAPACITY 64GB £579
2 iPadAir | PROCESSOR Al4 Bionic
CONNECTIVITY
CAMERA 20

ek Toucn | @

2| 129in CAPACITY 12668 £999
| ipadPro | PROCESSOR MI
g CONNECTIVITY WirFi

CAMERA 120P

UNLOCKING ®

. the
Watch Series 7 has anarrover
bezelthan before and even
supports  fulksize QWERTY
Keyboard as well s two new Watch faces.

Aside from also now boasting an ST SiP
the Watchis otherwise largely unchanged from
last year, sporting the same W3 and U chips,
as wellas an18-hour battery lfe

It also makes the most of new watch0S 8
features such as the new Mindfulness app, the
redesigned Home app and other enhancements.

Apple TV 4K

> From £169
> In April 2021 Apple unveiled

the sixth generation of its media
streamer. Running an A12 Bionic chip
and its own OS (tvOS), the model offers
4K high frame rate HDR. You get Apple
TV+, as well as access to third-party
content. You can also use it to play
Apple Arcade games, run Apple
Fitness+ content, stream photos and
'your music library, and more. The Siri
Remote has been
redesigned with an
improved touch-
enabled clickpad.

ocT 2022
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BEST BUYS

> DESKTOP SPEAKER
Ruark
£329.99 ruarkaudio.com__

>

>Winner of MF357's head to head,

the MR1speaker set looks and sounds the
business. The dome tweeter and fong-
throw woofer can hande a variety of
audio styles with aplomb. You get a good
variety of connectivity options, and we
love the chunky function/volume dial too.

> IN-EAR WIRLESS EARPHONES

Beats Fit Pro

£199.99 beatsbydre.com/uk

>The Beats Fit Pro are
compact and sporty in
~ design with integrated

6 silicone ear hooks. The

/ earbuds match Apple

AirPods Pro almost
feature for feature, and cost nearly £40
less. You get Apple's HI chip, Active Noise
Cancelling (ANC), Find My, Siri support and
Spatial Audio with dynamic head tracking.
What's more, these Beats boast longer
battery life than the AirPods Pro.

2

>KEYBOARD (MAC/iOS)
Logitech MX Keys Mini

£99.99 logitech.com

S S EEE T o
FEEEREEE
muden \—LL Nuunue

>Beautifully and solidly made from
aluminium with 79 largely concave, backiit
plastic keys, this angled keyboard looks
great on your desk and feels even better
under your fingers, making it easy to type
accurately and at speed. The keyboard
can be paired with up to three separate
devices, and you get a dedicated Emoji
button and mic mute/unmute buttons too.
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> QHD DISPLAY
ViewSonic VP2768a ColorPro
£379 viewsonic.com

>If you're looking for

ascreen for creative

colour work, the
100% sRGB VP2768a
ColorPro should be
a definite contender.
The frameless 27in 2K QHD display offers
a2560x1440 resolution, and a 14-bit 3D
lookup table that generates 4.39 trillion
colours. In terms of connectivity, there's
an integrated Gigabit Ethernet port, USB-
C,USB3.2 Gen 1, HDMI, and a DisplayPort.

'

> PRINTER

Epson Workforce WF-110W

£199.99 epson.co.uk

>Epson's Workforce
WF-TIOW is
supremely portable
with an integrated
rechargeable
battery that has
good longevity, plus there are flexible
connectivity options and a nicely designed
i0S app. The onboard screen and controls
make setup and operation easy, and
black-and-white print quality is excellent,
with colour certainly acceptable.

>WI-FI ROUTER
Zyxel Multy U WSR30

£199 zyxel.com/uk

>Zyxel's Multy U
mesh router hits the
’ sweet spot, offering
great performance
at a competitive
o price, making it ideal
for homes and small offices. The AC2100
router offers up to 280Mbps with a range
of 6,000sq ft, and the nodes are easy on
the eye, too. The companion app comes
with helpful speed tests and diagnostic
tools, as well as parental controls.

>Image credits (ift to ight, top to bottom: &
A Ko Epson ¢ €

Curated picks of third-party kit >

> STREAMING SOUNDBAR
Sonos Beam
£449 sonos.com

> The second-generation of this streaming
soundbar features a five-speaker array for
a deep, rich soundstage. You get Wi-Fi,
Ethernet and HDMI eARC connectivity
options, and Alexa and Google Assistant
built in. Dolby Atmos is supported, and the
digital signal processor simulates surround
sound. The Sonos app is easy to use and
you can also stream audio over AirPlay 2.

>EXTERNAL SSD

OWC Envoy Pro SX SSD
£345.99 (ITB) owedigital.com

>0ur SSD top spot
used to belong to
OWC's FX version
of this drive, but this
cheaper model is
atough cookie that
offers excellent read and write speeds. It's
IP67 rated so it's crush-proof, dust-proof
and waterproof and is plenty zippy in the
file transfer department. The SX SSD is
limited to Thunderbolt/USB 4 but you
can always use it with an adaptor.

>MACBOOK BAG

Hex Technical backpack
$149.95 (about £110) hexbrand.com

>Looking for a bag that
hits the sweet spot for
generous storage and
stylish looks? Look
no further. The Hex
Technical's 17.5-litre
capacity is made up of
device-hugging padded pockets for a
MacBook (up to 16in), iPad, power bank
and more. The bag is waterproof and has
a1680D Cordura ballistic bottom so it's
also reassuringly rugged.


http://ruarkaudio.com/
http://viewsonic.com/
http://sonos.com/
http://beatsbydre.com/uk
http://epson.co.uk/
http://owcdigital.com/
http://logitech.com/
http://zyxel.com/uk
http://hexbrand.com/
https://www.viewsonic.com/uk/
https://www.sonos.com/en-gb/home
https://www.beatsbydre.com/uk
https://www.ruarkaudio.com/
https://www.owcdigital.com/
https://www.logitech.com/en-gb
https://www.stmgoods.com/
https://www.zyxel.com/uk/en/homepage.shtml
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BEST BUYS... Curated picks of additional apps >

‘3 PHQTO EDITOR (MAC)
Luminar
From £59 skylumicom

> If you want to improve

your photos without

spending too much, this is

the app for you. If you're

worried that you don't have
the know-how for technical image edits,
this is also the app for you! The software
uses artificial intelligence (Al) to analyse
your photos with templates for various
categories, instantly enhancing your shot.
And, once the Al has worked its magic, you
can make your own easy tweaks.

>TO-DO (MAC/i0S)
Todoist
From Free todoist.com

>Task management apps
should be clear and simple
but with features on hand
for you to be as productive
as possible. Todoist
provides that platform, and the Premium
£3.99 tier in particular gets our vote. The
interface is very easy to navigate and the
comprehensive toolset is accessible
without being overwhelming. The price
includes both Mac and i0S apps, file
uploads and collaborative tools.

>VIDEO ED‘ITOR (i0s)
LumaFusion 3
£25.99 (IAPs) luma-touch.com

> The accomplished video
editing suite can now
download from various
cloud services and read
directly from a USB-C or
Thunderbolt drive - files can be edited at
source. The Lock & Load feature provides
presets and fine-grained controls for
stabilisation, and a graphic equaliser can
enhance or diminish audio frequencies.
The interface also allows you to easily
resize various windows.

>1mage credits (left o right, top to bottom): Skylum, Valeris Baguckis
Doist oftware Inc, The Grizzly Labs LCH

. Bombich So Luima

> TEXT RECOGNITION (MAC)
TextSniper
£6.99 textsniper.app

>Not only can TextSniper

extract and recognise

text from anything you

see on your Mac's screen,

it can do so very quickly.
The app can handle just about any type of
copy - be it a screenshot, PDF, scanned
photo document, and so on. It's easy to
use, works almost instantly, and we're
really impressed with its accuracy. If you
need a decent text recognition app, try
this excellent affordable option.

> DISK UTILITY (MAC)

Carbon Copy Cloner 6
‘bombich.com

£29.45

>If you're finding
Time Machine backups
somewhat inflexible, look
no further than CCC for
your replacement.
Carbon Copy Cloner 6's comprehensive
feature set includes flexible backups, disk
cloning and snapshot management. A
help book is on hand which also links to
the company's online Knowledge Base,
S0 you're always assured of access to
technical and specialist advice.

> CALENDAR & TASKS (MAC/iOS)
Fantastical 3
From £3.25 per month

sort things out. It has

oP
support for natural

language entry, so you can enter events
and reminders as you would say them. It's
got a nifty menu bar shortcut, plus a great
interface, clever calendar management
and a powerful iOS app. Its predecessor
won MF338's group test.

>If your calendar and
reminders are getting out
of control, Fantastical can

> NOTE’TAKING (i0s)
Notability 10
£899 gingerlabs.com

> Notability is a very
flexible note-taking app.
It can combine different
mediums, such as
illustrations, handwriting
and audio recordings, and import PDFs
and scan documents. Version 10 also
brings an in-house Shop for purchasing
additional stickers, themes and features,
such as handwriting conversion. The app
works well with Apple Pencil and supports
arange of cloud-based services.

> SCANNER/OCR (i0S)
Genius Scan+

£799 thegrizzlylabs.com

>Genius Scan uses your
i0S device's camera and
processing power to
deliver comprehensive
scanning and text-
recognition capabilities. The free app
(Genius Scan 6.0) provides document
detection, background removal, distortion
correction, as well as the ability to export
to PDF and create multi-page PDFs, but
the £7.99 Genius Scan+ (available as an
IAP) introduces a superb OCR engine.

> EMAIL MANAGER (MAC/iOS)
Spark
Free

> Feeling inbox anxiety?
The solution could be
Spark, our favourite
iPhone email app after
winning MF340's
group test. Its ‘smart inbox’ prioritises
emails based on perceived importance -
no more vital messages getting lost in
asea of spam. You can snooze messages
to be reminded about them later, and
search your mailboxes using natural
language. And to top it all off, it's free.
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RANDOM APPLE MEMORY

Power Mac G4 Cube

Former MacFormat editor Graham Barlow thinks
Apple's new Mac Studio reminds him of something...

hen you first cast eyes on the
new Mac Studio, it's hard not
to be reminded of the old Power
Mac G4 Cube. The G4 Cube, was released
back in 2000 and was one of Apple’s first
attempts to produce a powerful, small form
factor desktop computer without a built-in
screen. The Cube itself was something of

a Marmite design - a 77-inch computer
housed in a box of clear acrylic, making it
look like no computer had ever looked
before. Some people loved it, others weren't
sure what it was and some people thought it
looked like a box of tissues.

Of course, Apple’s golden boy Jonny Ive
designed it, and it looked like it belonged
to the same family as his other classic
computers, like the iMac and the Power
Mac G4. But if we're honest, it was a little
more towards the ‘toaster’ end of the design
spectrum than anything else he'd done.

Asa computer the Cube wasn't half
bad, but it had its problems. For a start
it was quite expensive for the amount of
power it provided, then there was limited
expandability and the see-through acrylic
started to crack on some models. To fit all the
components of a computer into such a
small frame, Apple had made some radical
design decisions for the time. There were
no expansion slots available to the user -
instead you could only attach peripherals
via USB. Also, the power supply was located
externally to save space and the Cube shipped
with round Harman Kardon speakers and a
digital amplifier, which you also had to find
room for on your desk.

Unfortunately, the Cube didn’t really
have an audience and it was an immediate
commerecial flop, selling only 150,000 units
before being suspended. It was too expensive
for the budget end of the market and too
limited for the professional end. And so, the
Cube was ‘suspended indefinitely’ in July of
2001. But while the Cube goes down in history
asa failure, its legacy lived on as it went on to
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The G4 Cube was Apple's
first desktop computer
without a built-in screen

influence the Mac mini, and the ‘trash can’ Mac
Pro. And now the Mac Studio is here to remind us
that cubes never really went out of fashion, it just
took Apple a long time to find one that we (or at
least pro creatives) could really get excited about.

ABOUT GRAHAM BARLOW

Graham Barlow is MacFormat's Editor-in-
Chief. He first edited the mag in 2004 when
an Apple iBook with G3 processor running
0S X10.3 Panther was ‘cool’, and cost a
month's salary. As a podcaster, his favourite
piece of Apple tech these days is his AirPods.




1 MOVE FAST.
WITH YOUR HELP,

WE CAN Too!

We're working to create a future where brain tumours are curable.
We urgently need your help to accelerate research.

Text DEFEATS5 to 70507 to donate £5, please help us to find a cure.

thebraintumourcharity.org
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IF 1 HAD
SOMEWHERE
TO LIVE...

When Abi’'s mum died, life got tough. She didn’t get on with her
dad and the arguments became violent. Abi felt her only choice
was to leave home. With just the clothes on her back, and no
idea where to go, she ended up sleeping on the streets in the
freezing cold.

Right now, you could give a homeless young person like Abi
somewhere to start their future

Abi’s life changed when she was given a room at Centrepoint.
Asafe place to sleep and recover. A place to develop the skills
and confidence she needed to rebuild her life - and leave
homelessness behind for good. Now, Abi believes she can

g0 anywhere.

YES, | WANT TO SPONSOR A ROOM
FOR £12 A MONTH

Please collect my payment on the Ist/I5th of every month

Thousands of homeless young people like Abi are desperately
trying to find their place in the world - but first they need a
place to start again. You could help right now by sponsoring
a room at Centrepoint for just 40p a day.

We know this support changes lives. 88% of the young
people we help move on positively in life. So please, help
someone like Abi today. Thank you.

Text PLACE to 78866 to donate £3

Call free on 0800 472 5798

Visit centrepoint.org.uk/place

Or complete and return the form below

Full Name:
Addr

Postcod Telephone:

Instruction to your Bank or Bullding Society to pay by Direct

¥ thebansgr, prmsm— ) 61 [ 1}

Name and full address of your
Bank or Building Society

Postcode

Name(s) of Account Holder(s)

Emait

Thank you for donating to Centrepoint today.

We'd love to show the impact of your support and share how young people
continue to need your help, through newsletters, fundraising appeals and
information about events. Please let us know how best to stay in touch with
you by adding your details above, and ticking the relevant boxes:

[IPlease contact me by email []Please contact me by phone

sanksartcoses LT accoune oo LT LT TTT]

Instructions to your Bank or Building Society: Please pay Centrepoint Direct Debits

the account detailed in this instruction, subject to the safequards assured by the
Direct Debit Guarantee. | understand that this instruction may remain with Centrepoint
and,if so, details will be passed electronically to my Bank/Building Society.

Signature(s) Date
2 ot accept Direct for some types of account

Increase your donation by 25p for mry £1you donate with Gitt Aig _giftwid i
O sy Ucklnq this box | confirm | am a UK taxpayer and wan( Cantrwuml to Gift Ald
o Gmatios g i  the Joat Your Yecon v comtiows T ke s the

Autire urth1 naty you atherwise. | understand that 1 ey as Income Tox ]
or Capital Gains Tax In any tax year than the amount of Git Ald claimed on al my
donations it is my responsibilty to pay any difference.

Your name and address are needd to identify you as a current UK taxpayer.

helped us change the ives of over 15,000 homeless
onyou,

L
young people. By l
young people with a home and a future.
Your privacyis key.

We promise never to sell or swapyour details, and will aways keep them secure.

You can opt out of post and change how we communicate with youat any
e s o DRG0 248 e gl b i of uk ey o e
suppor & to do this and ask us any que:

Please retum this form to: Freepost Plus RTXY-LBEA-UTA), Ange 25 ifiment
Services Ltd, Communication Centre, Par Moor Road, Par PL24 2

Registered office address: Central House. 25 Camperdown Street, London £180Z.
Company no. 1929421, Registered Charity no. 292411. Housing assodation no. H1865.
VAT registration no. 649 345 018,
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